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U.S. Export Administration Act: Restrictions on Exporting
Software

The Software includes cryptographic software that may be subject to export controls
under the U.S. Export Administration Act. The Software may not be exported to any
country or to any foreign entity or “foreign person” to the extent prohibited under
applicable U.S. government regulations. By downloading or using the Software, you
are acknowledging and agreeing to the foregoing limitations on your right to export or
re-export the Software, and are also representing and warranting that you are neither
on any of the U.S. government's lists of export precluded parties nor otherwise
ineligible to receive software containing cryptography that is subject to export controls
under the U.S. Export Administration Act.

Administrators must be aware that allowing users outside the United States to access
data via certain DI-Clients qualifies as exporting encryption software (either the client
executable or the Java applet sent to the browser). Export or re-export of encrypted
software must be in accordance with the Export Administration Regulations. Diversion
of encryption software contrary to U.S. law is prohibited.

More Information

More information about trademarks, product warranty, and third-party license notices
is available in your DI software Help system. At the bottom of any Help page, click
Product Information, and then select Disclaimers, Trademarks, Warranty, and
Third-Party Licenses.
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Diver Platform 7.0 Overview

The Diver Platform is the Dimensional Insight software suite that contains all
Diver 7.x software, including Workbench and Spectre. DiveTab is optional. User
categories are: Developer, ProDiver, DivePort, DiveTab, and HelpDesk.

About This Installation Guide

This guide contains installation, configuration, and verification procedures to
install the Diver Platform Server 7.0 and the Diver Platform Developer 7.0
packages for Windows. The server package contains DiveLine and web clients
DivePort, NetDiver, Bridge, and DIAL; the developer package contains the
desktop clients Workbench, ProDiver, and Help Desk. All Dimensional Insight
products in these packages are listed as follows:

IMPORTANT: The developer package examples are specific to Windows 10,
unless stated otherwise. Please keep in mind that steps may differ depending on
your configuration.

» Diver Platform—The Dimensional Insight software suite that contains
Diver 7.0 software, including Workbench and Spectre. User categories are:
Developer, ProDiver, DivePort, and DiveTab.

» Diver Solution—The Dimensional Insight software suite that contains
Diver 7.0 software, including Workbench. User types are tiered: Developer,
Advanced, General, and Casual.

» DiveLine—The server component of the Diver Platform and Diver
Solution. DivelLine authenticates users and controls access to data through
Diver clients such as Workbench, ProDiver, DivePort, and DiveTab.

» Spectre—The data analysis software in the Diver Platform. Spectre
processes data from a database or file to build a column-oriented
database (cBase) that caches efficiently on both the server and client
device. Spectre is integrated with Diveline.

» Workbench—An integrated development environment to develop, test,
and manage projects associated with a Diver application.

» ProDiver—The desktop analytics client of the Diver Platform and Diver
Solution.

» NetDiver—The zero-footprint web-based analytics client that provides ad
hoc reporting.

» DivePort—The client used to build and display portals that present your
Diver data and any other content you need to share over the web.
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Help Desk—A desktop component that provides access to user
maintenance for the DI client-server applications on the Diveline server.

DiveTab—The client that provides mobile users access to unstructured
content and structured data. It uses guided data navigation and one-
touch access on an iPad, PC, or phone. DiveTab is distributed separately.

Bridge—A web application based on DivePort technology that you can
use to navigate your DI applications from one central place. For more
information, see Appendix A: Bridge on page 90.

NOTE: You need to be an administrative user to install the software.

The steps to download and install licenses and components for Diver Platform
7.0 and Diver Solution 7.0 packages are virtually the same. Although the
examples in this guide specify Diver Platform 7.0, the procedures can also be
used to install Diver Solution 7.0.

If you run into any issues during the installation, contact DI Customer Support
for assistance:

North America: 920-436-8299 or support@dimins.com

United States: https://www.dimins.com/how-to-contact-dimensional-
insight/

China: +86 20-8129-6052

Germany: +49 711490 04-218

Netherlands: +31 (0) 88-514 88 00

Outside of the United States: https://www.dimins.com/international/

About Roles and Environments

DI suggests that there are four basic roles to consider in a customer installation
and deployment. The roles are:

1.

Development—People responsible for the creation of cBases, cPlans,
Dive files, classic models, DivePlans and markers, and pages for DivePort
or DiveTab

Test—People responsible for change control and data validation when
rolling out a new application, or upgrading software

Production—People responsible for delivering data to users through any
of the DI clients

Build—People responsible for the part of the extract, transform, and load
(ETL) process involving the creation of up-to-date cBase and model files
on a regular, usually nightly, schedule


mailto:support@dimins.com
https://www.dimins.com/how-to-contact-dimensional-insight/
https://www.dimins.com/how-to-contact-dimensional-insight/
https://www.dimins.com/international/
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Roles are independent of machines or engines and more than one role can be
performed in the same environment. For example, if the people responsible for
content development are also responsible for testing and validation, you can
combine the Development and Test roles in the same environment. However,
Test and Development environments should be isolated from the Production
environment to prevent untested content from reaching users.

DI supports and recommends the use of virtual machines to manage resources.
A best practice is to host virtual machines on hardware dedicated to DI
applications.

DI recommends that the Production, Development, and Test environments
reside on separate machines, either physical or virtual, and host one Diveline
service for each role.

NOTE: DI recommends running Bridge on a separate Diveline, with port
number 3330. Bridge serves as a gateway to all other applications.

About Diver Platform Server 7.0
The Diver Platform Server 7.0 package includes a license utility as well as the
following setup files:

 Bridge-Setup.exe

» Diveline-Setup.exe

» DivePort-Setup.exe

» NetDiver-Setup.exe

The di-license-admin.exe file is also part of the Server package.

DI recommends that you isolate installation environments by role. Each role,
such as Development, Test, and Production, should have its own server
environment to ensure optimal data processing. You can install multiple server
environments on computers with VM capabilities. In some cases, several roles
can share a single server environment by assigning different DivelLine port
numbers to each role.

The following table shows common mid-range deployment environments and
the Divelines that they typically connect to on a physical or virtual machine.
Each installed DivelLine requires its own port number and license. You must
perform a complete Diver Platform Server installation for each Diveline.

( W

LProduction 2130 J
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Environment Port Number

Test 2131

Development | 2132

Build 2135

Bridge 3330
N J

The following table shows common low-range deployment environments and
the DivelLines that they typically connect to on a physical or virtual machine.

Environment Port Number
Production 2130
LDeveIopment/Test 2132 J

NOTE: DI recommends running Bridge on a separate Diveline, but it is not
required. For more information, see Appendix A: Bridge on page 90.
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The following illustration provides an overview of the DI server infrastructure
that is installed with the Diver Platform Server package. It highlights the primary
clients and how the Diveline servers are installed on a virtual server machine.

! ! Installation

DivePort NetDiver
(client) (client)

HTTPS Certificate

Internet

Firewall

Divelines

NN
YVYV

Web Server Application Server(s)

Tomcat

NOTE: When using Unicode for one component, make sure all components are
Unicode. For example, you must have a Unicode Diveline server to serve
Unicode encoded content to a Unicode client.

About Diver Platform Developer 7.0

The Diver Platform Developer 7.0 package includes the following executable
files:

» di-broadcast.exe—A Diveline client that delivers data to selected users
through email. Deliveries can be scheduled on an episodic or periodic
basis, or triggered by a specific event.

+ di-config.exe—A Diveline subcomponent that allows an administrator to
configure Diveline options by using a Windows user interface. Included to
ease transition from version 6.x to 7.0. In 7.0, DI-Config functionality is part
of the Workbench Server Settings.

 di-scheduler.exe—A Diveline subcomponent that allows administrators
to schedule jobs by using a Windows user interface. Included to ease



Diver Platform 7.0

transition from version 6.x to 7.0. DI-Scheduler functionality is integrated
into Workbench.

e HelpDesk-Setup.exe—Installation software for the desktop component
of the Diver Platform. Help Desk provides access to user maintenance for
client-server applications on Diveline. It requires a separate license.

» ProDiver-Setup.exe—Installation software for the desktop analytics
client of the Diver Platform. ProDiver is the client in a client-server
architecture, which means it requires a connection to a DivelLine server to
access data.

» Workbench-Setup.exe—Installation software for the integrated visual
development environment to develop, test, and manage projects
associated with Diver Platform software.

The Diver Platform Developer package contains the Workbench and ProDiver
clients that are required to build a DI data infrastructure. You install the
developer software on computers independent of any other computers or
machines that contain the server software. The developer software typically
resides on computers intended for the system administrator or DI content
developers.

The following illustration shows some of the components of Workbench and
ProDiver that are installed with the DI Platform Developer package. You can see
that all of the client applications in this package are installed on user computers
connected to the application server behind the company firewall.

Diver Platform Developer Installation Application
Production / Build Envrionment Server
' N
OEEEN
EOEEE
HEOER Spectre
EEECE . i
EEEEO Integrator Diveline
Workbench  Production #3130
[client)

M
YVV

e

ProDiver Help Desk
[client) [client)
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Software Requirements

Before you install and operate Diver Platform 7.0 software, ensure that the
following application server, web server, and desktop client requirements are
met. In general, DI recommends that you use the latest versions.

TIP: Check the DI website periodically for new Security Notices.
NOTE: A 64-bit operating system is required for servers.

Application and

Support Notes
Web Server

Microsoft Windows | Minimum version required to run DivelLine version 7.0
Server 2008 R2 with Spectre. Server 2008 and later includes Microsoft
.NET Framework which is needed for Workbench.

Microsoft Windows | Fully supported.
Server 2012

Fully supported in the following configurations: Red
Hat Enterprise Linux, CentOS, Debian, Ubuntu, SuSE.

Linux

Latest version is recommended. 64-bit is required.

The Mono component is required to run Diver Solution
and Diver Platform on Linux systems.

DI recommends that you download the latest release
from http://www.mono-project.com/download/.

Desktop Operating

Support Notes
System

Microsoft Windows 11 | Fully supported.

Microsoft Windows 10 | Fully supported.

Microsoft Windows Fully supported.
8.1
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Desktop Operating

Support Notes
System

Microsoft Windows 8 | Fully supported.

LMicrosoft Windows 7 | Fully supported. J

NOTE: Controls for HTTP cookies and JavaScript must be enabled for each client
computer's web browser.

Web Browser Support Notes

Internet Explorer 9 or later | Fully supported. Version 11 or later
recommended.

Google Chrome, Mozilla Fully supported. Latest version recommended.

Firefox
¥

&

NOTE: The following third-party software comes bundled with the DI installers
for Windows.

Java Support Notes

Java 1.7.0.51 Minimum version required for use of DIAL in 7.0.

OpenJDK 11 Latest version is recommended.

NOTE: Diver Platform 7.0 is compatible with Java 11

and later, and OpenJDK.
N J

IMPORTANT: Due to Java licensing changes, updates for Oracle's Java Runtime
Environment are no longer available for business, commercial, or production
use without a commercial license. DI recommends using OpenJDK.

Apache Tomcat Support Notes

Tomcat 9.0 Latest version is recommended.
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Apache Tomcat Support Notes

Tomcat 8.5.0 Minimum version required for use of web clients. On
Tomcat 8 and later, make sure to remove the
unpackWAR attribute from the context tag in
DivePort's context xml file. The unpackwaRr attribute
is removed for Tomcat 8 and later by using the

Dimensional Insight installers.

Tomcat 7.0 Tomcat 7.0 reached its end-of-life as of March 2021,

and no longer receives updates. DI recommends

updating to Tomcat 9.0.

Microsoft Support Notes

.NET Framework 4.0 or | The .NET Framework helps you create mobile,
later desktop, and web applications that run on Windows

PCs, devices, and servers.

NOTE: When installing to a VM, DI recommends that you use a fixed Media
Access Control (MAC) address. This prevents licenses issues if the VM is
relocated. See the VMware Knowledge Base at http://kb.vmware.com.

Building the DI Directory Structure

Prior to downloading and installing DI Platform server and developer software
for 7.0, DI recommends that you create the following directory structure on your
machine:

\DI
\Projects
\Solution
\downloads
\licenses
If yours is a large site where content is developed, tested, released, and
extracted in four separate phases, but the content is stored on a single server,


http://kb.vmware.com/
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consider using a four-stage release process with a slightly different DI directory

structure.

| Stage 1: Development

Stage 2: Testing

| Stage 3: Production

Stage 4: Build

\DI
“Dew
\Projects
\Sclution
\downloads
\licenses

\Projects

\Sclution
\downloads
\licenses

“Liwve
\Projects
\gclution

‘\downloads
\licenses

Y ETL

\Projects

\Sclution
\downloads
\licenses

NOTE: This reflects the environments used on a single server so the b1 directory
has subdirectories for each environment.

You can install server and developer software on a single machine or different
machines using the same directory structure. You can install Java and Apache
Tomcat third-party software using DivePort-Setup.exe.

The following table provides a brief description of the default directories and
subdirectories that the installer uses in a typical DI directory structure.

Directory Subdirectory Description

DI \Projects Default location for Workbench projects.
This folder is created manually.

DI \Solution Default location for folders and files
created by DI product installations. This
folder is created manually.

DI\Solution | \downloads Default location for DI software
downloads. This folder is created
manually.

DIN\Solution | \licenses Folder for licenses and key files. This
folder is created manually.

10
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Directory Subdirectory Description

DI\Solution | \diveline Subdirectory with program files required
by the DivelLine service. Each installed
DivelLine instance can have its own

\diveline folder.

DIN\Solution | \dl-dataroot Top level directory for the Diveline
server for configuration information,
cache, and log files. Each installed
Diveline instance can have its own \d1-

dataroot folder.

DI\Solution | \executables Default location for many DI executable
files.
DIN\Solution | \webapps Program, configuration, and setup files

for DivePort and NetDiver.

DIN\Solution | \webdata Data and customization files for DivePort

and NetDiver.
o J

About Diver Platform and Solution 7.0 Licenses

Diver Platform 7.0 is the paid upgrade path for customers who want to use the
Spectre engine, DiveTab, or Measure Factory. Diver Solution 7.0 is the free,
standard software upgrade path for Diver Solution 6.4 customers on a
maintenance plan. Users licenses differ depending on whether you use Diver
Platform or Diver Solution.

NOTE: Some features, such as Input Tables, Measure Factory, and Help Desk,
are licensed separately from your Diver Platform or Diver Solution license.
Contact your Dimensional Insight sales representative for more information.

Diver Platform Licenses

User categories are defined for Diver Platform licensing. To use different client
programs, a user can belong to multiple license categories. Each named user is
in zero or more user categories.

11
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Each category has a limited number of users, based on the number of licenses. If
more users are assigned to the category than the license allows, excess users are
denied access. Users that do not authenticate successfully are denied access
and told to contact an administrator.

The user license types for Platform 7.0 are:

» Developer—Grants access to Workbench and all Diver clients

ProDiver—Grants access to ProDiver, Broadcast, and DIAL
DivePort—Grants access to DivePort and NetDiver
DiveTab—Grants access to DiveTab for the iPad and PC

Help Desk—Grants access to Help Desk and DI-Config to manage user
account changes without consuming a Developer license

Diver Solution Licenses

Diver Solution 7.0 maintains the tiered user licensing scheme that is used in
Diver Solution 6.4, with the addition of a new tier called Developer. Different
tiers give users access to different client programs. Each named user is in one
tier only. If you assign more users to a tier than the license allows, the
administrator sees a warning, and the last user assigned is disabled.

The tiered user types for Solution 7.0 are:

» Developer—Grants access to Workbench and all Diver clients

» Advanced—Grants access to ProDiver, DivePort, NetDiver, DI-Config, DI-
Broadcast, DI-Scheduler, and DIAL

e General—Grants access to DivePort, NetDiver, and DI-Config
e Casual—Grants access to DivePort

What Is Named User Licensing?

Diver Platform and Diver Solution use named user licensing. In this type of
licensing scheme, each user has their own unique logon information and can be
logged on from only one computer at a time.

About License Types

Whether you use Diver Platform or Diver Solution, your product licenses fall into
one of two categories:

Perpetual Licenses

You use a perpetual license for software that you purchased on a maintenance
contract. This type of license allows you to have a certain number of users and
virtual environments based on the conditions in your maintenance contract and
provides for routine software updates.

12
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Perpetual licenses become outdated on the same day that your maintenance
contract ends. When you renew your maintenance contract, you receive a new
license so that you can continue to receive software updates.

If you choose not to renew your maintenance contract, you can continue to run
the software using the outdated license. However, you cannot upgrade the
software or move it to a new computer.

Trial Licenses
You use a trial license for software that you are trying for a short period of time.

Trial licenses have an expiration date. After the expiration date passes, you can
no longer run the software that the trial license enables.

NOTE: A license's expiration or maintenance date is always on the first of the
month. For example, a license with a maintenance date of 11/2021 becomes
outdated on November 1st, 2021.

13
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Installing Diver Platform Server

These installation procedures use most of the installer defaults. Be sure to alter
the defaults as required when you repeat these steps to create separate
environments, for example, Test versus Production. See Building the DI
Directory Structure on page 9 and About Roles and Environments on page 2.

Downloading the Server Installation Package
You can download purchased software from the Dimensional Insight website.

1. Using a web browser, go to the Dimensional Insight website:
http://www.dimins.com.

2. On the home page, click Sign In.

4,920436.8298 & info@dimins.com Support English

thf‘;‘scioﬂa}. Home  What'sNew  Industries ~ YourRole ~ Technology ~ Partners ~ Resources ~ Company ~ 0O

The Customer & Distributor Login Area page opens.

3. Click DI Download / Customer Log In.

Customer & Distributor Login Area

Download Software, Release Notes, And Product Documentation

DI Download / Customer Log In &®

NOTE: Customers using IE8 and IES have reported issues reaching DI
Download via this web site. These customers should type in the url

address directly into the URL address bar where they will be
presented with a popup window and required to enter a username

Distributor / Partner LOg In @ and password: https://www.dimins.com/customersite/. Also note

that you must NOT block pop ups!

Documentation @ Others may log in using the following 2 links. Contact Customer
Support to request a password to the following areas: DI
Download/Customer Log in, Distributor/Partner Log in.

Training ®

CUSTOMER SUPPORT
Hours: 7:00am to 5:00pm CST
Tel: 920-436-8299

Email: support@dimins.com

A dialog box prompting for your sign-in information opens.

14
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@ www.dimins.com
This site is asking you to sign in.
Username
Password
(:ance'

4. Enter your Username and Password, and click OK.
The Dimensional Insight Customers home page opens.
5. Click DI-DOWNLOAD.

Welcome to the home page for

Dimensional Insight Customers

All software packages and release notes are available on DI-DOWNLOAD.
If you have any questions, contact our Customer Support Team at support@dimins.com.

DI-DOWNLOAD
Download the latest software updates and documentation.
>>DI-DOWNLOAD

The software and documents download page opens.

main website  contact

Dimensional

I'NSITGHT
download training consulting blog

Client: Dimensional Insight, Tech

- Info 6.4 6.4.1 (1166KB) Previous Point Releases Net Available Not Available

- Licensing 7.1 Update not available Mone Available Not Available Not Available

- Licensing 7.0 7.0.29 (23102KB) Previous Point Releases Not Available Not Available

- Licensing 6.4 6.4.25 (2817KB) Prewvious Point Releases Net Available Not Available -

6. Locate the latest version of the 7.0 software that you purchased, and click
the blue version number.

15
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Diver Platform Server 7.0 linux64_uc limited 7.0.53 (500027KB)

Diver Platform Server 7.0 linux64 7.0.53 (499973KB)

Diver Platform Server 7.0 linux64 limited 7.0.53 (499972KB)

Previous Point Releases
Previous Point Releases

Previous Point Releases

Release Notes (B77KB)
Release Notes (877KB)

Release Notes (877KB)

Manual (9309KB)
Manual (9309KB)

Manual (9309KB)

-
Diver Platform Server 7.0 Windows Unicode limited 7.0.53 (1257384KB)

Diver Platform Server 7.0 Windows 7.0.53 (1257467KB)

Diver Platform Server 7.0 Windows limited 7.0.53 (1257464KB)

Previous Point Releases
Previous Point Releases

Previcus Point Releases

Release Notes (877KB)
Release Notes (877KB)

Release Notes (877KB)

Manual (9309KB)
Manual (9309KB)

Manual (9309KB)

Diver Solution Asian Language Pack 7.0 Windows Unicode 7.0.53 (130770KB)

Previous Point Releases

Not Available

Not Available

The Opening download verification dialog box opens.

Opening diver-platform-server-7.0.53.3-winx64.zip

Yeu have chosen to cpen:
; diver-platform-server-7.0.53.3-winx64.zip

which is: Compressed (zipped) Folder
from: https://www.dimins.com

What should Firefox do with this file?
(O] Open with
() Save File
[[] Do this automatically for files like this from now on.

Cancel

Windows Explorer (default) ~

The Downloading page opens in the browser. If the Opening dialog box
does not open automatically, follow the instructions on the page:

Downloading: Diver Platform Server 7.0.53 Windows

If the download fails, click here.

To return to your downloads list, click your browser's ‘Back’ button.

Please tell us what you were trying to download and which web browser you were using (including version).

Select Save File, and click OK..
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Opening diver-platform-server-7.0.53.3-winx64.zip *

You have chosen to open:
: diver-platform-server-7.0.53.3-winx64.zip

which is: Compressed (zipped) Folder
from: https:/fwww.dimins.com

‘What should Firefox do with this file?
(O Open with | Windows Explorer (default) w

[] Do this automatically for files like this frorm now on.

Cance'

The Diver Platform Server software package zip file downloads to the
Downloads directory on the local computer.

NOTE: Most browsers enable you to configure the download location for
files downloaded from the Internet. For example, if you are using the
Firefox browser in Windows, you can choose Settings > General and
configure the download location in the Files and Applications section.

Extracting the Server Installation Package
After you download the Diver Platform Server 7.0 software package, extract the
files:
1. Move the server package from your Downloads directory to the
DI\Solution\downloads directory.
2. Right-click the package and select Extract All, or use a third-party tool, to
unzip the file.

The following executable files are extracted to the directory:

4 Bridge-Setup.exe
1) di-divelinezip
lg_,ﬁ di-license-admin.exe
% Diveline-Setup.exe
{2 DivePort-Setup.exe
(i di\rer-platform-ser\rer-?.D.S3.3-winx54.zip§|)
[&] MetDiver-Setup.exe

1) web-tools.zip

17
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Requesting a License

Before you install the DI server software, you must request and install a DI
license. You must do this for every physical or virtual environment in your
deployment.

Complete the following process using the same machine that you plan to install
the licenses on later. Keep in mind that your machine must have Internet access

to submit a license request.

To request a license to install the Diver Platform Server 7.0 and Diver Platform
Developer 7.0 packages:

1. Navigate to the DI\Solution\downloads directory.
2. Double-click the di-license-admin.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

3. Click Yes.
The DI-License-Admin utility starts.

44 DI-License-Admin - *
File Help

Manage Licenses | Request Licenses

Use thiz page to adminizter your product licenses. Click Install to register a new licensze file, Delete to remove a
license fram this machine, and Properties to see the details of a selected license.

Fegistered Products:

Froduct | Werzion | License Type | Expiration/Maintenance Date

Imztall...

4. Click the Request Licenses tab.

18
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On the left, the Machine Name, Operating System, and Machine
ID boxes are populated with your machine's information.

On the right side of the dialog box, the Applications to License box is
populated with the licenses you can request.

5_‘,‘] Dl-License-Admin - *
File Help

Manage Licenses Request Licenses

Usze thiz form to request licenzes for Dimenzional Inzight applications. & licenze file will be emailed to the address you
specify,

Customer Information

M arre: |J0hn Smith Phane: |555-555-5555
Cormpary: |Dimensi0nal Insight Email: |ismith@dimins.com
Machine Mame: h Tﬂpplications ta License [Select all that apply]: )
|ismith-DD1 Diver Platform 7.0 BI - Diveline: < ports ~
Operating System: Diver Solution 7.0 - Diveline: <port>
|wind0ws Developer Package 7.0
Machine!o: =
aehne Diveline 7.0:<port>
|HWDD: 50:56:c0:00:08 DI-Diver 7.0

4| | PraDiver 7.0

Distributors... || Diver Solution B.4 - DiveLine:<port> ¥

Comments/Questions:

5. Complete the Customer Information section.

'ﬁ] Dl-License-Admin - *
File Help

Manage Licenses Request Licenses

Use thiz form to request licenses for Dimenzsional Insight applications. A license file will be emailed to the address you
zpecify.

Customer Information
Marne: |J ohin Smith Phore: |555-555-555

Compary: |Dimensi0nal Insight Email: |ismith@dimins.com

6. Specify details about the server-side licenses that you want to request:

a. Inthe Applications to License box, select the license that enables
the server-side software that you purchased. For example, if you
purchased Diver Platform Server 7.0 for Windows, select Diver
Platform 7.0 Bl - DiveLine <port>.
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The Define Port-locked Information dialog box opens.

lﬂ] Define Port-locked Information X

“ou've selected a port-locked Diveline. To request a port-locked license, you must specify a port number,
“You may alzo specify optional user information. A Diveline product with this port and information will then
appear in the list of products,

Fart Number:  |2131

Specify the number of each uzer type [Optional]

Developer: |1 Advanced: |1 General: |1 Casual |1
oK | Cancel |

Enter the port number that you want to use.

You must specify a unique port number for every virtual
environment in your deployment.

TIP: The default port number is 2130, however you can use any
number that you want.

If you know the number of users of each type that you purchased
access for, complete the remaining fields.

Otherwise, Dimensional Insight Customer Support can find this
information when they create your license.

Click OK.

The options that you specified display as a new entry in the
Applications to License box.

Applications to Licenze [Select all that apply]:

Diiver Platform 7.0 Bl - Diveline: <ports F
Diver Platform 7.0 Bl -- Diveline: 2131 [Dew:1 Pro:1 . DPork: 1.0 T sk

Diver Salution 7.0 - Diveline:<port>

Diiveline 7.0:<port>
DI-Diver 7.0
ProDiver 7.0

Repeat Steps a through d to request a server-side license for each
virtual environment on your machine.

NOTE: If you plan to install Bridge, Dimensional Insight recommends
that you request an additional server-side license. When
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implementing Bridge, you typically install an extra DiveLine that only
Bridge connects to.

7. In the Applications to License box, select the remaining licenses for the
products that you purchased.

For example, if you purchased Diver Platform, select Developer Package
7.0.

8. In the Comments/Questions box, specify any additional purchases, such
as Input Tables, Measure Factory, or Help Desk, and include any
comments or questions that you have. Dimensional Insight recommends
that you also provide your machine's media access control (MAC) address.

NOTE: If installed on a virtual machine and that machine is relocated, a
new license is required. This can be avoided by ensuring the virtual
machine is installed with a fixed MAC address. For more information, see
http://kb.vmware.com.

9. Click Submit to open the Submit License? dialog box showing your
selections.

ﬁ Submit License?

You are requesting a license with the following information:

Mame: John Smith

Email: jsmith@dimins.com

Phone: 555-555-5555

Company: Dimensional Insight

Machine Mame: jsmith-001

Machine 1D: HWO0:50:56: c0:00:08
Operating System: windows

Application: Diver Platform 7.0 Bl --
Diveline:2131{Dev:1,Pro:1,DPort:1,DTab: 1)

Do you wish to submit the license request?

10. Click Yes to submit the license request.
11. Click OK to acknowledge the submission.

ﬁ‘] License Information Submitted X

The license key request has been submitted
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12.

13.

14.

Click Save to store the license request file to the pT\solution\licenses
directory.

NOTE: In the event that the installation does not have internet access,
locate the saved request file (for example, di_request _jsmith-001.request)
and forward to a machine with email access. Send the request file to
support@dimins.com.

After DI Customer Support sends you the requested license, save it to the
DI\Solution\licenses directory.

Opening Dimensienal_Insight_Inc-jsmith-001-licenses-v7-20200417 zip *

Yeu have chosen to cpen:
Dimensional_Insight_Inc-jsmith-001-licenses-v7-20200417 zip

which is: Compressed (zipped) Folder (683 bytes)
from: -

‘What should Firefox do with this file?
(O Openwith | Windows Explorer (default) ~

®):5ave File

[[] Do this automatically for files like this from now on.

Cancel

NOTE: Some email programs might include this file as inline text. Make
sure that the license file is an attachment.

Right-click the package and select Extract All, or use a third-party tool, to
unzip the file.

The following example shows a Diver Platform Server 7.0 license file:
c3931 jsmith-001 platform70 p2131 m202107.license

Installing a License File

After receiving a Dl license file (and before attempting to install the software),
you must extract the attached file from the support email to
DI\Solution\licenses, and then install the license file.

TIP: After installing a new license, restart DiveLine and Tomcat, and close and
reopen the software to update the license information.

22
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Navigate to the DI\Solution\downloads directory.
Double-click the di-license-admin.exe file.
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The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

3. Click Yes.
The DI-License-Admin utility starts.

4. On the Manage Licenses tab, click Install.

£ Di-License-Admin - X
File Help

Manage Licenses | Request Licenses

Use thiz page to adminizter your product licenses. Click Install to register a new licensze file, Delete to remove a
license fram this machine, and Properties to see the details of a selected license.

Fegistered Products:

Product | Yersion | License Type | Espiration/M aintenance Date

Install...

5. From the Open License File dialog box, navigate to the
DI\Solution\licenses directory.

6. Select the license file that you want to install, and click Open.

NOTE: If you are replacing an existing license with a more restrictive
license, the Restrictive License Info dialog opens, asking if you still want
to install the file. Note the conditions of the new license, and click Yes.

The license program displays a confirmation message.
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&2 License Installed >

License Installed Successtully

7. Click OK.
The license displays in the list of Registered Products.

4 Di-License-Admin - X
File Help
Manage Licenses | Request Licenses

Use thiz page to adminizter your product licenses. Click Install to register a new licensze file, Delete to remove a
licenze fram this machine, and Properties ta see the details of a selected license.

Fegistered Products:

Product | Y ersion | Licenze Type | E xpiration/M aintenance Date
DiverlBl - 2131 7.0 Perpetual 42021 |

Inztall..

NOTE: Open the DI-License-Admin utility to the Manage Licenses tab to
view all registered products and their license types.

Installing DiveLine

DiveLine is the Diver server component that authenticates users and provides
centralized access to cBase and model data. DiveLine shares processing with
various DI clients, such as Workbench, DivePort, ProDiver, NetDiver, and
DiveTab. DivelLine accepts connections from clients and communicates with
them by means of a proprietary protocol. DivelLine runs in the background as a
service and requires a Windows user account that you or the installation wizard
creates.

Note that with Diver Server 7.0, DI is building 64-bit encrypted DiveLines only.
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NOTE: You need to be an administrative user to install the software.

To install DivelLine, complete the following steps:

1. Navigate to the DI\Solution\downloads directory.

2. Double-click the DiveLine-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.

Confirm that you want to open and run the executable.

3. Click Yes.

The DiveLine 7.0 Setup Wizard dialog box opens.

% Diveline 7.0 (53.2) Setup

- x

Welcome to the Diveline 7.0 (53.2)
Setup Wizard

This wizard will quide you through the installation of Diveline
7.0 (53.2).

Itis recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
cormputer.

Click Mext to continue.

4. Review the setup instructions, and click Next.

The Installed DivelLines page displays.
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%= Diveline 7.0 (33.2) Setup — *

1 3 Installed Divelines
Pan‘ée]?séoﬂall List of currently installed Divelines

Current Diveline installations:

Upgrade
Modify

Uninstall

(®) Install New Get Version

Mullsaft Install Swstem w246

5. Select the Install New option. This page lists any existing DivelLine
installations, which you can choose to Upgrade, Modify, or Uninstall.

6. Click Next.
The DivelLine Paths page displays.

%= Diveline 7.0 (53.2) Setup — X

Dimensional Pvetine Paths

I NS I GHT

DI Solution | C:\DI\Solution

Paort number: 213

Dataroot directory: | di-dataroot B

Projects directory: | C:\DIVProjects

Mullsaft Install Swstem w2, 46

7. Accept the default values or select new ones for the following options:

» DI Solution—The default pathis c:\DI\Solution.

e Port number—The default port number is 2130, but it must match
the port number used in the license request. Assign unique port
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numbers for different environments. For example, 2131 for a Test
environment.

Dataroot directory—The default directory is d1-dataroot. If you
previously installed DivelLine or have another instance, you can
choose that Dataroot directory. However, sharing dataroots between
environments such as test and production is not recommended.

DI Projects directory—The default directory is C: \DI\Projects.
8. Click Next.
The DivelLine Service Settings page displays.

&= Diveline 7.0 (53.2) Setup — e

Dimensional — Diveline Service Settings

Service Name: | DI-Diveline-2131 Install directory: | diveline |

Service Display Name: | DI-Diveline-2131 |

Service Description: | Test Diveline |

Diveline Service User
Create a new Windows user (Warning: This action will occur when you dick Next)

The service will run as the following Windows user:

User name: |divelineuser | Password:

S1TGHT

9. The Diveline Service Settings dialog box is populated with default values
(which you can change).

» Service Name—The default is DI-Diveline. If you specify a port

number other than the default, 2130, the port number is appended
to the end of the name. For example, DI-DiveLine-2131.

Install directory—The default is diveline. You can change this to
give it a meaningful label. For example, specifying a particular
DivelLine if more than one is in use.

Service Display Name—The default is DI-DiveLine. If you specify a
port number other than the default, 2130, the port number is
appended to the end of the name. For example, DI-DivelLine-2131.

Service Description—Add a service description; recommended
when more than one diveline resides on a machine. The description
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should indicate the purpose of the Diveline. For example, Test
DiveLine.

» Diveline Service User—Specifies which user on the machine owns
the Diveline service. Clear the Create a new Windows user check
box if you have already identified a Windows user for the DivelLine
service. The Windows user must have administrator rights.

NOTE: A non-blank password for the Windows user is required.

» User name—The default is divelineuser. If you are not creating a
new Windows user, enter the existing user name and password. If
you are creating a new user, choose a user name and enter and
retype a password for the account.

This is the user that runs the service in the background. You can
either create a new Windows user, divelineuser, on your machine to
act as the Diveline Service user, or use an existing user by clearing
the Create a new Windows user check box and entering an
existing Windows user name and password.

10. Click Next.

The DivelLine Users page displays. You must specify an Administrative
user name and password and, optionally, create a test user. Be sure to re-
type the password. The administrative user is needed in order to access
and make configuration changes to the DivelLine server. A test account is
useful for verifying access by a non-administrative user.

NOTE: If you used a preexisting Dataroot directory (see Step 7), this
DiveLine Users dialog box is skipped.



%= Diveline 7.0 (33.2) Setup —

Dimensional =~ Pvetine Users
| H S | G H -I Set up Diveline users

Administrative user name: | admin |

Administrative password: | senes |
Re-type | [TI1T] |
Create a test user
Test user name: | test |
Test user password: | seee |
Re-type password: | sees |

Mullsaft Install Swstem w246
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Creating an administrative user enables you to log in to DivelLine. No

specified user results in an inaccessible Diveline.

A test user gives you a non-administrative user to test with. To create a
test user, select the Create a test user check box, and enter a Test user

name, a Test user password, and re-type the password.

11. Click Next.
The Diveline Certificate page displays.

%+ Diveline 7.0 (53.2) Setup —

Dimensional Diveline Cerificate
| NS I GHT

[ skip this step This information will become part of your encryption certificate and
will be visible to users via their web browser.

Country code (e.q. US): List of Country Codes | State (=.g. MA):

Location (e.g. Boston): | Burlington

Organization {e.q. Acme Widgets): | Dimensional Insight |

Server Name: |jsmiﬂ1-0[)1 | Email: |jsmiﬂ1@dimins.com

If you have existing Diveline certificates, enter them here:

Existing private key file: | |

Existing certificate file: | |

Mullsaft Install System w2, 46

12. Do one of the following:
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« If you do not want to create or use an encryption certificate, select

Skip this step. This is not recommended.

NOTE: If you select this option, users see a message similar to This
site is insecure when using DivelLine to access data. If you have
existing DiveLine certificates, click the ellipsis buttons to locate and
select their private key files and certificate key files.

If you do not already have an encryption certificate, fill in the
following fields to create one:

° Country code—Enter your two character country code. Click
List of Country Codes to display a complete list of country
codes.

o State—Enter your state abbreviation.
° Location—Enter a city name or other identifier.

° Organization—Enter the name of your company or
organizational name.

o Server Name—Enter the name of the server (the machine
name).

o Email—Enter an email address.

If you already have an encryption certificate (for example, from a
previous installation), select your private key and certificate files.
These files are located in the DI\Solution\<DiveLine
directory>\install-files directory, and are the privatekey.txt
and certificate.pem files.

13. Click Next.

The DivelLine License page displays. Browse for and open the license file.



%= Diveline 7.0 (33.2) Setup —

Dimensional ~ Dvetine bicense
| H S | G H -I Setup your Diveline license

Current License Information:

DI-Solution Product Registration Tool, Version 7.0 (53.2)
Copyright (C) 1998-2020 by Dimensional Insight, Inc
http: /fwww.dimins.com/ support@dimins.com

License data for Diveline 7.0 on Windows:
License Type: Perpetual
Licensed to: Dimensional Insight, Inc.
Modeocked to: HW28:d2:44:77:8a:e3
Port number: 3330
User categories and limits:

Browse for a license file:

Mullsaft Install Swstem w246

C:‘n,DI‘nSquﬁon‘n,licenses\cSQS:l_]'smiih—DDlJ:ulatForm?DJ:| D Add License

< Back MNext =

14. Click Add License.

15.

16.

The Result of adding license window opens.

Result of adding license:

Dl-Solution Product Registration Tool, Version 7.0 (53.2)
Copyright [C} 1988-2020 by Dimensional Insight, Inc
http:/fwww.dimins.com/  support@dimins.com

Using
“ChDMSolutiontlicenses\c3931_jsmith-001_platform70_p2131_m202104.1i
cense” as license file,

Registration data for Diver|Bl saved successfully.

The license was installed successfully to the machine's license store,
which is available to all users.

To confirm that the license is valid, you will need to run the program.

Licensed to: Dimensional Insight, Inc,
Mode lock active. Locked to: HWO00:50:56:c0:00:08

%+ Diveline 7.0 (33.2) Setup *

Click OK.
The window closes.
Click Next.

Diver Platform 7.0

The Required Software page displays for installing Java 7 or later (if not
already installed). This is required to run DIAL (Dimensional Insight Access

Language) and DivePort.
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%= Diveline 7.0 (33.2) Setup — *

Dimensional Reauired Software
I'NSIGHT

Java is required for DIAL

Existing Java Installation (must be Java 7 or later):

Install Java

Mullsaft Install Swstem w246

NOTE: If Java already exists on your machine, it appears in the Existing
Java Installation box with the Install Java check box cleared. Click Next,

and proceed to Step 21.
17. Click Next.
The Install Java page displays.

%+ Diveline 7.0 (53.2) Setup - >

Dimensional =~ 'stall Java
I'NSIGHT

Java installation directory:
| C:'Program Files\Java'jdk-11.0.6+10

License Agreement

11 have read and accept the terms of the Java license agreement. Install Java

Installation Result:

Mullsoft Install Svstem w246

< Back Mext = Cancel

18. Do the following:
» Accept or change the Java installation directory.
» Click License Agreement to open the terms of the license.
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» Select the license agreement check box to accept the license terms.
 Click Install Java. This might take several minutes.

19. After you see the Successfully installed Java message in the Installation
Result text box, click Next.

20. When the Ready to Install dialog box opens giving a summary of the
pending Diveline installation, click Install.

%= Diveline 7.0 (33.2) Setup — *

1 3 Ready to Install
Pan‘ée]?séoﬂall Summary of the pending installation

Please review the information below. When you are ready, press "Install”.
The Diveline service will be stopped, disconnecting any users.

Date: 2020-05-11 -~
New Installation:
Product: Diveline
Wersion: 7.0 (53.2)
DI Solution location: C:\DI\Solution
Diveline path: diveline
Diveline dataroot: di-dataroot
Service name: DI-Diveline-2131
Service display name: DI-Diveline-2131
Service description: Test Diveline
Service port: 2131
Service user: . \divelineuser
Fiinval ina admin nears admin

Mullsaft Install Swstem w246

< Back Install Cancel

21. When you see the Installation Complete confirmation message, click
Finish.

%= Diveline 7.0 (33.2) Setup —

Dimensiona] ~ 'ntafiation Complete
| N S | G H T Setup was completed successfully,

Completed

Show details

Mullsaft Install System w2, 46

< Back Cancel
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Diveline Files
The Diveline installation wizard adds the following files to the
C:\DI\Solution\executables directory:

 dial.jar—The Dimensional Insight Access Language component that
enables you to remotely analyze and report the content of models and
cBases.

» di-broadcast.exe—The Diveline client that provides scheduled or event-
driven delivery of Diver markers using email.

 dicfg.exe—The Diveline subcomponent that allows an administrator to
configure Diveline options using a command line tool.

+ di-config.exe—The 6.x Diveline client that allows an administrator to
configure Diveline options using a Windows user interface. It is included
to ease the transition from 6.x.

o dictl.exe—The 6.x command line tool for DI-Controller; used to
disconnect users accessing a particular model or cBase. It is included to
ease the transition from 6.x.

o disch.exe—The 6.x command line tool for DI-Scheduler. It is included to
ease the transition from 6.x.

* di-scheduler.exe—The 6.x DivelLine subcomponent that allows an
administrator to create, automate, and monitor events related to DI
products using a Windows user interface. It is included to ease the
transition from 6.x.

 di-updater.exe—The subcomponent that creates a package for
managing downloads to Diveline.

» diver.exe—The desktop version of the Diver application. It does not work
with cBases.

» exportinfo.exe—The subcomponent that provides machine identification
information for licensing a machine that is not connected to the Internet.

» prodiver.exe—The desktop analytics client of the Diver Platform.
* register.exe—The command line tool for license maintenance.

In addition to the above listed executables, the Diveline installer adds the
following Diver 7.0 executables to the c:\DI\Solution\<DiveLine
directory>\bin directory:

 builder.exe—The Diver component that transforms data by summarizing
and preprocessing it in order to create classic models.
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 dial.jar—The Dimensional Insight Access Language component that
enables you to remotely analyze and report the content of models and
cBases.

 di-diveline.exe—The main component of the Diveline application server
software that servers data to client applications.

+ di-listener.exe—The component of the application server that manages
incoming client connections.

+ di-logger.exe—The component of the application server that collects a
list of activities performed by the server.

 di-scheduler-engine.exe—The component of the application server that
handles the scheduling of jobs.

 di-service.exe—The component of the application server that manages
services.

* integ.exe—The Diver Solution extract, transform, and load scripting tool.

» spectre.exe—The data analysis software that is used to build and query
cBases. It powers the DivelLine server software for efficient queries from DI
clients against those cBases.

Testing the Diveline Installation

To verify the successful implementation of Diveline, you must connect to the
correct Diveline port on the server using a DivelLine client, such as prodiver.exe.

NOTE: This test uses a copy of the ProDiver application placed on the server by
the Diveline installer.

Complete the following steps:

1. Navigate to the DI\Solution\executables directory.
2. Double-click the prodiver.exe file.

ProDiver and the DI-DivelLine Hostname dialog box opens.

Dl-Diveline hosthamme?

ok | Cahicel |

3. Enter the server name. For example, jsmith-001:2131.
4. Click OK.
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5. If this is the first time you are opening a client after the server install in
which you created a self-signed certificate, the client opens the Verify
Certificate dialog box asking you to verify and accept the certificate
presented to the server.

Verify Certificate

The server requires encryption, but presented an unknown
certificate. Please verify the following and indicate whether or not
you trust this certificate. If you do, you will not be asked again.

Certificate Owner: Details = >

Jsmith-001
Dimensional Insight
Burlington, MA US

Accept | Decline ‘

6. If you want to view information about the certificate, click Details.

7. Click Accept to trust the certificate.

8. On the DivelLine Login dialog box, enter the DivelLine Username and
Password.

L‘_ Diveline Legin.. >

Server Jzmith-001:2131

Username: |

Password: [

Connection encrypted

| LCancel |

9. Click OK to open the ProDiver home page.
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B ProDiver — O X

File Edit Organize Display Window Help

= B-FESR EEOOEP Lo NEE E

|Ready |Logged in as admin (jsmith Al

10. To verify the installed version of ProDiver, click Help > About ProDiver.

About DI-ProDiver... x

% Dimenzional Insight, Inc.
DI-PraDiver 7.0 [53.2] (S5L)

Copyright 1991-2020 Dimengional [nzight, 1he.

Diveline Informatian: A

Server jzmith-001:2131

Diveline Yergion 7.0 [53.2)

Connection encppted with S5L [ECOHE-RSA-AES256-GCM-
SHa384) ]

11. Click File > Exit.

Installing DivePort

DivePort is a client component that resides on a web application server, typically
Apache Tomcat. DivePort uses portlet web technology (both page and portlet
instances) to create and customize presentations and dashboards using data
compiled from multiple sources, including ProDiver markers and Spectre Dive
files. You access DivePort using an Internet web browser.

NOTE: You need to be an administrative user to install the software.
To install DivePort:

1. Navigate to the D1\Solution\downloads directory.

2. Double-click the DivePort-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

37



Diver Platform 7.0

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

3. Click Yes.
The DivePort 7.0 Setup Wizard dialog box takes a moment to open.

€3 DivePort 7.0 (52.2) Setup — *

Welcome to the DivePort 7.0 (53.2)
Setup Wizard

Thig wizard will guide you through the installation and
maintenance of DivePort 7.0 (53.2).

4. Click Next to continue.

5. The Installing a New Portal page opens.

{3 DivePort 7.0 (53.2) Setup - X

. : Installing a New Portal
P']Jr[‘ée]i.qéoﬂa-]r Enter the location of the DI Solution directory.

DI Solution folder:
| C:\DI'Solution

< Back Cancel

6. Verify the default locations for the DT solution directory.
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7. Click Next to continue.

The Required Software page opens.

{3 DivePort 7.0 (53.2) Setup — X

Dimensional —Reauired Software
I'NSIGHT

Java and Apache Tomcat are reguired for DivePort

Existing Java Installation (must be Java 7 or later):

| C:\Program Files\Java'jdk-11.0.6+10

install Java

Existing Tomcat Installation:

Install Apache Tomcat

This dialog prompts you to install Java (version 7 or later) and Tomcat.
8. Select the check boxes for the software you must install or update.

TIP: If a path appears in the Existing Installation box, the software is
already installed.

« If you installed Java, verify the existing path, and skip to Step 10.

« If you installed Java and Tomcat, verify the existing paths, and skip to
Step 12.
9. Click Next.

The Install Java page opens.
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& DivePort 7.0 (33.2) Setup — *

Dimensional '@l Java

I NSITGHT

Java installation directory:
| C:'\Program Files\Javaljdk-11.0.6+10

License Agreement

11 have read and accept the terms of the Java license agreement. Install Java

Installation Result:

< Back MNext = Cancel

10. Perform the following actions:
» Accept or change the Java installation directory.
» Click License Agreement to open the terms of the license.
» Select the license agreement check box to accept the license terms.
* Click Install Java. This might take several minutes.

After the installation finishes, the wizard displays the message
Successfully installed Java in the Installation Result box.

11. Click Next.

The Install Tomcat page opens. If you already installed Tomcat, skip to
Step 12.
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{3 DivePort 7.0 (53.2) Setup — X

Dimensional =~ 'mstall Tomeat
I'NSIGHT

Tomcat installation directory:

| C:'\Program Files\Apache Software Foundation{Tomcat 9.0

License Agreement
11 have read and accept the terms of the Tomeat license agreement. | Install Tomeat

Installation Result:

< Back MNext = Cancel

12. Perform the following actions:

13.

» Accept or change the Tomcat installation directory

 Click License Agreement to open the terms of the license
 Select the license agreement check box to accept the license terms
 Click Install Tomcat

After the installation finishes, the wizard displays the message
Successfully installed Tomcat in the Installation Result box.

Click Next.
The Create Certificate for HTTPS page opens.

Because DivePort resides outside of the company firewall, it requires an
HTTPS certificate to communicate with the Tomcat protocol which resides
inside the firewall.
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{3 DivePort 7.0 (53.2) Setup — X

Dimenqlonal Create Certificate for HTTPS

| NS I GHT

Warning: a self-signed certificate produces browser warnings [ skip this step

File Out: | C:\Users\jsmith\Documents ke ystore |

Mame (e.qg. server1.company.com): |jsmiﬂ1-ﬂDl |

Organizational Unit: | BI Software |

Organization Dimensional Insight City/Locality: |Burlingb3n |
StateProvince: 24etter Country Code: Password:

Creation Result:

Create Certificate

< Back MNext = Cancel

This step enables you to create a self-signed certificate. You can create a
self-signed certificate to get your DivePort working as soon as possible.
You can later create a Certificate Service Request that you can forward to a
certification authority, such as GoDaddy. You can then work with this
vendor to install a fully validated HTTPS certificate. The vendor (certificate
authority) from whom you purchase the certificate should provide you
with or point you to directions for installing the certificate.

NOTE: If you want to skip this step and subsequently create a Certificate
Service Request (CSR) document using the wizard, select Skip this step
and proceed to Step 14.

To complete the self-signed certificate, enter the following information:

 File Out—The path to the directory where you want to store the
certificate. The default path is
C:\Users\<user name>\Documents\keystore.

* Name—The server name that the DivePort connects to. If you are
performing a local installation, enter the name of that machine.
Otherwise, this value is typically the domain name of your site. For
example, a local installation is jsmith-001, while a domain name is
<server>.<company>.com.

» Organizational Unit—A name that describes your type of business.
For example, Bl Software.

» Organization—The name of your company. For example,
Dimensional Insight.
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» City/Locality, State/Province, and 2-Letter Country Code—The
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location where your company is licensed to do business with local or

state government.

e Password—The certificate password, which defaults to tomcat. Be
sure to remember the password,

if you create a CSR.

14. Click Create Certificate to generate the certificate and display the
message Successfully created Certificate in the Creation Result box.

15.

16.

17.

NOTE: A self-signed certificate generates browser warnings requiring you
to verify the authenticity of the certificate.

Click Next.
The Certificate Signing Request for

HTTPS page opens.

The wizard populates the dialog box with information needed by a
Certificate Authority to authorize the signed certificate (for example,
keystore location and tomcat_cert_request.csr location).

€3 DivePort 7.0 (53.2) Setup

Dimenqlonal Certificate Signing Request for HTTPS

I NS T GHT

Submit this Certificate Signing Regquest (.csr) file to a Certificate
Authority to obtain a signed certificate

[ skip this step

- X

Key File: | C:\Users\jsmith\Documentskeystore

File Qut: | C:Wsers\jsmith\Documents\tomeat_cert_request.csr

Request Result:

< Back Mext =

Create Request

Cancel

If you generated a self-signed certificate in the previous step, you can

select Skip this step to continue with
certificate. Proceed to Step 16.

the installation of the self-signed

Optionally, click Create Request to create a certificate request. Upon

completion, the wizard displays the m
Request in the Request Result box.

Click Next.

essage Successfully created

The Install Certificate for HTTPS page opens.
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{3 DivePort 7.0 (53.2) Setup — X

Dimensional 'mta Cetificate for HTTPS
| NS I GHT

DivePort requires a secure (HTTPS) connection through Tomcat [ skip this step

Site Certificate for HTTPS:

| C:\WUsers\jsmith\Documentskeystore
Certificate Password:
| tomcat |

Self-Signed Certificate Instructions Install Certificate
Installation Result:

< Back MNext = Cancel

18. Click Install Certificate to install the self-signed certificate created in Step
12.

Upon completion, the wizard displays the Successfully installed
certificate message in the Installation Result box.

The following events happen when you install the self-signed certificate:

» The wizard copies the certificate keystore from
C:\Users\<User>\Documents (when generated) to C:\Program
Files\Apache Software Foundation\Tomcat 9.0\conf (when
installed).

e The wizard updates the server.xml file located in the conf directory
with the following line of XML code:

<Connector port="443"
protocol="org.apache.coyote.httpll.HttpllProtocol"
SSLEnabled="true" maxThreads="150" scheme="https"
secure="true" clientAuth="false" sslProtocol="TLS"
keystoreFile="C:\Program Files\Apache Software
Foundation\Tomcat 9.0\conf\keystore"
keystorePass="tomcat" />

The HTTPS-enabled self-signed certificate enables your DivePort to
communicate with the server over the Transport Layer Security (TLS)
communication.

TLS is a security protocol for establishing an encrypted link between a
server and a client, typically a Web Server and a browser, or a mail client
and another mail client.
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19. Click Next.
The Installing a New Portal page opens, with the following field defaults:

» Portal name—The default name is diveport. You can change it to
suit your needs.

e Path to DI Solution folder—The default folderis c:\DI\Solution.

» Path to Java—The default path is c: \Program
Files\Java\jrel.8.0 121.

e Path to Tomcat—The default pathis c:\Program Files\Apache
Software Foundation\Tomcat 9.0.

A best practice is to change the default Portal name to something other
than diveport (for example, diveport-test) to keep the software distinct
from the project or application implementation. One installation of the
software can support multiple instances or portals. Verify the other default
fields.

€3 DivePort 7.0 (52.2) Setup — *

Dimensional ~'stelline 2 New Portal ,
nter the name of the new portal, and verify these system
|HS|GH] lEteﬁ'l f th tal, and verify th e
ocations.

Portal name: | diveport-test |
(This will appear in the portal URL)

DI Solution folder:
| C:\DI'Solution |

Java Funtime Environment version 7 or later:
| C:\Program Files\Javaljdk-11.0.6+10 |

Apache Tomcat Server version 7.0 or later:
| C:\Program Files'\Apache Software Foundation\Tomcat 2.0 |

Space Required: 291 MB

20. Click Next.

The second Installing a New Portal page opens, with the default name of
the Diveline service and port number (for example, jsmith-001:2131).
Verify that the port number matches the DivelLine service. This dialog also
prompts you to enter the administrator Username and Password
previously defined for the Diveline administrator.
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{3 DivePort 7.0 (53.2) Setup — X

Dimensional stalling a New Portal

Enter the Diveline server string and administrator logon
I NSTGHT infarmation

DiveLine server and port number:
[ jsmith-001:2131 |

Username: | admin |

Password: [seese |

Mullsaft Install Swstem w246

21. Click Next.

The Ready to Install page opens, with a summary of the DivePort
installation information.

{3 DivePort 7.0 (53.2) Setup — X

1 3 Ready to Install
Pan‘éer?qéorl}all Here is a summary of the pending installation.

When you are ready, press 'Install’.

Mew Installation [2020-05-12] ~
Portal name: diveport-test
Portal URL: https: //jsmith-001:443/diveport-test
Preduct: DivePort
Version: 7.0 (53.2)
DI Solution location: C:\DISolution
Diveline Server: jsmith-001:2131
Diveline Admin: admin
DivePort IP: 192.168.179.1
(this will be added to Diveline's gateway_ips)
Installer running as user: jsmith (in Administrators group)
System memory: 2047 MB
Java JRE location: C:\Program Files\Java'jdk-11.0.6+10

Bemcbn Tamet bt Colfienar—am Clanlfnadha Cafhemes Conmda$nelTamet 00

W

Mullsaft Install Swstem w246

< Back Install Cancel

NOTE: Take note of the Portal URL. This is used to access DivePort from a
web browsesr.

22. Click Install.

23. When you see the Completing the DivePort 7.0 Setup Wizard dialog
box, click Finish.
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{3 DivePort 7.0 (53.2) Setup _

Completing the DivePort 7.0 (53.2)
Setup Wizard

URI Encoding

The default URI encoding for Tomcat is ISO-8859-1. For earlier versions of
DivePort, the server.xml file installation instructions included setting the
URIEncoding variable to UTF-8. This setting is not performed by the Windows
installer for version 7.0.

ISO-8859-1 and UTF-8 overlap for the ASCII character set. When DivePort
software generates URLs, non-ASClI characters are encoded so that the URL
only contains ASCII characters. For these generated strings, either ISO-8859-1 or
UTF-8 encoding is acceptable.

It is possible that a user might want to enter a URL directly, which could contain
non-ASClI characters. If those characters are high-bit ISO-8859-1 characters,
either the default or a URIEncoding="UTF-8" is not accurate. If a user intends
to enter URLs that contain non-ASCII characters, they should set the
URIEncoding on their Tomcat connector according to the encoding they intend
to use. This is done by stopping Tomcat, editing the server.xml file, and
restarting the service. See Step 17 about the connector section in Installing
DivePort on page 37.

Configuring Apache Tomcat

After installing Tomcat as part of the DivePort install wizard, you need to verify
the size of the Maximum memory pool and select the Use default box under
the Java tab of the Tomcat<version #> Properties dialog box.

The maximum memory pool is the memory that can be allocated to the JVM. It
is also known as the "Tomcat Heap".
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The initial Tomcat Heap for a standard DI installation should be 4GB (4096 MB).
If a customer needs to exceed 10GB, they should contact DI Technical Support
to help them diagnose their environment and suggest possible tuning options.

Complete the following steps:

1. Open Windows Explorer and navigate to the Tomcat bin directory at
C:\Program Files\Apache Software Foundation\Tomcat 9.0\bin.

2. Inthe bin directory, double-click the tomcat9w.exe file.

The Tomcat9 Properties dialog box opens.

%, Tomcat Properties X

LogDn Logging Java  Startup  Shutdown

Service Name: tomcats

Display name: | Tomcatd |

Description: | |

Path to executable:

"C:\Program Files\Apache Software Foundation\Tomcat 9.0%iniTamcata,

Startup type: Automatic -

Service Status:|  Started

Start Stop Pause Restart

Cancel Apoly

3. On the General tab, verify that the Startup type is set to Automatic and
that the Service Status is Started.

4. On the Java tab, verify that the Maximum memory pool is set to 4096
MB.
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Eg. TomecatT Properties
General LogOn Logging Java  Startup Shutdown

[ use default
Java Virtual Machine:

| C:\Program Files\Java\jdk-11.0.6+10binserver jvm.dl |

Java Classpath:

| C:\Program Files\Apache Software Foundation {Tomcat 9.0%in\bootstrap |

Java Options:

Deataling.home =C:\Program Files\Apache Software Foundation\Tor A
-Deataling.base =C: \Program Files\Apache Software Foundation {Tom
-Djava.io.tmpdir=C:\Program Files\Apache Software Foundation{Tom

-Djava.utll. logging.manager =org. apache. juli. ClassLoaderLogManage

ot 2t lmsires ceursBirs Bl i Wi rurar e Sl Aevms o s, Coe

Java 9 Options:

Initial memory pool: | | MEB
Maximum memary poal: | 4095 | MEB

Thread stack size: | | KB

Cancel Apply

section on the General tab.
Click Apply.

Diver Platform 7.0

5. To implement any changes, click Stop then Start in the Service Status

To verify that the Tomcat service is working on your machine, open a
browser and type http://<DiveLine server>:8080 in the URL box. 8080 is
the default port number for the Tomcat webserver.

For example, http://jsmith-001:8080.

The following Apache Tomcat confirmation page appears in your

browser window:

Home Documentation Configuration Examples Wiki Mailing Lists

Apache Tomcat/9.0.31

™  Recommended Reading:
Security Consi i How-To
/& Manager Application How-To

Clustering/Session Replication How-To

Find Help

# APACHE

Server Status
Manager App

Host Manager

Verifying the DivePort Installation

To verify a successful implementation of DivePort, complete the following steps:
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1. Open a browser and enter the URL for the DivePort portal, using a format

similar to the following:

https://<servername>/<portal name>

For example, https://jsmith-001/diveport-test, where jsmith-001 is the
server name, and diveport-test is the name of the DivePort portal. The
URL must use a secure version of an HTTP, or HTTPS. This URL can also be
found in Step 20 of Installing DivePort.

Proceed to Step 5 if you installed a signed HTTPS certificate during the
initial install.

NOTE: DivePort resides outside of the company firewall and requires an
HTTPS certificate to communicate with the Tomcat protocol.

2. The first time you log on to DivePort after an installation using a self-

signed certificate, you see the Your connection is not secure warning
page.

Warning: Potential Security Risk Ahead

Firefox detected a potential security threat and did not continue to jsmith-001. If you visit this site, attackers could try
to steal information like your passwords, emails, or credit card details.

Learn more...

Go Back (Recommended) Advanced...

3. Click Advanced to view the error message: The certificate is not trusted

because it is self-signed.
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1. Warning: Potential Security Risk Ahead

Firefox detected a potential security threat and did not continue to jsmith-001. If you visit this site, attackers could try
to steal information like your passwords, emails, or credit card details.

Learn more.

Go Back (Recommended) Advanced...

Websites prove their identity via certificates. Firefox does not trust this site because it uses a certificate
that is not valid for jsmith-001.

Error code: MOZILLA_PKIX_ERROR_SELF_SIGNED_CERT

View Certificate

Go Back (Recommended) Accept the Risk and Continue

4. If you created a self-signed certificate using the DivePort installation
wizard, click Accept the Risk and Continue.

The exception is added to the browser automatically.

NOTE: You need to verify that your DivePort connection is secure when
using a self-signed certificate on each machine that uses the DivePort
client. In other words, include this information in your end-user training.

5. If you see the Welcome to DivePort page with a log on prompt, you have
successfully installed DivePort.

Dimensional
INSICH

Sl ivepor

Username: Password:

nd The Diver Solution tra

£ 2020 Dimensional Insight, Inc. All rights reserved, DivePart
demarked by Dimensi i

6. To log on to DivePort, enter the administrator Username and Password
from the Diveline installation, and then click Log On.

7. In the menu bar, click About to open the About DivePort information
page with the version numbers for DivePort and Diveline.
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DivePort

wersion 7.0 (53.2)
Diveline 7.0 (53.2)

© 2020 Dimensional Insight, Inc. All rights rezerved.
DivePort and The Diver Solution trademarked by

Dimensional Insight, Inc.

. r

8. In the menu bar, click HELP and then View Administrator Help or View
User Help to view the DivePort Help for the Administrator or User.

Here is the Welcome page for the DivePort Administrator Help.

Dimensional DivePort Help DivePort Basics  Features  Reference
I'NSIT GHT

Search DivePort Help |Search All Files ~ | Q
DivePort 7.0 Administrator Help

Using Help Overview What's new

Navigation tips About DivePort in DivePort 7.0

® © e

Charts Portlets Maps

Visualize data Organize and customize data Present your data on a map

¢l m 9
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Here is the Welcome page for the DivePort User Help.

Dimensiona] DivePort Help  DivePort Basics  Accessing Resources

I NSIT GHT Viewing and Analyzing Data  Managing Data  Reference

Search DivePort Help |Search All Files v‘ Q
DivePort 7.0 User Help

Using Help Overview 7.0 Features

Navigation tips About DivePort New DivePort features

© 0,

Navigation Resources Dashboards

Getting to the data About DI, and support links Monitor KPls

r\

DivePort Help opens in your default browser.

Installing NetDiver

NetDiver is a web-based application that resides on a web application server,
such as Apache Tomcat. NetDiver enables authorized users to access and
analyze their data on the web.

NOTE: You need to be an administrative user to install the software.

To install NetDiver, complete the following steps:

. Navigate to the DI\Solution\downloads directory.

2. Double-click the NetDiver-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm

making changes to your device.
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NOTE:: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

3. Click Yes.
The NetDiver 7.0 Setup Wizard dialog box opens.

BT MetDiver 7.0 (33.2) Setup — *

Welcome to the NetDiver 7.0 (53.2)
Setup Wizard

Thig wizard will guide you through the installation and
maintenance of NetDiver 7.0 {53.2).

4. Click Next.

The Installing a New NetDiver page opens, with default names and
locations for the following:

» NetDiver portal name, as you want it to appear in the NetDiver URL.
The default is netdiver. Change it to suit your needs. For example,
netdiver-test.

» DI Solution directory

» Java Runtime Environment, version 7 or later, directory

» Apache Tomcat Server, version 7 or later, directory
Verify the default locations and make changes if necessary.
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BT WetDiver 7.0 (33.2) Setup —

Dimenqiona] Installing a New MNetDiver
| N § | - GHT Enter the name of the new NetDiver, and verify these system

locations.

NetDiver name: | netdiver-test |
(This will appear in the MetDiver URL)

DI Solution folder:

Java Runtime Environment version 7 or later:

Apache Tomcat Server version 7.0 or later:

Space Required: 19 MB
Mullsaft Install Swstem w2, 46

| C:\DI'Solution |
| C:\Program Files\Javaljdk-11.0.6+10 |

| C:\Program Files'\Apache Software Foundation\Tomcat 9.0 |

5. Click Next.

Diver Platform 7.0

The Installing a New NetDiver page displays. The name and port

number defaults to the DivelLine server.

BT NetDiver 7.0 (33.2) Setup —

1 1 Installing a New NetDiver
Pan‘ée]?séoﬂall Enter the default Diveline server string

Default Diveline server and port number:
[ jsmith-001:2131

[ allow the user to change servers
(Check thiz if you want this NetDiver to be able to connect to many different Divelines)

Mullsaft Install Swstem w2, 46

If you want NetDiver to connect to different Divelines, select Allow the

user to change servers.
6. Click Next.

The Ready to Install page displays, with a summary of the NetDiver

installation information.
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BT WetDiver 7.0 (33.2) Setup — X

1 3 Ready to Install
P']‘n‘ée]i.qéoﬂa-]r Here is a summary of the pending installation.

When you are ready, press 'Install'.

Mew Installation [2020-05-12]
MetDiver name: netdiver-test
MetDiver URL: https: f{jemith-001:443/netdiver-test
Product: MetDiver
Version: 7.0 (53.2)
DI Solution location: C:\DISolution
Diveline Server: jsmith-001:2131
User can change servers: MO
System memory: 2047 MB
Java JRE location: C:\Program Files\Java'jdk-11.0.6+10
Apache Tomcat location: C:\Program Files\Apache Software Foundation\Tomcat 9.0
Apache Tomcat maximum heap size: 4096 MB

< Back Install Cancel

NOTE: Take note of the NetDiver URL. This is used to access NetDiver
from a web browser.

7. Click Install.

8. When you see the Completing the NetDiver 7.0 Setup Wizard dialog
box, click Finish.

BT MetDiver 7.0 (53.2) Setup —

Completing the NetDiver 7.0 (53.2)
Setup Wizard

NOTE: In the netdiver.html file (located in the
C:\DI\Solution\webapps\<netdiver>\dlcgi directory), sDI. EXTRAS allows
you pass URL parameters when using DLCGI authentication.
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NetDiver Customizations

If NetDiver is launched from DivePort, DivePort sends a skin parameter to
NetDiver, which NetDiver uses if it is valid. If a parameter is not sent, NetDiver
uses the context file parameter netdiver.skin if valid and present. If unavailable,
NetDiver uses the skin called default.txt.

To change the NetDiver skin from the default:

1.

Do one of the following:
» Copy and rename an existing skin file (recommended).

NetDiver skin files are located in the
C:\DI\Solution\webapps\<netdiver>\customization-

templates\skins directory.

e Create a new txt file.

NOTE: If launched from DivePort, use the same file name as the DivePort
skin.

2. Use a text editor to specify the values of the properties for the skin.

3. Save your skin file to the

C:\DI\Solution\webdata\<netdiver>\customizations\skins
directory.

To change the NetDiver skin when not launching from DivePort:

1.

5.

Position the desired skin txt file in the
C:\DI\Solution\webdata\<netdiver>\customizations\skins

directory.

Navigate to C:\Program Files\Apache Software Foundation\Tomcat
9.0\conf\Catalina\localhost directory.

Open the <netdiver>.xmlfile in a text editor.
Add the new parameter:
<Parameter name="netdiver.skin" value="<netdiver skin>.txt"

/>

Save the xml file.

Verifying the NetDiver Installation

To verify a successful implementation of NetDiver, complete the following steps:

1.

Open a browser and enter the URL for the NetDiver portal, using a format
similar to the following:

https://<servername>/<portal name>
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For example, https://jsmith-001/netdiver-test.
This URL can also be found in Step 6 of Installing NetDiver on page 53.

NetDiver resides outside of the company firewall and requires an HTTPS
certificate to communicate with the Tomcat protocol.

NOTE: The first time you log in to NetDiver after an install using a self-
signed certificate, you might see the Your connection is not secure
warning page. If so, add an exception. If you see the NetDiver logon page,
you have successfully installed NetDiver. You must verify that your
NetDiver connection is secure when using a self-signed certificate on each
machine that is used with the NetDiver client. That is, inform your new end
users to verify their NetDiver connection.

2. Tolog on to NetDiver, enter your Username and Password, and click Log
On.

w NetDiver
wersion 7.0 {53.2)

Username: Password:

€ 2002-2020 Di

3. The Open File dialog box appears with a list of NetDiver files.

Look in: @

demo-sales.mdl
demo_drs.dbk
demo_drs.mdl

File name: | | Open

Files of type: | MNetDiver Files (*.mrk,*.dbk,*.dvp,*.mdl, *.tnl) v| Cancel

If the dialog box does not open automatically, click the Open File icon,

2, on the top left. If no files are visible, verify that all file types are
selected.

4. Select a dbk file and click Open. For example, demo-divebook.dbk.
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5. Select an Area and a Topic and click OK to open. For example, Tabulars
and Sales Region.

Areas Topics

Southern Salespeople
Reports Business Type
Charts
Ad Hoc Analysis Month/Product MultiTab
Web Links Region/Month CrossTab
- Topic Info

ok | | Hide |

If you see a tabular similar to the following, NetDiver is functioning
correctly.

=k N & E i PROXY LOG OFF
Sales Region [demo-sales.mdl-Dive A]

Sales Region |Plan Units Total Plan Dollars Total Actual Units Total Actual Dollars Total m
Totals 2,092 8,630,600 2,526 9,624,200/[ 2 ¢ pigtory(demo-sales.mdl)
Far West 247 1,031,100 336 1,320,700 | & [23 Ssles Region
Mid Atlantic 306 1,342,300 403 1,680,200/) |
Mid West 222 850,200 260 779,600 9. Models
Mountain West 257 1,061,300 304 1,175,200 | =) demo-sales.mdl
Northeast 320 1,361,100 347 1,513,600 ; Industry Code
South 462 2,012,600 507 1,892,600 Business Type
Southwest 278 §72,000 369 1,262,300 Company Name
Sales Region
Customer Location
Sales Branch
Salesperson
Month
.. Product
-} Info
BE Time Series Info

6. Inthe menu bar, click About to open the About NetDiver information
page with the version numbers for NetDiver and DivelLine.

59



Diver Platform 7.0

NetDiver

version 7.0 (44.1)

@ 2002-2020 Dimensional Insight, Inc. All rights reserved.
MNetDiver and The Diver Solution trademarked by
Dimensional Insight, Inc.

7. Inthe menu bar, click HELP to open the help documentation in a new
browser window.

Dimensiona] NetDiver 7.0 Help  Getting Started  Presentation = Managing Data
I NSIGHT Glossary

Search NetDiver Help ‘ Search All Files vl Q

NetDiver 7.0 Help

Using Help Overview Diving

Finding information About NetDiver Find specific data

© == N

Tables

Organize data in a tabular format

Graphs Reports

Visualize data Present and share data
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Setting the Executable Path Variables

After you have installed the Diver Platform Server components, you must add
their directory paths to the System Variables > PATH on your machine.

For example:
e C:\DI\Solution\executables
e C:\DI\Solution\diveline\bin

NOTE: This example is specific to Windows 10. If you are running a different
version of Windows, the individual steps might differ.

To set the directory path variables for the executables, complete the following
steps:

1. Navigate to Control Panel\System and Security\System.

NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

The System window opens.

2 System - o x
& > v 4 E ControlPanel » System and Security > System v o O Search Control Panel
File Edit View Tools
[2
Control Panel Home . . .
View basic information about your computer
& Device Manager Windows edition
% Remote settings Windows 10 Pro

& 5ystem protection © 2018 Microsoft Corporstion. All rights =- Wl nd OoWS 'IO
@ Advenced system settings reserved. .

System
Processor: Intel(R) Cere(TM) i3-4200M CPU @ 2.50GHz 2.49 GHz
Installed memory (RAM):  £.00 GB (7.69 GB usable)
System type: 84-bit Operating System, x64-based processor P
enovo.
Pen and Touch: No Pen or Touch Input is available for this Display

Support Information

Computer name, domain, and workgroup settings

Computer name: jsmith-001 @) Change settings
Full computer name: jsmith-001

Seezlso Computer description:

Security and Maintenance Workgroup: \WORKGROUP

2. Click the Advanced system settings button.

The System Properties dialog box opens.
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System Properties =

Computer Name  Hardware Advanced  System Protection Remote

You must be logged on as an Administrator to make most of these changes.
Performance

Visual effects, processor scheduling. memory usage, and virtual memary

User Profiles
Desktop settings related to your sign-n

Settings...
Startup and Recovery
System startup, system failure, and debugging information
Settings...
Environment Variables...
OK Cancel Apply

3. On the Advanced tab, click Environment Variables.

The Environment Variables dialog box opens.

Envirenment Variables X

User variables for jsmith

Variable Value
TEMP Ci\Users\jsmith\AppData\Local\Temp
TMP C:\Users\jsmith\AppData\Local\Temp

System variables

Variable Value A
COMMPath C:\Program Files\Lenovo\Communications Utility
ComSpec CAWINDOWS\systern32\crnd.exe
configsetroot CAWINDOWS\ConfigSetRoot
DriverData CAWindows\System32\Drivers\DriverData
FP_NO_HOST_CHECK NO
JAVA_HOME CaDMNavatjdk-11.0.4+11
NUMBER OF PROCESSORS 4 v
New... Edit... Delete
OK Cancel

4. From the System Variables list, select Path and then click Edit.



Envirenment Variables

User variables for jsmith

Variable Value
TEMP Ca\Users\jsmith\AppData\Local\Temp
T™P C:h\Users\jsmith\AppDataiLocal\Temp

New... Edit... Delete
Systern variables

Variable Value &
NUMBER_OF_PROCESSORS 4
0s Windows NT

C:\Program Files (x86)\Intel\iCLS Client';C:\Program FileshIntel\iCL...
PATHEXT .COM;.EXE; BAT..CMD:. VBS; VBE; JS;.JSE;. WSF WSH: M5C
PROCESSOR_ARCHITECTURE  AMD&4
PROCESSOR_IDEMTIFIER Intel&4 Family & Model 60 Stepping 3, Genuinelntel
PROCESSOR LEVEL 6 e

New

Delete

Cancel

The Edit environment variable dialog box opens.

Edit environment variable

C:\Program Files (x86)\InteMiCLS Client\,

C:\Program Files\Intel\iCLS Client\,

%65ystemRoot%\system32

FeSystemRoot®

%5ystemRoot %\ System 32\ Whem

%65YSTEMROOT%:\ System32\WindowsPowerShellvw1.00

C:\Program Files\Intel\Intel(R) Management Engine Components\...

C:\Program Files\Intel\Intel(R) Management Engine Componentsil...
C:\Program Files (x86)\Intel\Intel(R) Management Engine Compon...
C\Program Files (x86)\Intel\Intel(R) Management Engine Compaon...
C:\Pregram Files\Inte\WiFi\bin\

C\Program Files\Common Files\Intel\WirelessCommon?,
C\Program Files (x86)\Intel\OpenCL SDIO3.0\bin\x 86

C:\Program Files (x86)\nte\OpenCL SDIO3.0\bin'x 64

C\Program Files (x86)\Common Files\Lenovo
CASWTOOLS\ReadyApps

CADNSolution\executables

CADNSolution\divelingbin

CADNSolutionJavajdk-11.0.1 \bin
CADNSolution\Java'jdk-11.0.1\kin

New
Edit
Browse...

Delete

Mowve Up

Move Down

Edit text...

Cancel

5. Click New.
6. Enter the new value.

Diver Platform 7.0

7. Repeat steps 5 and 6 for each value. These values are required:
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C:\DI\Solution\executables
C:\DI\Solution\diveline\bin

NOTE: Depending on the Windows version, the values are in a list or
string. If the values are in the string format, you must insert semi-colons as
a separator.

8. Click OK to save changes.
The Edit System Variable dialog box closes.
9. Click OK to exit the remaining dialog boxes.
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Installing Diver Platform
Developer

Downloading and Extracting the Developer Installation
Package

This topic describes how to download and extract the Diver Platform Developer
7.0 Windows software package. See Downloading the Server Installation
Package on page 14 for information on how to locate Dl installation files.

NOTE: Install Diver Platform Developer on your local computer, not the server.

See Building the DI Directory Structure on page 9 to prepare the client
computers.

Complete the following steps:

1. On the software and documents download page on DI-Download, locate
the latest version of the Diver Platform Developer 7.0 Windows installation
package, and click the version number.

Diver Platform Developer Pack 7.1 Windows 7.1.11 (382502KB) Previous Point Releases Not Available Not Available

Diver Platform Developer Pack 7.1 Windows limited Update not available MNone Available Not Available Not Available

Diver Platform Developer Pack 7.0 Windows Unicode limited
Diver Platform Developer Pack 7.0 Windows

Diver Platform Developer Pack 7.0 Windows limited

7.0.53 (423763KB)
7.0.53 (423747KB)

Update not available

Previous Point Releases
Pravious Point Releases

Mone Available

Release Notes (2405KB)
Release Notes (2405KB)

Release Notes (2405KB)

Manual (8409KB)
Manual (8409KB)

Manual (8409KB)

Diver Platform European Language Pack 7.1 Windows Unicode

7.1.11 (2276070KB)

Previous Point Releases

Not Available

Not Available 4

The Opening download verification dialog box opens.

You have chosen to open:

which is: Compressed (zipped) Folder
from: https://www.dimins.com

'What should Firefox do with this file?
(O] Open with
(") Save File

Windows Explorer (default)

Opening diver-platform-devpak-7.0.53.3-winx64.zip

diver-platform-devpak-7.0.53.3 -winx64.zip

[ Do this automatically for files like this frem now on.

Cancel
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The Downloading page opens in the browser. If the Opening dialog does
not open automatically, follow the instructions on the page.

Downloading: Diver Platform Developer Pack 7.0.53 Windows

If the download fails, click here.
Please tell us what you were trying to download and which web browser you were using (including version).

To return to your downloads list, click your browser's ‘Back’ button.

2. Select Save File and then click OK.

Opening diver-platform-devpak-7.0.53.3-winx64.zip >

Yeu have chosen to cpen:
diver-platform-devpak-7.0.53.3 -winxb4.zip

which is: Compressed (zipped) Folder
from: https://www.dimins.com

'What should Firefox do with this file?
(O Openwith | Windows Explorer (default) ~

( @Eﬁave File )

[] Do this automatically for files like this frem now on.

Cancel

The Diver Platform Developer 7.0 software package is saved to the
Downloads directory on your local computer.

3. Move the developer package to the bI\sSolution\downloads directory.

4. Right-click the package and select Extract All, or use a third-party tool, to
unzip the file.

The following executable files are extracted to the directory:

ﬁ di-broadcast.exe

ﬁ di-config.exe

ﬁ di-scheduler.exe

I : diver-platform-devpak-7.0.52.3-winx6d.zip
(& HelpDesk-Setup.exe

(& ProDiver-Setup.exe
(& Workbench-Setup.exe
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Installing ProDiver

ProDiver is the desktop analytics client of the Diver Solution and Platform. With
ProDiver, you can view and analyze model and cBase data with a graphical user
interface. You can create markers in ProDiver and use those markers to build
dashboards and presentations in DivePort.

NOTE: You need to be an administrative user to install the software.

The ProDiver installer places a copy of the Setup Wizard in the Program Files
directory for uninstalling purposes.

To install ProDiver:
1. Navigate to the DI\Solution\downloads directory.
2. Double-click the ProDiver-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable file.

3. Click Yes.
The ProDiver Setup Wizard dialog box opens.

(37 ProDiver 7.0 (53.2) Setup - x

Welcome to the ProDiver 7.0 (53.2)
Setup Wizard

This wizard will guide you through the installation of ProDiver
7.0 (53.2).

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue,

4. Review the setup instructions, and click Next.

The Installed ProDivers page displays.
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(3 ProDiver 7.1 (12.2) Setup — X

1 3 Installed ProDivers
Pan‘ée]?séoﬂall List of currently installed ProDivers

Current ProDiver installations (dick for details):

Upgrade

Uninstall

(®) Install New

Mullsaft Install Swstem w246

5. Select the Install New option.
This page lists any existing ProDiver installations, which you can choose to
Upgrade or Uninstall. If this is the first installation, Install New is selected
by default.

6. Click Next.

The ProDiver Install Path page displays the default installation path. For
example, C:\Program Files (x86)\Dimensional Insight\ProDiver.
Make changes if necessary.

(37 ProDiver 7.0 (53.2) Setup — *

Dimensional ~ PreDiver install Path
INSIGHT

ProDiver Install Directory:

| C:\Program Files (x36)\Dimensional Insight\ProDiver

Mullsaft Install Swstem w2, 46

7. Click Next.
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The Ready to Install page displays a summary of the pending installation.

(71 ProDiver 7.0 (53.2) Setup

1 H Ready to Install
Pﬁnge]?qéotl}a;ll Summary of the pending installation

Please review the information below. When you are ready, press “Install”,

Date: 2020-05-12

Installation:
Preduct: ProDiver
Version: 7.0 (53.2)

Install location: C:\Program Files (x86)\Dimensional Insight\ProDiver

Mullsoft Install System w2, 46

< Back Install Cancel

8. Click Install to install the ProDiver software.

When complete, the wizard displays the Installation Complete dialog

box.

(57 ProDiver 7.0 (53.2) Setup

- 3 Installation Complete
P'lln‘éeTiISEOIl}a]T Setup was completed successfully.

Completed

Show details

Mullsaft Install System w2, 46

< Back Cancel

NOTE: To view a running summary of the installation process, click the

Show details button.

9. Click Finish to close the installation wizard.
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NOTE: When you run the ProDiver installer for a new installation or an
upgrade, it associates dlk files with the ProDiver executable file for
opening ProDiver from DivePort.

ProDiver Installation Silent Option
The ProDiver installer has a "silent option" that administrators can use to run the
installer remotely on multiple workstations without interaction from the user.

To run the installer in silent mode, use the /s option (with case sensitive,
uppercase "/s") in the command line of the end user's computer. For example:

ProDiver-Setup.exe /S
The following options can be used for more control.

Option Description

/mode= Indicates the action for the installer. Values are:

e install
e upgrade
e uninstall

e list

If there are no existing installations, the installer defaults to
doing a new install. If there is one existing installation, the
installer defaults to doing an upgrade. If there are multiple
installations, there is no default mode—to perform an
upgrade or uninstall, you must specify the installation. Use
the list option to see existing installations.

/path= Indicates the target location. The default value for the path
is:

"C:\DI\Solution\executables\prodiver"
The installer writes a log file called installation.log to the

user-specified or default path with information about the
installation.

On computers with multiple installations, indicates which
installation to upgrade or uninstall. The format used is that
of the GUl installer (for example "ProDiver-2019-02-26-17-
41-29").

- J
NOTE: When output is sent to the console to display a list of errors encountered
when running, you might be prompted to press Enter to continue. If the

/installation=
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message does not indicate that the installer has completed, the process might
still be running in the background. If you need to perform other tasks, use a
separate command window.

Examples:

A new installation to the default path on a computer with no existing ProDiver:

ProDiver-Setup.exe /S
That installation can be upgraded using the same command line:

ProDiver-Setup.exe /S
A new installation to a non-standard path:

ProDiver-Setup.exe /S /path=c:\di\solution70\executables\prodiver70
If it is the only ProDiver on that computer, you can upgrade by using:

ProDiver-Setup.exe /S
If you want to be sure that you are doing a new installation or an upgrade,
specify the mode explicitly:

ProDiver—-Setup.exe /S /mode=install
ProDiver-Setup.exe /S /mode=upgrade

To see a list of installed versions:

ProDiver-Setup.exe /S /mode=list
An upgrade to a particular version:

ProDiver—-Setup.exe /S /mode=upgrade /installation=ProDiver-2019-
0804-12-58-26

Verifying the ProDiver Installation

To verify that the ProDiver installation was successful,, complete the following
steps:

1. Open the Windows Start menu and enter ProDiver in the Windows
search box.

2. In the Programs list, click ProDiver.

The DI-DivelLine hostname dialog box opens.

Dl-Diveline hosthamme?

ok | Canicel |

NOTE: If you used ProDiver to check the DiveLine installation, you will not
be prompted for the DI-DivelLine hostname. Instead, the DiveLine Login
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dialog box opens. Skip to Step 6. For more information about checking
Diveline, see Testing the DivelLine Installation on page 35.

3. If you are using the default port number 2130, enter <server>. If you are
using another port number, enter <server>:<port number>. For
example, jsmith-001:2131.

If the connection fails, the Select DiveLine Server dialog box opens. If the
connection is successful, skip to Step 6.

L‘_ Select Diveline Server... X

Server Name  [jsmith-00r1:2131 =]

[~ UseIPv6

4. Enter or select the name of the server and click Select.

NOTE: The default port number is 2130. If you are using another port,
specify it in the ServerName box by using the format <server
name>:<port number>.

The Verify Certificate window opens.

Verify Certificate X

The server requires encryption, but presented an unknown
certificate. Please verify the following and indicate whether or not
you trust this certificate. If you do, you will not be asked again.

Certificate Cwner: Details »»
jsmith-001

Dimensional Insight
Burlington, MA US

Accept | Decline ‘

5. Review the certificate and click Accept.

The Diveline Login dialog box opens.
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Server jzmith-001:2131
Usermame: |
Paszsward: [

Connection encrypted

| Cancel |
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6. On the DiveLine Login dialog box, enter the Username and Password

and click OK.
BN Diveline Login... bt
Server jemith-0071:2131
Username: |admin
Password: | *****
Connection encypted
OK | Cancel |

TIP: If you want to use a different server, click Cancel and return to Step 4.

7. Select File > Open, or click the Open icon, @

The Open File dialog box opens.

NOTE: Your display might contain different files.

B Open File >
Lookin:|t|.a’ j @ £ E
Mame | Size | Type | D ate Modified |
demo-divebook.dbk  33KB .dbk 1141941939 1241 PM
(& demo-sales.mdl 200 KB mdl 1/4/199910:13 PH
demao_drs.dbk 23KB .dbk 1141341933 12:42 PM
dema_drs.mdl BES KE .md| 94372008 4:34 PM
File name: |

Open |

Filez of bype: |F'r0Diver Files [.mdl;.dvp;.mrk;.dbk;.ref;.tnl;.qu:j Cancel

8. Select a dbk file and click Open. For example, demo-divebook.dbk.

9. Select an Area and a Topic, for example Tabulars and Sales Region, and

click OK.
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DiveBook Select ®

T abularz Southem Salespeople
Business

Charts
Ad Hoc Analysiz
‘wheb Links Region/tonth CrossTab

If you see a tabular display similar to the following, ProDiver is functioning
correctly.

BN ProDiver - O X
File Edit Organize Display Window Help

> B-§SR EEaEEP Loz hEE | E

Sales Region | Plan Units | Plan Dollars| Actual Actual
Total Total Units Total| Dollars Total

Totals 2,092| 8630600 2526 9,624,200
Far West 247 1,031,100 336 1,320,700
WMid Atlantic 306 1,342,300 403 1,880,200
Wid West 222 850,200 260 779,600

i 257 1,061,300 304 1,175,200
3200 1,361,100 347 1,513,600
462 2012600 507 1,892,600
278 972,000 369 1,262,300

7 Rows (Totals-T) Logged in as admin (jsmith

10. To view the version numbers of your ProDiver installation and DiveLine
server installation, select Help > About ProDiver.
Click OK to close the window.
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About DI-ProDiver... *

% Dlimenzional Insight, ne.
DI-PreDiver 7.0 (53.2] [S5L]

Copyright 1991-2020 Dimengional Inzight, Inc.

DiveLine Information:

Server jzmith-001:2131

Diveline Yergion 7.0 [(53.2)

Connection encippted with S5L [ECOHE-RSA-AES256-GCM-
SHa384)

11. To open ProDiver Help, select Help > View Help.
ProDiver Help opens in your default browser.

Dimensiona] ProDiver 7.0 Help  Getting Started Presentation = Managing Data
INSIGHT Glossary

Search ProDiver Help ‘ Search All Files v &

ProDiver 7.0 Help

Using Help Overview 7.0 Features

Finding information About ProDiver New ProDiver features

®

/

Tables

Organize data in a tabular format

Graphs Reports

Visualize data Present and share data

B
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Installing Workbench

Workbench is an integrated development environment (IDE), designed to
simplify and speed up development of applications to model your data. With
Workbench on your desktop, you can manage projects on the server and test
and visually examine your data flows and processes. In addition, Workbench
provides one point of entry for all your Diver data servers, consolidating the
tasks of developing, testing, and managing multiple data projects. The
Workbench installation process closes all open instances of Workbench, so be
sure to save any unsaved changes in Workbench before installing or updating
Workbench.

NOTE: You need to be an administrative user to install the software.
Complete the following steps:

1. Navigate to the bI\Solution\downloads directory.

2. Double-click the Workbench-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm that
you want to make changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable file.

3. Click Yes.
The Workbench 7.0 Setup Wizard dialog box opens.

(31 Workbench 7.0 (53.2) Setup — e

Welcome to the Workbench 7.0
(53.2) Setup Wizard

This wizard will guide you through the installation of
Workbench 7.0 {53.2).

Itis recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.

4. Review the setup instructions and click Next.
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The Installed Workbenches page opens.

(51 Workbench 7.0 (53.2) Setup _ %

1 H Installed Workbenches
P:'nge]?qéotl}all List of currently installed Workbenches

Current Workbench installations (cdick for details):

Upgrade

Uninstall

(®) Install New

Mullsoft Install System w2, 46

5. Select the Install New option. This page lists any existing Workbench
installations, which you can choose to Upgrade or Uninstall. If this is the
first installation, Install New is selected by default.

6. Click Next.
The Workbench Install Path page opens and displays the default

installation path. For example, C:\Program Files (x86)\Dimensional
Insight\Workbench. Make changes if necessary.

(51 Workbench 7.0 (52.2) Setup — >

Dimensional  Werkbench install Path
I NS T GHT

Install Directory:
| C:\Program Files (x86)\Dimensional Insight\Workbench

Mullsaft Install Swstem w2, 46
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7. Click Next.

The Ready to Install page opens and displays information on the
pending installation.

(51 Workbench 7.0 (53.2) Setup — X

1 1 Ready to Install
Pﬁn‘ée]?qéorl}all Summary of the pending installation

Pleaze review the information below. When you are ready, press “Install”.

Date: 2020-05-12
Installation:
Product: Workbench
Version: 7.0 (53.2)
Install location: C:\Program Files (x86)\Dimensional Insight\Workbench

Mullsoft Install System w2, 46

8. Click Install to install the Workbench software.

When complete, the wizard displays the Installation Complete page.

(37 Workbench 7.0 (53.2) Setup —

1 3 Ingtallation Complete
Pﬁn‘ée]?séoﬂall Setup was completed successfully.

Completed

Show details

Mullsaft Install Swstem w246

< Back Cancel

NOTE: To view a running summary of the installation process, click the
Show details button.

9. Click Finish to close the wizard.
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NOTE: The Workbench installer enables TLS 1.2 on Windows 7 if it was not
explicitly disabled by the user.

Verifying the Workbench Installation

To verify that the installation of Workbench was successful, complete the
following steps:

1. Open the Windows Start menu and enter Workbench in the Windows
search box.

2. In the Programs list, click Workbench.
NOTE: When you open Workbench for the first time, it prompts you to
select a directory for storing configuration files when you work offline. The

defaultis the c:\DI\Solution\dl-dataroot directory for the local
Diveline installation.

a. Click the Browse button to select a different Workbench
configuration directory.

b. Click Finish.

Configure Workbench — ] *
Configuring Local Machine
Select your corfiguration directary

To work offline, Workbench needs to know where to put the
configuration files.

You can reuse the dataroot of a local Diveline installation, or put it
somewhere else.

Configuration directory:

[C2\D1Soktion'd-dataroot \

Diveline ‘ Dataroot |

Diveline-2131

< Back Finish Cancel

3. If successfully installed, the Workbench Start page opens.
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222 Warkbench - m} X
File Edit View Tools Help

B-Bld e~ C 2 | -2
g

e Show | Schedules . || Showonlyfailed schedules [ | Displayorphaned schedules

Q @ @ Default Connections
Recent Connections
Recent Connections ]

Connect to server

Work Offline

Recent Projects

Select a connection to work on a project

Errors Running (0) Finished jobs Cutput Find Resulis Messages

4. To view the Workbench version number, click Help > About Workbench.
Click OK to close the window.

About Workkench

Workbench

Client Version 7.0 (53.2)

Copyright & Dimensional Insight, Inc. 2010-2018
Dimensional Insight, Inc.

Server Versions:
70(532)

Some icons by Yusuke Kamiyamane. All rights reserved.

5. To open Workbench Help in a browser window, click Help > View Help or
click the Question mark icon.
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Dimensional
I NSI GHT

Search Workbench Help

Using Help

Navigation tips.

Server Settings

Configurations

Workbench Basics Tools Add-ons  Additional Resources

Glossary

Search All Files v Q

7.0 Features
New Workbench Features

Overview
About Workbench

&

Production
Overview

The Workbench Help opens in your default browser. Here you can find
topics that explain how to connect to a server.
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Updating the DI Software

For best results, Dimensional Insight recommends using the most recent point
release of software, including Tomcat and Java software. The software Setup
Wizard has an option for upgrading your software.

NOTES:

The upgrade process differs depending on which software is being
updated.

Updating the Diveline server and its clients, DivePort and NetDiver,
requires temporarily stopping Tomcat.

Temporarily stopping Tomcat automatically disconnects users.

When updating Bridge or DivePort 7.0, if the installer has a newer version
of Tomcat 9.0 available than what is currently is installed, you have the
option to allow the installer to update Tomcat to that version.

The ProDiver installer places a copy of the Setup Wizard in the Program
Files directory for uninstalling purposes.

The Diveline, DivePort, Bridge, and NetDiver 7.2 installers allow updating
from7.1to0 7.2.

To upgrade your software:

1.
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Download the zip file for the software or software package from DI-
Download at http://www.dimins.com.

Move the file from your Downloads directory to the
DI\Solution\downloads directory.

To unzip the file, right-click the file and select Extract All, or use a third-
party tool.

Double-click the exe file. This example uses DiveLine-Setup.exe.

The User Account Control dialog box opens, asking you to confirm that
you want to make changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

Click Yes.
The DiveLine 7.0 Setup Wizard dialog box opens.


http://www.dimins.com/

%= Diveline 7.0 (33.2) Setup

Welcome to the Diveline 7.0 (53.2)
Setup Wizard

This wizard will guide you through the installation of Diveline
7.0 (53.2).

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.,

Click Mext to continue,

6. Review the setup instructions and click Next.

The Installed DivelLines page displays.

% Diveline 7.0 (53.2) Setup

(®) Uparade Diveline-2131
() Modify
() Uninstall

() tnstall New

DI-Diveline-3330

1 1 Installed Divelines
P']J%e]?qéoﬂa-]r List of currently installed Divelines

Current Diveline installations:

Port: 2131 ~
Run as: . \divelineuser

Status: running

Dataroot:
dl-dataroot
Executable:
C:\DI\Solution\diveline\bin\di-service w
£ >

Get Version

< Back Cancel

Diver Platform 7.0

NOTE: This page is called Choose an Action in some Setup Wizards.

7. Select the installation you want to upgrade.

TIP: Click the Get Version button to view the current installation version.

8. Click Next.

9. Follow the instructions to reach the Installation Complete or
Completing page.
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NOTE: The installer checks whether the existing license is valid.

10. Click Finish to finish the installation.
NOTES:

» Updating Diveline removes all data files from the Spectre cache, leaving

the metadata in place. This speeds up the upgrading process and allows
for a cache refresh operation.

Normally, upgrades to NetDiver do not require changes to a configured
Web Server authentication scheme. However, if you are upgrading Tomcat
to 7.0.73 or higher without upgrading the dlcgi.exe file, you may run into a
bug if you are using Windows usernames. Dimensional Insight
recommends upgrading dlcgi.exe using the one included in the latest 7.0
server package.

Renewing a License

You can request a new license from Dimensional Insight using the DI-License-
Admin utility. Keep in mind that your machine must have Internet access to
submit a license renewal request.

To renew a license;

84

. Navigate to the DI\ Solution\downloads directory.

2. Double-click the di-license-admin.exe file.

The User Account Control dialog box opens, asking you to confirm that
you want to make changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

. Click Yes.

The DI-License-Admin utility starts.
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&4 Di-License-Admin — *
File Help

Manage Licenses | Request Licenses

Uze thiz page to adminizter your product licenzes. Click Install to regizter a new licenze file, Delete to remove a
licenze fram thiz maching, and Properties to zee the detailz of a selected license.

Reqiztered Products:

Froduct | Versionl Licenze T_I,Ipel E xpiration/t sintenance D ate

Diveline - 3330 70 Perpetual 1420119
DiverlBl - 2131 7.0 Ferpetual 4/20;

Ingtall... | | Renew... ] Propertiesz. .. Delete

4. In the Registered Products list, select the license you want to renew.
5. Click Renew.

The Renew License window opens.
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44 Renew License X

Reguest a reneweal of an existing license. Flease check that uzer and machine information are corect. Any requests to change the license may be
entered in the Comments figld.

Application  [DiverlBl - 2131 7.0
Existing Licenze Detailz emies |J oh Srrith

Licenze data for DiverlBl A
Licensze Class: Enterprise Phone: |555_555_5555
Licenze Type: Perpetual )
Licenzed to: Dimengional Ingight, Inc.

Node-locked to: Hw/00:50:56:c0:00:08 |DFOD3-DE53 ) - - -
Port rurmber: 2131 Company: |D|rnen3|onal Ihzight

Uzer categonies and limits:

Developer: 1 — —
Di\reF'oIr:ll: 1 Email: ||sm|th@d|m|ns.com

DiveT ab: 1
PraDiver: 1

Mairtenance tarmination date: 4/2021
Software released after this date will not work, with this key Kachnelnonation

Licensed features:

(Enter any Comments, Questions, or Changes] fachiztlare ||sm|th-00‘|

Operating System: |wind0ws

M achine 10: |HWDD:50:58;CD:DD:DB

Subrmit | Canecel |

Verify the Customer and Machine Information on the license and make
changes where necessary.

Review the Existing License Details.

In the Comments, Questions, or Changes text box, enter any changes you
want to make to the license and include any comments or questions you
have.

Click Submit.
The License Information Submitted dialog box opens.

ﬁ License Information Submitted X

The license key request has been submitted

10. Click OK to acknowledge the submission.
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11. After DI Customer Support sends you the requested license, save it to the

12.

DI\Solution\licenses directory.

Opening Dimensional_Insight_Inc-jsmith-001-licenses-v7-20200417 zip
Yeu have chosen to cpen:
: Dimensional_Insight_lnc-jsmith-001-licenses-v7-20200417 zip
which is: Compressed (zipped) Folder (683 bytes)

from: .

‘What should Firefox do with this file?

(O Openwith | Windows Explorer (default) ~

@Eéave File

[ Do this automatically for files like this from now on.

Cancel

NOTE: Some email programs might include this file as inline text. Make

sure that the license file is an attachment.

To unzip the file, right-click the package and select Extract All, or use a

third-party tool.

The following example shows a Diver Platform Server 7.0 license file:

c3931 jsmith-001 platform70 p2131 m202107.license
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Uninstalling the DI Software

The software Setup Wizard has an option for uninstalling your software.
NOTES:

The procedure for uninstalling DI software differs depending on which
software is being removed.

Uninstalling the Diveline server and its clients, DivePort and NetDiver,
requires temporarily stopping Tomcat.

Temporarily stopping Tomcat automatically disconnects users.

The ProDiver installer places a copy of the Setup Wizard in the Program
Files directory for uninstalling purposes.

To uninstall your software:

1.

3.
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Double-click the exe file. This example uses Diveline-Setup.exe.

The User Account Control dialog box opens, asking you to confirm that
you want to make changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

Click Yes.
The DiveLine 7.0 Setup Wizard dialog box opens.

%= Diveline 7.0 (33.2) Setup — *

Welcome to the Diveline 7.0 (53.2)
Setup Wizard

This wizard will guide you through the installation of Diveline
7.0 (53.2).

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.,

Click Mext to continue,

Review the setup instructions and click Next.
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The Installed DiveLines page displays.

% Diveline 7.0 (53.2) Setup — e

1 H Installed Divelines
P:'n‘ée? Qéotljlla;ll List of currently installed Divelines

Current Diveline installations:

(Z) Upgrade Diveline-2131 Port: 2131 ”~
CI-Diveline-3330
() Modify Run as: . \divelineuser
(®) Uninstall Status: running
Dataroot:
dl-dataroot
Executable:
C:\DI\Solution\diveling\bin\di-service s
£ >
O Install New Get Version

NOTE: This page is called Choose an Action in some Setup Wizards.

4. Select the Uninstall button.

. Select the installation you want to uninstall.
TIP: Click the Get Version button to view the current installation version.

. Click Next.

. Follow the instructions to reach the Installation Complete, or
Completing page.

TIP: Bridge and DivePort include an option to remove files related to the
site. Select the Also remove site-specific files check box to delete these
files.

. Click Finish to finish uninstalling the software.

You may need to restart your machine after uninstalling.
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Appendix A: Bridge

Bridge is a web application based on DivePort technology that you can use to
navigate your DI applications from one central place. It gives you single-click
access to your DivePort and NetDiver portals and can reach all your relevant
web content without relying on browser features like bookmarks. You can also
use Bridge to connect to ProDiver and DiveTab.

Bridge presents a single view of DivePort Applications and Portals regardless of
which version is running. This allows you to build new Applications and Portals
taking advantage of the latest Diver Platform functionality without first
upgrading existing applications. You get seamless access to existing and future
applications under one umbrella.

Design

Bridge supports all versions of DI software. There are no cross-compatibility
limitations, so you can use it to launch any functioning DI application, on one
machine or multiple platforms. It can be configured to use one Authentication
layer across all DI applications, supporting single sign-on. The result is a single
browser window and single-click access for your end users.

Bridge must be configured to recognize the other Applications and DI Portals,
and in turn, the hosting DivelLines must recognize Bridge. You can use multiple
Bridges to segment your users if it suits your environment, but it is not required.
The user interface can display one button for each Portal to which a user has
been granted access, so the displayed buttons can vary by user. All users can be
directed to a single URL to bookmark.

The interface, no matter how it is configured, is designed to be simple and
consistent. Here is an example of a user interface for the Bridge component.
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Dimensional Insight

Change Password  About  Log Off

228 ¢z 2 ¢z

Teamer Employee Central Web Site Web Mail
K7
\L °°°
Vi ay
Library Goods & Services Healthcare Demo Teamer Metrics

Demo

When installed and configured, Bridge authenticates end users when they log
on. When the end user chooses a destination that is a DI application, a one time
password is used to log on to the target. What a user sees in each destination is
controlled by that destination’s configuration. Access is no different than what is
in place without Bridge.

Furthermore, for any given destination (for example, a DivePort), Bridge does
not display a destination if it goes to DivePort pages that the current user does
not have access to.

How it Works

The Bridge administrator names all the available destinations and provides an
image and description for each button that is displayed for the end users. The
administrator also enters the Diveline, Application, and Portal URL information,
and coordinates as needed with the administrators of the destination sites to
complete configuration for single sign-on.

The tasks for Bridge are as follows:
» Use the hosting DivelLine’s user list for authentication.

» Determine what buttons to display for each user based on the settings for
each destination.

« Link to other sites as configured.
NOTES:

» The authentication methods can be different between Bridge and the
various target Divelines. The target is set up to recognize Bridge, and
Bridge forwards the authentication.

» Passwords are not important—they can be the same or different. In a
typical scenario, end users log on to Bridge with their Bridge password,
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and can connect to any other DI application regardless of what their
password is on those sites.

» New users added to sites need to be manually added to Bridge's Diveline.
From the end-user perspective:
1. Access Bridge using the published URL in your chosen web browser.
2. Enter your Username and Password, and log on.
3. View the displayed buttons for each configured application or portal.
4. Click on a button to open that application or portal.
5

. Return at any time to the Bridge tab to access another application or
portal.

Requirements

The infrastructure required for Bridge is the same as for the Diver Platform.
Bridge is easy to install and deploy: it is basically another DivePort instance, so it
can run on your web server with all your other DivePorts. For more information,
see Installing Bridge on the next page.

NOTE: For better control of Bridge access, particularly regarding who can
modify Bridge settings, you might want to install a separate DivelLine dedicated
for Bridge. A Bridge-specific DivelLine uses port number 3330. For more
information, see Installing DiveLine on page 24.

The basic set of users for Bridge is taken from whichever Diveline is selected to
host it. Additional users can be created using Workbench. For more information
on maintaining users for DI software, please refer to Help Desk or the Server
Settings section of the Workbench Help.

Bridge Configuration

Bridge can be installed on an existing Diveline, or a new DivelLine instance can
be created to host Bridge specifically. When Bridge is installed, all DivelLine
administrators automatically become Bridge administrators. Bridge
administrators are not required to be DivelLine administrators. Only
administrators have access to the Admin menu in Bridge. For options, see the
Server Settings section of the Workbench Help.

No changes are required to DI applications on the same DivelLine as Bridge, but
applications on other Divelines require edits to the Authorized DivePort
Gateways list under the General tab for Workbench Server Settings. This
needs to be edited manually to include Bridge's IP address or DNS name. This is
required for single sign-on to work, along with the DiveLine server name and
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port in the Destination Settings. For more information, see Configuring
Destinations on page 102.

When planning your deployment, be aware that the DivelLine user list controls
who has access to that Bridge instance. If user lists vary widely for your
DivePorts across your organization, manual updates are required.

Once installed, an administrator can set up additional administrators and
customize Bridge's look directly from the Bridge portal. For more information,
see Configuration Options on page 99.

Authentication

Bridge's user list is that of the hosting Diveline. All types of Diveline
authentication are supported (Own, LDAP, SYSTEM, or Web Server). Bridge's IP
address or DNS name must be in the destination Diveline’s gateway_ips list for
a seamless handoff.

Bridge keeps connections open to its destination DiveLines in order to keep its
lists of the users on those Divelines up to date. It uses these user lists to decide
which destinations to show to a user. If a destination has a Diveline associated
with it, it only shows that destination if the user is in the user list for that
DivelLine. If the destination goes to a DivePort page ID, Bridge also makes sure
that the user has access to that page and does not show a destination that the
user does not have access to.

If Bridge and destination DivelLines have the same user names (irrespective of
case), and the DiveLine and Admin Username are part of the Destination
configuration, Bridge knows which buttons to display for the end user. One click
on the button puts the user into the application.

Bridge does a case-insensitive comparison when determining whether a user is
in the current list of users for a given Diveline, to determine whether to show a
destination pointing to that DivelLine to that user.

If the Destination configuration is incomplete, causing Bridge to show a
destination the end user has no access to, then a secondary log on appears
when the button is clicked.

NOTE: Bridge uses an encrypted connection when communicating with
encryption-enabled 7.0 DiveLines. However, for compatibility with older DI
software, it allows access to unencrypted Divelines.

Installing Bridge

Wherever you install Bridge, the hosting DivelLine serves as the basis for its user
list. Once you have determined which Diveline to use for Bridge, launch the

93



Diver Platform 7.0

installer downloaded from DI-Download. This section guides you through the
installation process of Bridge for Windows.

NOTE: You need to be an administrative user to install the software.

To install Bridge:

1. Navigate to the DI\Solution\downloads directory.

2. Double-click the Bridge-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.

Confirm that you want to open and run the executable.

3. Click Yes.

The Bridge <version number> Setup Wizard dialog box opens.

i) Bridge 7.0 (33.2) Setup

Welcome to the Bridge 7.0 (53.2)
Setup Wizard

Thig wizard will guide you through the installation and
maintenance of Bridge 7.0 (53.2).

4. Click Next.

The Required Software page opens.
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4 Bridge 7.0 (53.2) Setup - x

Dimensional Reauired Software
I'NSIGHT

Java and Apache Tomcat are required for Bridge

Existing Java Installation (must be Java 7 or later):

| C:\Program Files\Java'jdk-11.0.6+10

install Java

Existing Tomcat Installation:

| C:\Program Files\Apache Software Foundation\Tomcat 9.0

[install Apache Tomeat

Mullsaft Install Swstem w246

5. Do one of the following:

« If already installed, verify the existing installation paths.

 If notinstalled, select the Install Java or Install Apache Tomcat or
both check boxes and follow the instructions. This example uses the
existing installations. If following the installation guide, Java is
installed in Installing DivelLine on page 24, and Tomcat in Installing

DivePort on page 37.
6. Click Next.

The Create Certificate for HTTPS page opens.

4 Bridge 7.0 (53.2) Setup — *

Dimensiona] Create Cerificate for HTTPS
I NS I GHT

Warning: a selfsigned certificate produces browser warnings [ 5kip this step

File Qut: | C:\Jsersjemith\Documents ke ystore |

Mame (e.g. serverl.company.com): | |

Organizational Unit: | |

e — |
StateProvince: l:l 24etter Country Code:l:l Password:

Creation Result:

Create Certificate

Mullsoft Install Swstem w2, 46

< Back Next = Cancel




7. Do one of the following:
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« Fillin the information as appropriate and click Create Certificate.

» Select Skip this Step.

NOTE: If you installed Diveline, there is already a certificate available.

Select Skip this Step.
8. Click Next.

The Certificate Signing Request for HTTPS page opens.

i Bridge 7.0 (53.2) Setup

Dimensional
NS IGHT

Submit this Certificate Signing Request (.csr) file to a Certificate
Authority to obtain a signed certificate

Certificate Signing Request for HTTPS

- x

[ skip this step

Key File: | C:\Users\jsmith\Documentskeystore

File Qut:

| C:'\Users\jsmith\Documents\tomeat_cert_request.csr | e

Request Result:

< Back

Create Request

Next = Cancel

9. Do one of the following:

* Verify the information and click Create Request.

 Select the Skip this step check box.
NOTE: If you installed Diveline, there is already a certificate available.

Select Skip this Step.
10. Click Next.

The Installing a New Portal page opens with the following defaults:

» Portal name—The default name is bridge. You can change it to suit

your needs.

o Path to DI Solution folder—The default folderis c:\DI\Solution.

e Path to Java Runtime Environment—The default path is
C:\Program Files\Java\jrel.8.0 121.

e Path to Apache Tomcat Server—The default path is c: \Program
Files\Apache Software Foundation\Tomcat 9.0.
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A best practice is to change the default Portal name to something other
than bridge (for example, bridge-test) to keep the software distinct from
another implementation. One installation of the software can support
multiple instances or portals. Verify the other default fields.

i Bridge 7.0 (33.2) Setup - x

1 1 Installi New Portal
Dimensional ing 2 _
' NS I GHT Enter the name of the new portal, and verify these system
locations.

Portal name: | bridge-test |
(This will appear in the portal URL)

DI Solution folder:
| C:\DI'Solution |

Java Runtime Environment version 7 or later:
| C:\Program Files'\Javaljdk-11.0.6+10 |

Apache Tomcat Server version 7.0 or later:
| C:\Program Files'Apache Software Foundation\Tomcat 9.0 |

Space Required: 92 MB

11. Click Next.

The second Installing a New Portal page opens, with the default name of
the Diveline service and port number (for example, jsmith-001:3330).
Verify that the port number matches the Diveline service. This page also
prompts you to enter the administrator Username and Password
previously defined for the DivelLine administrator.



12.

13.
14.

i) Bridge 7.0 (53.2) Setup —

Dimensional stalling a New Portal

Enter the Diveline server string and administrator logon
I NSTGHT infarmation

DiveLine server and port number:
[ jsmith-001:3330 |

Username: | admin |

Password: [seese |

Mullsaft Install Swstem w246

Click Next.
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The Ready to Install page opens, with a summary of the Bridge
installation information. Verify the information. Use the Back button if

needed.

4 Bridge 7.0 (53.2) Setup —

Dimensional ~Readvte instal

I NSIGHT Here is a summary of the pending installation.

When you are ready, press 'Install’.

Mew Installation [2020-05-13]
Portal name: bridge-test
Portal URL: https: /{jsmith-001:443,bridge-test
Product: Bridge
Version: 7.0 (53.2)
DI Solution location: C:\DI'Solution
Diveline Server: jemith-001:3330
Diveline Admin: admin
Bridge IP: 192,168.179.1
Installer running as user: jsmith (in Administrators group)
System memory: 2047 MB
Java JRE location: C:\Program Files\Java'jdk-11.0.6+10
Apache Tomcat location: C:\Program Files\Apache Software Foundation\Tomcat 9.0

Bmmmbm T e b s i e b mimms ACOE RAD

W

Mullsoft Install System w2, 46

NOTE: Take note of the Portal URL. This is used to access Bridge from a

web browser.

Click Install.
Click Finish to close the installation wizard.
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4 Bridge 7.0 (53.2) Setup —

Completing the Bridge 7.0 (53.2)
Setup Wizard

NOTES:

The default web application name is bridge. This is easily changed when
installing.

The Bridge application has its own section in the Windows Registry.

The Bridge software has its own section in the Windows Start menu. From
the Start menu, enter “bridge” to see a link for the <bridge> Logon Page.
Click to open in your default browser.

When multiple instances of Bridge are installed on the same Windows
machine, you might want to edit Properties to display different Program
labels from the Start menu.

Multiple Bridges can be installed on a single server, or multiple servers,
and can communicate each other. When nesting Bridges, avoid creating
circular loops. That is, if Bridge A points to Bridge B, Bridge B should not
point back to Bridge A.

Configuration Options
After you install Bridge, you launch it as you would a DivePort instance.

Enter the URL into your web browser. For example, https://jsmith-001/bridge-
test/#.

A page similar to the following displays.
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DI Bridge

About

Bridge

wversion 7.0 (53.2)

‘Usemame ‘

Use an Administrator account from the Diveline that Bridge uses to log on.

Adding Login Options
Using Workbench, you can display messages and information to a user after
login to various DI clients:

» Welcome Message—This message appears when the user opens Bridge.
» Message of the Day—This message appears after a successful log in.

 Last Login Information—Displays information about the user's last log
in. If this option is selected, it appears as part of the Message of the Day.

To add a log in Welcome Message or a Message of the Day or both:
1. Open Workbench.
2. Navigate to the Connection Manager.
3. Open a connection to the Diveline hosting the Bridge. For example:
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L Connection Manager [m| X
Connections de- i R G 2] ||QuickSearch | @
MName | Type < General
= TestDiveline Diveline E‘;e ection [ype Diveline
B opog ol T rver @ jsmith-001
Bridge Diveline Diveline
= Bridge Diveline iveline Port
Label (Optional) Eridge Diveline
4 Credentials
User admin
Password (stored if set) —
- Preferences
Connect on startup [ False
|- Advanced
« I

4. Click Tools > Server Settings > General > Options.

Click the Login Options chevron to display the login settings.

y ' Options
g_,-, ¥ 6.4 Diveline Namespace

¥ Miscellaneocus

@ Login Options

Welcome Message

Message of the Day | <Mones

Show last login information

6. Optionally, enter a Welcome Message, or Message of the Day, or both,
and select or clear the Show last login information check box.

7. Save your changes.

When Bridge is accessed by your users, they see any configured messages.

101



Diver Platform 7.0

Edit Dialogs
As in a standard DivePort portal, the edit controls are located top right below
the banner. Click to display the menu or dialog.

DI Bridge

Admin Change Password About Log Off

o Admin—Leads to configuration dialogs.

» Change Password—Prompts for a new password for the current user and
saves it to the corresponding Diveline. Only available for
Own authentication.

e About—Displays the version for Bridge and DiveLine.
» Log Off—Signs off the Bridge portal.

Use the Admin menu to get started.

|
| Admin | About Log OFf

Destinations...
Users...
Other Settings. ..

Update User Lists

» Destinations—Use to configure target portals Bridge can access.
» Users—Use to set additional administrators for Bridge (not DiveLine).
» Other Settings—Use to customize buttons and banners for Bridge.

» Update User Lists—Use to update Bridge's local user lists from
destination DivelLines without having to wait for the next time Bridge
automatically refreshes its local information. If this menu item is not used,
Bridge updates its destination user information every five minutes if
configured. For more information, see Configuring Other Settings on

page 109.

Configuring Destinations
Use Admin > Destinations to access the Destinations Settings dialog box.
This is where you define connections for Bridge.

To define a Bridge destination:
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1. Click Add to begin.
2. Click the pull-down menu and choose a Destination Type.

There are three Destination Types:

Web Application—Destination to a web address, including a
DivePort instance, possibly with a particular environment and page,
or a NetDiver instance, or another website.

ProDiver—Destination to a project file, opening the file in ProDiver.

DiveTab—Destination to a DiveTab instance, opening the site with
DiveTab.

3. Enter and choose attributes as needed:

NOTE: The attributes change based on the Destination Type.

Label—Names the available site; appears on the button, and in the
Destinations list dialog box.

Tool Tip Text—Appears as a tooltip when hovered over.

Link URL—Specifies the Uniform Resource Locator (URL) or web
address for a DivePort instance, possibly with a particular
environment and page, or a NetDiver or other site on the Web.

NOTE: Relative paths for destination strings need to start with "/".
For example: /path#page=pagename.

Project Name—The name of a project ProDiver is opening. ProDiver
can open a project or a specific file. This attribute is ProDiver specific.
If not specified, the ProDiver application is still launched.

File Path—The exact file path to a file ProDiver is opening. ProDiver
can open a project or a specific file. This attribute is ProDiver specific.

DiveLine—Indicates the server name and port number for the target
portal (for example, jsmith-001:2131). This gives Bridge access to
that DiveLine user list. The target Diveline authorizes Bridge to
authenticate users by listing the Bridge's machine in the Authorized
DivePort Gateways list under the General tab for Workbench
Server Settings.
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# Authorized DivePort Gateways

Gateways =

10.5.11.133 I

10.5.11.167

10.5.11.179
10.5.11.20
10.5.11.63 bt

The Diveline attribute is required for single sign-on (SSO) to DI
applications from Bridge.

TIP: If no Diveline is specified, a secondary logon displays. A
secondary logon also displays when there is no match on the user.

Admin Username—Used to control the button display for sites that
use DivelLine. If a DiveLine administrator is specified for the target
portal, only users in that DiveLine see the target button. If no Admin
Username is specified, all visitors to Bridge see the destination as an
option, even if they have no credentials. The target DivelLine must
authorize Bridge to authenticate users.

NOTE: There is a time delay between the saving of the configuration
settings and the actual application of those settings in the Bridge
instance. Keep this in mind when you are trying to verify that users
are seeing the appropriate buttons.

Image URL—Points to a graphic file for the button. The browse
button opens a dialog showing thumbnails of all images that came
with Bridge or were installed in the
<bridge>/customizations/images directory under Bridge's
webdata directory. Contents of the customizations/images
directory appear as part of the resources directory. If no image is
specified, a blank box appears instead. For example:
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4. Click

Select an image

o +|@

By

4
e

k]

s mE

L] ™

resources/images/applications/Diver.png !

The circled icon was installed with the application.

You can also provide a full URL. For example, https://jsmith-
001:3330/bridge-test/resources/images/Diver.png

Font Size—Indicates Normal (17 pixels) or Small (12 pixels) for the

label text.

Open in new tab—Indicates how the target should open in the
browser. When selected, the target opens in a new browser tab;
when cleared, the target opens in the current tab.

OK to save the destination.

The dialog box closes.

Here is an example of Web Application destination to DivePort.

Destination Type:
Label:

Tool Tip Text:
Link URL:
Diveline:

Admin Username:
Image URL:

Font Size:

Open in new

FERICW

Destination Settings

Web Application e
DivePort

diveport-test
https://jsmith-001/diveport-test
jsmith-001:2131

admin

/resources/images/applications/Diver.png

Morrmal hd

When configuring older DivePorts, take note of the fact that any DivePort or
secondary Bridge opened in the same tab as the starting Bridge displays a
bridge icon in the tool bar only if it is using the Simplified User Interface (SUI).
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The SUI option was first available with version 6.4. The icon is interactive,
changing into a hand when selected, behaving like the Home and Back buttons.

my aceount  about

2 Prehd HealthcareAware BI | QuickStart

¢ Back Home 6 Overview

Encounters Revenue

Facility Al values (3) - Last Refreshed: Thursday, August

TIP: Older DivePort portals, or current ones not using the SUI, should be
configured to open in a new tab, so the end user can return to Bridge by
selecting the starting tab, since the bridge icon will not be available.

Here is an example of Web Application destination to NetDiver.

Destination Settings ®

Destination Type: |Web Application w7

Label: NetDiver

Tool Tip Text: netdiver-test

Link URL: https://jsmith-001/netdiver-test
Diveline: jsmith-001:2131

Admin Username: |admin

Image URL: /resources/images/applications/Diver.png

Font Size: Normal e

Open in new

Py

OK Cancel

Here is an example of Web Application destination to a website.

Destination Settings ®
Destination Type: Web Application v
Label: Dimensional Insight
Tool Tip Text: company website
Link URL: https://www.dimins.com/
Diveline:

Admin Username:
Image URL: /resources/images/applications/ProgramAdvisor.png

Font Size: Mormal b

Open in new

Py

OK Cancel

106



Diver Platform 7.0

Here is an example of a ProDiver destination.

Destination Settings

Admin Username:
Image URL:

Font Size:

Destination Type:  ProDiver hd
Label: ProDiver

Tool Tip Text: ProDiver

Project name:

File path: !

Diveline: jsmith-001:2131

admin
/resources/images/applications/Diver.png

Morrral v

oK Cancel
Here is an example of a DiveTab destination.
Destination Settings
Destination Type: DiveTab hd
Label: DiveTab
Tool Tip Text:
Link URL: https://jsmith-001:2131/ divetab-test
Diveline: jsmith-001:2131
Admin Username: | admin
Image URL: /resources/images/applications/Diver.png
Font Size: Morrral v
oK Cancel

Reorganizing Buttons

Use Admin > Destinations to see the Settings dialog box with the currently
defined buttons.
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For example:

Settings ®
Destinations

¢, DivePort Test
¢, NetDiver Test

Maowve Up Add Duplicate Edit Delete

Apply oK Cancel

To reorder buttons:
1. Select a destination.
2. Click Move Down or Move Up.
3. Repeat as needed.
4. Click OK to see the new order presented in the portal.

Making a Copy of a Destination

Use Admin > Destinations to make a copy of, or duplicate, an existing
destination within the same Bridge. You still need to change the Link URL to be
unique before committing the new destination. In the Destination Settings
dialog box, do the following:

1. Select a destination.
2. Click Duplicate.

3. Change the Link URL. This cannot be the same as the existing destination,
as the Link URL needs to be unique.

4. Make additional changes, as needed.
5. Click OK to see the duplicate destination listed under Destinations.

Editing a Destination

To edit the settings for a destination, click Edit in the Destination Settings
dialog box, or simply double-click the destination you want to edit. This opens
the Destination Settings dialog box for that destination.
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Deleting a Destination

Use Admin > Destinations to delete an existing destination. In the Destination
Settings dialog box, do the following:

1. Select a destination.

2. Click Delete.

The selected destination is removed.
Configuring Users

Use Admin > Users to see all users for the Bridge instance listed in the Users
dialog. This dialog is used to make someone an administrator for Bridge.

Users *
User Administrator
admin
test =
advanced
general |
casual [}

oK Cancel

e User—This is a list of users from the DiveLine hosting Bridge.

» Administrator—A check mark indicates that the user can perform
configuration tasks for Bridge. This includes adding and deleting sites and
customizing the buttons.

Note that the administrative user used to access Bridge is listed, but the toggle
box is disabled. In this example, the current user is “admin”.

NOTES:
 All DiveLine administrators become Bridge administrators by default.
» Not all Bridge administrators are DiveLine administrators.

By default, the list of users is sorted alphabetically in ascending order by User.
By clicking on either the User or the Administrator column, the list is sorted on
that column, reversing the sort order from ascending to descending or
descending to ascending. The sorting is case-insensitive.

Configuring Other Settings
Use Admin > Other Settings to access the Other Settings dialog. This is where
you can customize the general appearance of Bridge's landing page and
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subpages.
Other Settings [
Logon Text: Bridge
Show logon text?:
Title: Welcome to DI Bridge
Orientation: Portrait 7

Skin:

Destination Button Size: Mormzl A
Banner Image:
Logon Image:

About Image:

Redirect on single destination?: ]

Defauft ¥

Reset to Defaults OK Cancel

Logon Text—Specifies a string for the browser tab.

Show logon text?—Indicates that the Logon Text displays in the middle
of the logon page.

Title—Specifies the name to appear in the banner area of the landing
page.

Orientation—Allows you to select Portrait or Landscape for all the

buttons. The image is smaller in Landscape (90 x 90 px) than in Portrait
(100 x 100 px) orientation, but more text fits on each line in Landscape.

Destination Button Size—For the button size, you can select Normal or
Large. Images are scaled as follows:

° Normal/Portrait: 100 x 100 pixels

° Normal/Landscape: 90 x 90 pixels

° Large/Portrait: 200 x 200 pixels

° Large/Landscape: 180 x 180 pixels

Banner Image—Specifies the path to the graphic file to be used for the
page heading. There is no default. Whatever is used is scaled to a
maximum height of 44 pixels to avoid impacting the title bar layout.

Logon Image—Specifies the path to a graphic file to be used for the
logon page. There is no default. As for all other images, the browse button
opens a dialog showing thumbnails of all images that came with Bridge or
were installed in the <bridge>/customization-templates/images
directory under Bridge’'s webdata directory.
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About Image—Specifies the path to a custom graphic file to be used for
the About dialog if you want to customize it. The default is
resources/images/about-art.png, Which is 282 x 241 pixels. The About
Dialog’s layout is set up to show version text just below the “Bridge” text
in the image.

Update user list from destinations?—\When this option is checked, each
time it updates its user information from its destinations, Bridge adds any
user names that exist in any destination, but not in the Bridge's Diveline,
to its own Diveline. No other information is added besides the user name.
The option defaults to unchecked. Note that this option is disabled when
the Bridge DivelLine uses Own authentication. This option enables Admin
> Update User Lists.

Redirect on single destination?—When this option is checked, and there
is only one destination visible to a non-admin user, when the user logs on
to Bridge, Bridge automatically redirects to that destination. If this is a web
site, it opens in the same tab; if it is DivePort or Bridge, they do not show
the Bridge icon that allows the user to return to the previous Bridge page.
Administrative users do not get redirected.

Skin—Lists skins included with Bridge and skins in the
webdata/bridge/customizations/skins directory. Change the skin and
click OK to reload the page. The new skin takes effect.

NOTE: Although Bridge uses some of the same skin entries as DivePort, it also
uses some different skin entries, due to the differences between the user
interfaces.

The Reset to Defaults restores the default settings, which are:

Logon Text: Bridge

Show logon text is selected
Title: Welcome to DI Bridge
Orientation: Portrait
Destination Button Size: Normal
Skin: Default

All other fields are empty.

The Other Settings dialog box below displays the following selects, among
others: Logon Text: Welcome; Title: Bridge Connect; Orientation: Landscape;
Destination Button Size: Normal; Banner Image:

/resources/images/applications/GLA.png.

Here is an example of how these selections are applied.
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@ Welcome I

() ¢ @ ® & https://jsmith-001/bridge-test/# RO

£+ Most Visited ¥ Dimensional Insight

Bridge Connect

o =

Admin  About Log OFF

Other Settings @
Logon Text: ‘We\cume ] |
Show logon text?:
-{Trtle: ‘Bndge Connect ] |
n f q é- Orientation: Landscape >
Dimensional Insight { ‘ P ‘ |]
Destination Button Size:
{Banner Image: ‘fresources;‘irragesfapp\imtions{GLA.png ] |
. . Logon Image: ‘fresources;‘irmgesfapp\imtions{t:ustom.png |
M About Image: ‘fresources;‘lrragesfapphmtlons{Dwer.png |
Health Care
Redirect on single destination?:
Reset to Defaults oK Cancel

If the Show logon text? option is selected, the Logon Text appears on the log
on screen. If the check box is empty, the Logon Text does not appear.

Here is an example of a log on screen with the Show logon text? check box

empty, and with the Title and Logon Image.

Wil Bridge Connect

ﬁ Welcome

wversion 7.0 (53.2)

About

|U5ername |
[ |

Log On

€ 2002-2020 Dimensional Insight, Inc, All rights reserved, Bridge and The Diver Sohution trademarked by Dimensional Insight, Inc.

Finally, the About Bridge popup is displayed as follows, with About Image:

/resources/images/applications/Diver.png.
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About Bridge %

version 7.0 (53.2)
DI-Diveline 7.0 (53.2)

© 2002-2020 Dimensional Insight, Inc. Al rights reserved.
Bridge and The Diver Solution trademarked by
Dirmensional Insight, Inc.

CK

The Select an Image dialog below shows the image selections that were made
in the above example:

e Banner Image—/resources/images/applications/GLA.png

* Logon Image—/resources/images/applications/Custom.png

» About Image—/resources/images/applications/Diver.png

Select an image
e +l®@ @ N\ +a =
f stn © .
g [l @;&, g ()
5 — L
.resources_f'images_a'applications_a’Custom.png lwkmm

‘.‘
B
FE" R "! rescurc es_-"imag'es_a'a pplications/GLA.png
v | 2 (&) T T

N

e 1

L3 rescurces/images/applications/Diver.png !

5

Cancel

Here is an example of the same set of buttons with Portrait and Landscape
orientation.

Portrait;
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Welcome to DI Bridge

Admin  About  Log OFf

m & 9

Dimensional DivePort Documents
Insight
Health Care Hospital NetDiver
Operations
Landscape:

Welcome to DI Bridge

Admin  About Log Off

= & X

Dimensional Insight DivePort Documents

M YT &

Health Care Hospital Operations NetDiver

Custom Graphics

A library of image files is delivered as part of the application. These resources
are available whenever you use the browse button to configure an image file as
described in Configuration Options on page 99.

You can extend this resource to include your own set of files. The graphics are
stored in the following directory:

DI/Solution/webdata/<bridge>/customizations/images/

The images supplied with the Bridge installation adhere to the following
guidelines:
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Image  Default Size Notes
Button | diverpng | 100x 100 | For best results, make sure there is space
pX around the graphic in the Image. At least
90 x 90 15 pixels is recommended.
pX The portrait orientation displays 100 x 100
px, while the landscape displays scales
down to 90 x 90 px.
The application resource colors: #3ca4c6
to #1479bd, gradient; #1d83bf, solid.
Banner | none no Whatever is used is scaled to a maximum
default height of 44 pixels. The CSS property
#bridge-titlebar sets the background
color of the banner as #5f9fe1.
Logon | logon- 171x 75 | Background color: #dfe8f6 or transparent.
art.png px You can use any graphic, but if the
background color of the image is #dfe8f6,
it blends in with the page background.
About | about- 282 x 241 | Background color: #ffffff
art.png pX Make sure the background color is white.
Version text is shown just below the
“Bridge” text in this image.

S

In general, the png format is recommended, although the Images dialog box
looks for png, jpg, gif, and bmp file types.

There is some flexibility in the sizes, so run tests to see how your images display.
Larger images are scaled down when needed and can result in a loss of quality.

User Access

Once you have configured Bridge buttons for your users, you can share the URL.
Things to note:

» Only Administrative users see the Admin button below the banner.

» Password maintenance options depend on the authentication type and
server configuration.
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 Ifauseris required to change their password during the initial logon,
either to Bridge or to a linked DivePort or NetDiver, a Change Password
dialog box opens. If the dialog box is canceled, the user is logged out
automatically. If the password is changed successfully, the user is logged
on and the password on DivelLine is updated.

116



Diver Platform 7.0

Appendix B: Help Desk

Help Desk is used to perform maintenance tasks for users on a DivelLine server.
All features in Help Desk are also available in Workbench. You use Help Desk to
delegate the basic DivelLine user maintenance chores to individuals who do not
need access to project data.

NOTE: Help Desk requires a separate license.

Installing Help Desk

Help Desk allows for users without Developer licenses to edit groups and users.
NOTE: You need to be an administrative user to install the software.
To install Help Desk:

1. Navigate to the b1\Solution\downloads directory where you
downloaded the developer package.

2. Double-click the HelpDesk-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable.

3. Click Yes.

The HelpDesk <version number> Setup Wizard dialog box opens.

(37 HelpDesk 7.0 (53.2) Setup - x

Welcome to the HelpDesk 7.0 (53.2)
Setup Wizard

This wizard will guide you through the installation of
HelpDesk 7.0 (53.2).

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.,

Click Mext to continue,
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4. Click Next.
The Installed HelpDesks page opens.

(37 HelpDesk 7.0 (53.2) Setup — X

1 3 Installed HelpDesks
Pan‘éer?qéorl}all List of currently installed HelpDesks

Current HelpDesk installations (dick for details):

Upgrade

Uninstall

(®) Install New

Mullsaft Install Swstem w246

5. Select one of the following:
e Upgrade
e Uninstall
 Install New

Each option guides you through the required steps. This example uses
Install New.

6. Click Next.
The HelpDesk Install Path page opens.
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(77 HelpDesk 7.0 (53.2) Setup — X

Dimensional HelpPesk install Path
| NS I GHT

Install Directory:
| C:\Program Files (x8&)\Dimensional Insight\HelpDesk

Mullsaft Install Swstem w246

Verify the directory for Help Desk installation.
Click Next.

The Ready to Install page opens.

(71 HelpDesk 7.0 (53.2) Setup — bt

1 H Ready to Install
P:'nge]?qéotl}a;ll Summary of the pending installation

Please review the information below. When you are ready, press “Install”,

Date: 2020-05-13
Installation:
Product: HelpDesk
Version: 7.0 (53.2)
Install location: C:\Program Files (x86)\Dimensional Insight\HelpDesk

Mullsoft Install System w2, 46

< Back Install Cancel

Verify the Help Desk installation information.
Click Next.

The Installation page opens, and displays Installation Complete once
finished.
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(77 HelpDesk 7.0 (53.2) Setup —

1 3 Ingtallation Complete
Pﬁn}e]?séoﬂall Setup was completed successfully.

Completed

Show details

Mullsaft Install Swstem w246

< Back Cancel

11. Click Finish to close the installation wizard.

Verifying the Help Desk Installation

To verify a successful implementation of Help Desk:

1. Open the Windows Start menu and enter Help Desk.
2. Click the link to Help Desk that appears in the Programs list.

Help Desk opens.

i Help Desk - O X

Session  Help
é Q <Not connected > @ 0

Past Sessions

3. Select Session > Connect.

The Login dialog box opens.
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v Legin o

Server | V|

Username | |

Password | |

[ save password for future sessions

Login Cancel

4. Do the following:

 In the Server box, enter the server name. For example, jsmith-
001:2131.

e Enter the Username and Password for Diveline.

 Select Save password for future sessions if you want to save this
information for later use.

5. Click Login.

A new session on Help Desk opens.

" Help Desk - [} X
Session  Help
[4) €3 admin@jsmith-001:2131 ® 0
Users
Users
Q Search 80 ’, & JO

Groups

User # | Full Name Groups Projects

Licensing - admin All Projects (Admin)

L test <Nanes

Activity

6. Click Help > About to view the Help Desk version number.
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About Help Desk
' Help Desk

Version 7.0 (53.2)

Copyright @ 2017-2018 by Dimensional
Insight, Inc.

All Rights Reserved

7. Click Help > View Help, to view the Help documentation in a browser

window.
Dimensional
%I Nsiocn 1t HelpDesk [ seare
%Cnntenis lossary EE

[ Help Desk

‘ Tips to Improve Search Results

‘ Help Desk Overview

‘ Connecting to a Diveline Server

‘ Creating a Help Desk Shortcut with Login Optic
‘ Managing Users

[ User Edit Tabs

‘ Home Directories

‘ Retrofitting Users for the Home Project
‘ Managing Groups

‘ Managing Project Access

‘ Assigning Properties to Users and Groups
‘ Licensing Levels

‘ Managing Diver Solution Licenses

‘ Managing Diver Platform 7.0 Licenses

‘ Conversion of 6x Licenses to 7x

I Activity Tab

Ll
Welcome to Help Desk

pdated Monday, September 30, 2019 (3:07 PM)

Last
Help Desk is a desktop component of the Diver Platform.

Help Desk provides access to user maintenance for the DI client-server
applications on the Diveline server. The Help Desk license provides
administrative-level permissions for the user maintenance tasks, but
does not allow the same access level as administrators. All of the
settings in Help Desk are also available to developer users in
Workbench L.

Using this Help System
The layout of this Help system varies, depending on the device that you

are using to view it.

A full screen view shows a table of contents and a glossary on the left
pane of the help window, and a search box on the right.
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Appendix C: Diveline
Authentication Options

Diveline supports four different user authentication options. As a Diveline
administrator, choose the best type for your network environment.

e Own—Uses Diveline's internal username and password list maintained
using Workbench or Help Desk.

e System—Uses the Diveline server's UNIX operating system user account
credentials for authentication.

* Web Server—Uses the user information maintained by the web server to
authenticate users.

e LDAP—Uses a Lightweight Directory Access Protocol server to request
credentials and authenticate users.

NOTE: All authentication types require that DiveLine users are defined in
Workbench Server Settings.

Own Authentication

Own authentication maintains user information entirely within Workbench. You
can create users and passwords, and assign security and licensing levels within
Workbench, and it functions independently of any other security on the system.
You do not need to create operating system user accounts on the server itself
because user accounts are maintained entirely within the Diveline through
Workbench. When creating users in Workbench for use with Own
authentication, a password is required; blank passwords are not allowed. All
user passwords are hashed within the application using the scrypt algorithm.

Note that most enterprise implementations of Diver Platform do not use Own
Authentication because of the need to maintain separate passwords. Using
LDAP, System, or Web Server authentication type supports working with an
existing authentication system, such as Active Directory.

Configuring Own Authentication

Setting Own authentication type allows you to maintain DivelLine user
information entirely within Workbench. For more information, see Own
Authentication above.

To configure Own authentication:
1. Open Workbench and open a DiveLine connection.
2. Select Tools > Server Settings > General.
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124

3. In the Security section, select Own from the Authentication Type pull-
down menu.

Start  main.divetab 4k
|Ganera\
I General General
Users ' Security
Groups EAuther\ticamnType Own V)
Projects ¥ Password Policy
¥ User Management
Properties
¥ Authorized DivePort Gateways
Controller
Email Notifications
Advanced

_7- Options
g & ¥ 6.4 Diveline Namespace

¥ Miscellaneous

¥ Login Options

4. Click the chevron next to Password Policy.

The Password Policy options display.

# Password Policy

[] Password expires after 0 : days
[] Prevent reuse of last 0 = passwords
[ Require password to have at least 0 7| characters

[[] Password cannot contain username
[]Password requires upper and lower case charaders
["] Password requires a number

[]Password requires a punctuation mark

The Password Policy options allow you to specify and enforce criteria for
creating and maintaining strong user passwords that comply with your
company's security guidelines.

NOTE: Password Policy options are specific to Own authentication type.
5. Specify the password options:

» Password expires after “x” days—Sets the number of days after
which passwords expire. This allows a user to change an expired
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password, regardless of whether or not password changing has been
allowed on the user's profile. Individual users can be exempted from
mandatory password expiration by selecting the Password never
expires check box on their user profile Security/Licensing settings.
Not selecting this option results in the password not expiring.

* Prevent re-use of last “x” passwords—Sets the number of
previously used passwords that cannot be re-used. Not selecting this
option, or entering "0", disables the feature, allowing users to reuse
the same password repeatedly.

» Require passwords to have at least “x” characters—Sets the
required number of characters for a user password. Not selecting
this option, or entering"0", disables the minimum requirement
setting.

» Password cannot contain username—Prevents using part or all of
the username in the password.

» Password requires upper and lower case characters—Requires
using both upper and lower case characters as part of the user
password.

» Password requires a number—Requires using a number as part of
the password.

» Password requires a punctuation mark—Requires using a
punctuation mark, such as an exclamation point or comma, as part
of the password.

NOTE: The Diveline server-level password settings interact with settings
on individual user accounts. For example:

 If you select Password expires after X days, users can change an
expired password regardless of whether the User cannot change
password option is selected for their user accounts.

* If you select Password never expires in their user account, you
exempt an individual user from mandatory password expiration.

6. Save the Server Settings, using File > Save or Ctrl+S.

System Authentication

System authentication uses the DiveLine server's UNIX operating system user
database for authentication. It is available only on supported UNIX platforms.
This is a convenient way to handle password authentication without maintaining
a separate password list. However, you do need to define your users within
Workbench, and the account user name must exactly match the user name in
the server’s user database.
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For System authentication, you do not need to assign passwords in Workbench;
any password specified in Workbench is ignored.

On UNIX, System authentication uses Pluggable Authentication Modules (PAM)
if it is available. This means it is possible to use system passwords without
running Diveline as the root. It also enables the use of PAM's extensible
mechanisms for authenticating to various sources. By default, Diveline accepts
passwords that work for normal, non-super user (non-su) logons on the
machine. Additional customization of PAM for DiveLine can be used by
modifying the PAM configuration for the diveline.exe file. Specify auth entries as
desired.

On Linux, System authentication supports PAM-based authentication and
account management for authorization. Linux also supports implementing
freelPA, which allows for Host-based Access Control rules, as long as pam_acct_
mgmt is called.

Configuring System Authentication

System authentication type uses the server's user database for DiveLine
authentication, and is only available for supported UNIX platforms. For more
information, see System Authentication on the previous page.

To configure System authentication:
1. Open Workbench and open a Diveline connection.
2. Select Tools > Server Settings > General.

3. In the Security section, select System from the Authentication Type
pull-down menu.
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Start  main.divetab M’m 4
|Ganera|
I General General

ysers ' Security

Groups [.-Authentlcatlon Type  System

Projects % User Management

¥ Authorized DivePort Gateways
Properties

Email Notifications
Controller
Advanced

7_" Options
s ® ¥ 6.4 DiveLine Namespace

¥ Miscellaneous

¥ Login Options

NOTE: There are no additional settings in Workbench for System
authentication, but be sure to define users in Workbench or Help Desk.

4. Save the Server Settings, using File > Save or Ctrl+S.

Web Server Authentication

Web Server authentication uses the user and password list already maintained
by a Web Server. DivelLine includes a special script to communicate with the
Web Server.

Web Servers respond to web requests from the local file system or execute local
programs or scripts, and return the output of those programs to the browser
that sent the query. DiveLine CGI (DLCGI) is such a program and is designed to
allow the use of a Web Server to authenticate users and streamline maintenance
of client start pages. Common Gateway Interface (CGI) programs are supported
on Web Servers such as Microsoft Internet Information Server (1I1S) and Apache
HTTP Server. DLCGI allows users to log on and authenticate to the Web Server,
and passes that logon information to DiveLine. Diveline then takes the users
configured in the Web Server, including Windows Domain users, for
authentication. If multiple domains are involved, the Web Server authentication
configuration needs to pass along the appropriate domain and username to
Diveline.

The result is a single sign-on with the Web Server, and the ability to maintain
passwords outside of DivelLine. However, you must define your users within
Workbench, and the user names in Workbench must exactly match the user
names on the Web Server. Web Server authentication allows single sign-on
access through ProDiver if using a Windows Domain or, if you launch ProDiver
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from a DivePort using a dlk file. See also Implementing SSO on Linux on
page 161.
There are two main tasks for setting up Web Server authentication:

e Configuring the Web Server below

e Configuring Web Server Authentication on page 150

See Configuring DivePort for Web Server Authentication on page 152 for
additional steps for DivePort.

Configuring the Web Server
Configure the Web Server for DivelLine CGI (DLCGI) according to system-specific
instructions.

e Configuring IIS Windows 10 / Server 2016 / Server 2019 below
e Configuring IS Windows 8 / Server 2012 on page 136

e Configuring IS Windows 7 / Server 2008 on page 140

After the Web Server is configured, proceed to Configuring Web Server
Authentication on page 150.

Configuring IIS Windows 10 / Server 2016 / Server 2019
Microsoft's Internet Information Services (1IS) or Internet Information Server, is a
Web Server for use with Windows NT. IIS is not turned on by default when
Windows is installed and can be accessed through the Microsoft Management
Console or Administrative Tools in the Control Panel. This section applies to IS
10.0 which comes standard in Windows 10, Server 2016 and Server 2019. These
steps might not be exact-refer to the latest Microsoft documentation.

To verify the IIS installation:

1. Navigate to Control Panel\Programs\Programs and Features.

NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

The Programs and Features window opens.
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&~

File

Edit

2 Programs and Features

“ 4 [ » Control Panel > Programs > Programs and Features v | D

View Tools

- a x

Search Programs and Feat...

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
) Turn Windows features on or

Currently installed programs Total size:  7.67 GB
63 programs installed

6]

off Organize ~ = o
Narne - Publisher Installed On  Size
5/7/2014 1.75GB
» 3/17/2020
5/5/2020
3/17/2020
- 5/7/2014 186 MB
- 3/17/2020
. 5/7/2020
. 5/5/2020
5/5/2020
- 31772020 2.80 MB
5/3/2019 150 MB
5/7/2020 336 KB

2. On the left column, click Turn Windows Features on or off.:

The Windows Features window opens.

Windows Features - O X

Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on,

= [ Internet Information Services
Il FTP Server
[m] | Web Management Tools
m  World Wide Web Services

Internet Explorer 11 ~

[ | Internet Information Services Hostable Web Core
[ | Legacy Cemponents
Media Features
[m] Micrasoft Message Queue (M5MQ) Server
Microsoft Print to PDF
Micrasoft XPS Decument Writer
m ] MultiPoint Connector 2

3. Expand Internet Information Services.
4. Select your options. The ones listed below are required.

 Web Management Tools > 1IS Management Console

» World Wide Web Services > Application Development Features
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> CGl
» World Wide Web Services > Security > Windows Authentication

5. Click OK.

The dialog box closes.
NOTE: You might need to restart your computer for these features to take
effect.

To create a virtual directory and set the needed permissions to allow DLCGI to

run:

1. Navigate to Control Panel\System and Security\Administrative

Tools.
NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

The Administrative Tools window opens.

i | = | Administrative Tools - m} x
Home Share View o
4 30« System and Security » Administrative Tools L] O Search Administrative Tools
2 Component Services %2 Print Management
» g Quick access B .
2% Computer Management 3 Recovery Drive
@ OneDrive "fg Defragment and Optimize Drives ‘:,'E Registry Editor
+m Disk Cleanup ‘}) Resource Monitor
[ This PC - i : }
3] Event Viewer a1 Services
¥ Metwork fﬁ;\nternet Information Services (IIS) Manager [l System Configuration
‘;E\SCSI Initiator ] System Information
éLocaI Security Policy @Task Scheduler
E ODEC Data Sources (32-bit) P Windows Defender Firewall with Advanced Security
EODBC Data Sources (64-bit) [ Windows Memory Diagnostic
":;:_-\.Parfurman(e Monitor
21 items =

2. Click Internet Information Services (lIS).

The Internet Information Services (I1IS) Manager opens.
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&5 Internet Infarmation Services (IIS) Manager — m] by
S € sMTHO! » oy @
File View Help
Connections Actions
@ ISMITH-001 Home
[ Manage Server
-C o o .
v j JiMI'I'l—! 001 (jsmith-001'jsmith) Filter: . Go - % Show All | Group by . & Restart
i Application Pools |~ P Start
v .[@] Sites 15 - B Stop
4D Default Web Site 2= . = _—
& c1] = 2 = Vi fication Pools
Authentic... CaGl FastCGl Handler HTTP Vi -
Settings ~ Mappings  Respon... Change .NET Framework
- Version
? éE%ﬂ ?3& g ;% o Get New Web Platform
ISAPI and Modules Qutput Server Worker Sompone T
CGl Restri... Caching Certificates  Processes @ Help
Management ~
7 &
=
Configurat... Feature Shared
Editor Delegation Configurat...
Ready b1

3. On the Connections pane on the left, expand the local computer and
Sites.

The Default Web Site displays.

4. Right-click Default Web Site and select Add Virtual Directory from the
menu.

The Add Virtual Directory dialog box opens.

Add Virtual Directory ? X

Site name:  Default Web Site
Path: /

Alias:

Example: images

Physical path:

Pass-through authentication

Connect as... est Settings

Cancel

5. For the Alias, enter cgi-bin and for the Physical Path, browse for the path
to the dlcgi.exe file. The default path is c:\DI\Solution\diveline\cgi-
bin.

6. Click Connect as.
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The Connect As dialog box opens.

Connect As ? x

Path credentials:

(O Specific user:

®) Application user (pass-through authentication)

7. Select the Specific User radio button, Set, fill in the credentials for the
user account running Diveline, and click OK.
8. Do one of the following:

« If DiveLine and the Web Server are on the same machine, copy the
\diveline\install-files\dlcgi-local.cfg file to the diveline\cgi-bin
directory.

ﬁ dlecgi-local.cfg - Notepad

File Edit Format View Help

version "1";

J// Computer generated object language file

object 'DCFG™ "main™ {
datarcot="c:\\di_solution\\dl-datarcot”,
template_directory="c:\\di_solution\\diveline\\html",

};

« |f DiveLine and the Web Server are on different machines, copy the
\diveline\install-files\dlcgi-remote.cfg file to the diveline\cgi-bin
directory.

Nj dlcgi-remote.cfg - Motepad

File Edit Format View Help

version "1";

J/ Computer generated object language file

object 'DCFG' "main™ {
diveline="server[:port]”,
template_directory="C:\\di_solution\\diveline\\html",

T3

|

9. Rename the copied cfg file to dlcgi.cfg and open the file to verify the d1-
dataroot directory path, or the server and port number.

NOTE: Repeat Step 1 to 8 for each virtual directory.
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10. To set permissions, select the virtual directory after creating it.
11. On the center pane, double-click Authentication.

12.

13.

The Authentication options open.

Configuration: 'Default Web Site/cgi-bin' web.config

@3 Internet Information Services (15) Manager — m} X
e i1 v JSMITH001 » Sites » Default WebSite » cgi-bin » o @~
File View Help
: “| Authenticati :
5 = uthentication
2 .iJ @ Help
= 9 T
v EjJSMI'IH 001 (jsmith-001'jsmith) Group by: No Grouping -
i[5} Application Pools
v .[&] Sites MName Status Response Type
v@ Default Web Site Ancnymous Authentication Disabled
» <[] aspnet_client ASP.NET Impersonation Disabled
i g | €gi-bin Windows Authentication Enabled HTTP 401 Challenge
< >
[ Fentures View . ContentView
%

Disable all authentication methods except Windows Authentication.
Enable Windows Authentication if it is disabled.

Right-click Windows Authentication, and select Providers from the

menu.

The Providers dialog box opens.
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Providers ? x

Enabled Providers:

Megotiate Move Up
MNTLM
Move Down
Remove

Select a provider from the list of available providers and click Add
to add it to the enabled providers.

Mvailable Providers:

oK Cancel

14. Remove Negotiate from the Enabled Providers and click OK.
15. Select the virtual directory again, and double-click Handler Mappings.
The Handler Mappings options open.

&5 Internet Infarmation Services [IIS) Manager

— ml X
(& | » ISMITHO01 » Stes b Default WebSite b cgi-bin @ o @~
File View Help

Connections . Actions

= .| Handler Mappings

Add Managed Handler...
~ 83 JSMITH-001 (jsmith-0014jsmith)

-5} Application Pools

Use this feature to specify the resources, such as DLLs and managed code, that — Bl

handle responses for specific request types.

H Add Wi Script Map...
v -[8 Sites Add Module Ma
Add IV Viapping...
v 4B Default Web Site Group by: State = _
.= Edit Feature Permissiens...
> -] aspnet_client Marmne Path State Path Type Handler e
iw | cgi-bin Revert To Parent
Lo Disabled
- View Ordered List...
CGl-exe exe Disablec e CgiModule e
Enabled ® vep
TRACEVerbHandler * Enabled Unspecified  ProtocolSug

OPTIONSVerbHandler * Enabled Unspecified  ProtocolSug

<

" =1] Features View {2 Content View

Configuration: 'Default Web Site/cgi-bin' web.config

5

16. Double click CGl-exe.
The Edit Module Mapping dialog box opens.
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Request path:

*exe

Example: *.bas, wsvc.axd

Medule:

|cgiModule v

Executable (optional):

|CGI-exe

Request Restrictions...

Diver Platform 7.0

17. Click the browse button for the Executable box, and browse to the

18.

location of the dlcgi.exe file. The default value is
C:\DI\Solution\diveline\cgi-bin\dlcgi.exe. If you cannot see the
executable, select exe from the file type pull-down menu.

Click OK.
The Edit Module Mapping window opens.

Edit Module Mapping

Do you want to allow this ISAPI extension? Click "Yes™ to add

o the extension with an "Allowed” entry to the |SAP| and CGI
Restrictions list or to update an existing extension entry to
“Allowed” in the ISAP and CGI Restrictions list.

Yes Mo Cancel

19. Click Yes to accept the changes.

The dialog box closes.

20. Right-click CGl-exe, and select Edit Feature Permissions from the menu.

The Edit Feature Permissions dialog box opens.
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21.

22.

Edit Feature Permissions ? x
Permissions:
Read
Script
[ Execute

Select the Read, Script, and Execute check boxes, and click OK. This
enables CGl-exe.

Test this configuration by running dlcgi.exe?raw:

Open a web browser and enter in http.//<servername>/cgi-
bin/dlcgi.exe?raw.

NOTE: This page might ask for a username and password. Use the server
username. For this example, the username is jsmith.

Here is the resulting page:

File Edit View History Boockmarks Tools Help

x oy

jsmith-001/cgi-bin/dlcgi.exefraw

<« & ‘Q‘ O\jsmith—001.com_.-'cgli—bi'._-'cl\cgli‘e:e?’a.'.- s T} E. N @ =)
I} Most Visited @ Getting Started ':",Dimensionallnsight

wversion: "7.0 (52.3)"
user: "jsmich-001%jsmith"
password: "EMINBEEY"

DLCGI configuration file: "C:\DI\Solution‘\diveline\cgi-bin\dlcgi.cfg"

DLCGI is providing authentication service to a local Diveline using this dataroot:
C:\DI\Sclution\dl-dataroot

Template directory: C:\DI\Solution\diveline\html

Environment Variables:
guery string: "raw"
path info: "7
server name: "jsmith-001"
remoce user: "jsmith-001%jsmith™
script nmame: "/fcgi-bin/dlcgi.exe”
current directory: "C:\DI\S5olution‘diveline\cgi-bin"

IS is now configured for Diveline's Web Server authentication under
Windows 10.

Configuring IIS Windows 8 / Server 2012

Microsoft's Internet Information Services (IIS), or Internet Information Server, is
a Web Server for use with Windows NT. IIS is not active by default when
Windows is installed; the 1IS Manager is accessed through the Microsoft
Management Console or the Administrative Tools in the Control Panel. This
section applies to IS 8.0 which comes standard in Windows 8 and Server 2012.
These steps might not be exact-refer to the latest Microsoft documentation.
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To verify the IIS installation:

1.

Navigate to Control Panel\Programs\Programs and Features.

NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

The Programs and Features window opens.

2. On the left column, click Turn Windows Features on or off.

3. Expand Internet Information Services.

Select your options. The ones listed below are required.

» Web Management Tools > IIS Management Console

* World Wide Web Services > Application Development Features
> CGl

» World Wide Web Services > Security > Windows Authentication

5. Click OK.

The dialog box closes.

NOTE: You might need to restart your computer for these features to take
effect.

To create a virtual directory and set permissions to allow DLCGI to run:

1.

Navigate to Control Panel\System and Security\Administrative
Tools.

NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

Click Internet Information Services (lIIS).
The Internet Information Services (I1IS) Manager opens.

On the Connections pane on the left, expand the local computer and
Sites.

The Default Web Site displays.

Right-click Default Web Site and select Add Virtual Directory from the
menu.

The Add Virtual Directory dialog box opens.

For the Alias, enter cgi-bin and for the Physical Path, browse for the path
to the dlcgi.exe file. The default path is c: \DI\Solution\diveline\cgi-
bin.

Click Connect as.
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7.

8.

10.
11.

12.

13.

138

The Connect As dialog box opens.

Select Specific User and Set, fill in the credentials for the user account
running Diveline, and click OK.

Do one of the following:

« If DivelLine and the Web Server are on the same machine, copy the
\diveline\install-files\dlcgi-local cfg file to the diveline\cgi-bin
directory.

ﬁ dlcgi-local.cfg - Notepad = O X
File Edit Format View Help
version "1";
J/{ Computer generated object language file
object 'DCFG™ "main™ {
dataroot="c:\\di_solution‘\\dl-datarcot”,
template_directory="c:\\di_solution\\diveline\‘\html",

1

« If DivelLine and the Web Server are on different machines, copy the
\diveline\install-files\dlcgi-remote.cfg file to the diveline\cgi-bin
directory.

| dicgi-remote.cfq - Notepad - O X

File Edit Format View Help

version "1";

J// Computer generated object language file

object 'DCFG™ "main™ {
diveline="server[:port]”,
template_directory="C:\\di_solution\\diveline\\html",

IE

|

Rename the copied cfg file to dlcgi.cfg and open the file verify the d1-
dataroot directory path, or the server and port number.

NOTE: Repeat Step 1 to 8 for each virtual directory.
To set permissions, select the virtual directory.

On the center pane, double-click Authentication.
The Authentication options open.

Disable all authentication methods except Windows Authentication.
Enable Windows Authentication if it is disabled.

Right-click Windows Authentication, and select Providers from the
menu.



14.
15.

16.

17.

18.
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The Providers dialog box opens.

Providers @

Enabled Providers:

Megotiate
NTLM

Select a provider from the list of available providers and click Add
to add it to the enabled providers.

Available Providers:

Cancel

Remove Negotiate from the Enabled Providers and click OK.

Select the virtual directory again, double-click Handler Mappings, and
double click CGl-exe.

The Edit Module Mapping dialog box opens.

Click the browse button for the Executable box, and browse to the
location of the dlcgi.exe file. The default value is
C:\DI\Solution\diveline\cgi-bin\dlcgi.exe. If you cannot see the
executable, select exe from the file type pull-down menu.

Click OK.
The dialog box closes.
Right-click CGl-exe, and select Edit Feature Permissions from the menu.

The Edit Feature Permissions dialog box opens.

Edit Feature Permissions @
Permissions:
Read
Seript
[F] Execute
[ oK l ’ Cancel ]

19. Select the Read, Script, and Execute check boxes, and click OK. This

enables CGl-exe.
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20. Test this configuration by running dlcgi.exe?raw:

Open a web browser and enter in http.//<servername>/cgi-
bin/dlcgi.exe?raw.

NOTE: This page might ask for a username and password. Use the server
username. For this example, the username is jsmith.

Here is the resulting page:

File Edit View History Bookmarks Tools Help E@
jsmith-001/cgi-bin/dlcgi.exefraw X ‘
&« c @ jsmith-001/cgi-bin/dlcgi.exe?raw o QW N D =

£+ Most Visited @ Getting Started #; Dimensional Insight

wersion: "7.0 (52.3)"
uzer: "jsmith-001\jsmith"
password: "KMINBEKY"

DLCGI configuration file: "C:\DI\Solution\diveline\cgi-bin\dlcgi.cfg”

DLCGI is providing authentication service to a local DivelLine using this dataroot:
C:\DI\Solution\dl-dataroot

Template directory: C:\DI\Solution\diveline\html

Environment Variables:
guery string: "raw"
path info: "™
server name: "jsmith-001"
remote user: "jsmith-001\jsmith"
script name: "/cgi-bin/dlcgi.exe™
current directory: "C:\DI\Solution\diwveline\cgi-bin"

IS is now configured for Diveline’'s Web Server authentication under
Windows 8.

Configuring IIS Windows 7 / Server 2008

Microsoft's Internet Information Services (IIS) or Internet Information Server, is a
Web Server for use with Windows NT. IIS is not turned on by default when
Windows is installed and can be accessed through the Microsoft Management
Console or Administrative Tools in the Control Panel. This section applies to 1IS
7.0 which comes standard in Windows 7 and Server 2008. These steps might not
be exact-refer to the latest Microsoft documentation.

To verify the IS installation:
1. Navigate to Control Panel\Programs\Programs and Features.

NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

The Programs and Features window opens.
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(= E]=]

’ 1 X
@U' » Control Panel » All Control Panel ltems » Programs and Features - |(vf| | Search Pro.. 0 |

File Edit View Tools Help

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

'@J Turn Windows features on or
il Organize == - @

MName Publisher Installed On -
- 31372017 s
’ 11/7/2017 |—|
- - — 9/13/2017
- - — 9/13/2017
- 3/29/2018
~ e 9/7/2017
. - 5/23/2018
10/27/2016
- 5/30/2018

. - 6/14/2016
q | n |

e Currently installed programs

I)" 103 programs installed
L Total size; 181 GB

2. On the left column, click Turn Windows Features on or off.
The Windows Features window opens.

3. Expand Internet Information Services.

Windows Features E=R(ESE 5
Turn Windows features on or off (7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on.

[] | Indexing Service
| Internet Explorer1l

o
[T, FTP Server 4
[H | Web Management Tools
[H] || World Wide Web Services
[] | Internet Information Services Hostable Web Core

. Media Features

| Mlicroseft MET Framework 3.5.1 -

| »

m

[ oK ] ’ Cancel

4. Select your options. The ones listed below are required.
 Web Management Tools > 1IS Management Console
» World Wide Web Services > Application Development Features
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> CGlI

» World Wide Web Services > Security > Windows Authentication

5. Click OK.

The dialog box closes.

NOTE: You might need to restart your computer for these features to take

effect.

To create a virtual directory:

1. Navigate to Control Panel\System and Security\Administrative

Tools.

NOTE: There are multiple ways to navigate the Windows operating

system. This method uses a path in the Windows Explorer.

The Administrative Tools window opens.

[E=N e =X

uu ‘E] » Control Panel » System and Security » Administrative Tools

File Edit View Tools Help

- ‘&, ‘ | Search Administrative Tools yel |

QOrganize = Bumn

i~ 0 @

i Favorites

4 Libraries
3 Documents
J? Music
=] Pictures

B videos

/% Computer
&, Windows7_05 (C3)
%‘ Lenovo_Recowvery (Q:)

4 Documentation (dias-centr

i“ﬂ MNetwork

15 items

[#- Component Services

(@ Computer Management

Data Sources (ODBC)

(at] Event Viewer

ﬁalntamaﬂnformation Services (I5) Manager
fah iSCSI Initiator

(@ Local Security Policy

(31 Performance Monitor

{38 Print Management

ali. Services

(7 System Configuration

@Task Scheduler

@P Windows Firewall with Advanced Security
@] Windows Memory Diagnostic

(2l Windows PowerShell Modules

2. Click Internet Information Services (l1IS).

The Internet Information Services (I1IS) Manager opens.
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& Internet Information Services (T15) Manager

Ready

[E=E EoR ==
\ = T 15 .
) ) [ svmroo » & = L @
File View Help
Connections Actions
@) JSMITH-001 Home
L Manage Server
485 SMITH-001 (jsmith-001\jsmith) — - BGo - 4 Show Al | Group by: Ares B 2 Restart
L Application Pools P Start
“ ‘ﬂgis s - - B Stop
. & Default Web Site Ba sy E
},‘_.E; E = 2 = ? plication Pools
Authentic... Cal FastCGl Handler HTTP ISAPL and View Sites
Settings ~ Mappings  Respon..  CGIRestri.. Change NET Framenork
& Version
s ] &)
G;}H F # @y @ Help
Modules Qutput Sa_ryar Worker Online Help
Caching  Certificates  Processes
Management
B W& E
=%
Configurat... Feature Shared
Editor  Delegation Configurat...

[= Features View |/ Content View

B

3. On the Connections pane on the left, expand the local computer and

Sites.

The Default Web Site displays.

4. Right-click Default Web Site and select Add Virtual Directory from the

menu.

The Add Virtual Directory dialog box opens.

Add Virtual Directory

Site name:  Default Web Site
Path: )

Alias:

Example: images

Physical path:

Pass-through authentication

Connect as... Test Settings

o =]

(-]

Cancel

5. For the Alias, enter cgi-bin and for the Physical Path, browse for the path

bin.

6. Click Connect as.

to the dlcgi.exe file. The default path is c:\DI\Solution\diveline\cgi-
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The Connect As dialog box opens.

Connect As @

Path credentials:

() Specific usen

@ Application user (pass-through authentication)

0K ] [ Cancel

7. Select the Specific User radio button, Set, fill in the credentials for the
user account running Diveline, and click OK.
8. Do one of the following:

« If DiveLine and the Web Server are on the same machine, copy the
\diveline\install-files\dlcgi-local cfg file to the diveline\cgi-bin
directory.

Nj dlcgi-local.cfg - Notepad

File Edit Format View Help

version "1";

J// Computer generated object language file

object 'DCFG™ "main™ {
dataroot="c:\\di_solution\\dl-datarcot"”,
template_directory="c:\\di_solution‘\\diveline‘\html",

¥

« If DivelLine and the Web Server are on different machines, copy the
\diveline\install-files\dlcgi-remote.cfg file to the diveline\cgi-bin
directory.

ﬁ dlcgi-remote.cfg - Notepad

File Edit Format View Help

version "1";

J// Computer generated object language file

object 'DCFG™ "main™ {
diveline="server[:port]”,
template_directory="C:\\di_solution\\diveline\html",

};

9. Rename the copied cfg file to dlcgi.cfg and open the file to verify the d1-
dataroot directory path, or the server and port number.

NOTE: Repeat Step 1 to 8 for each virtual directory.

To set the permissions to allow DLCGI to run:
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NOTE: There are multiple ways to navigate the Windows operating
system. This method uses a path in the Windows Explorer.

The Administrative Tools window opens.

(=) o=

File Edit View Tools Help

—
OU | » Control Panel » System and Security » Administrative Tools

- | +5 ‘ | Search Administrative Tools 0 |

Organize v Burn

[ Favorites

wa Libraries
3 Documents

J’ Music

[=| Pictures
E Videos
1M Computer
&, Windows7_05 (C)
E@ Lenove_Recovery (Q:)

4 Documentation (dias-centr

‘?j Network

15 items

[#]- Component Services

(2 Computer Management

Data Sources (ODBC)

@ Event Viewer

@Intameﬂnfurmatiuﬂ Services (IIS) Manager
[l iSCSl Initiator

[7y Local Security Policy

@)Pen’nrman(e Monitor

ﬁ'nj;Print Management

[ Services

(7H System Configuration

@Task Scheduler

@Windows Firewall with Advanced Security
[#F] Windows Memery Diagnastic
@Windnw; PowerShell Modules

B |~| 1 @

Click Internet Information Services (lIS).

The Internet Information Services (I1IS) Manager opens.
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% EDELTE | & el @ -
File View Help
@) JSMITH-001 Home
& | Manage Server
[ -001 (jemith-001\jsmit — -
{83 JSMITH-001 Gsmith-001\jsmith) | || g, - [0 Go - Gy Show All | Groupby: Area =R =
@ Application Pools P Start
4.8 Sites - B sop
1 4 Default Web Site et | - -
& = 1 E View Application Pools
Authentic... Cal FastCGl Handler HTTP ISAPL and View Sites
Settings  Mappings  Respen..  CGIRestri... CrangNETFRrere R
I == Version
=l W Eu']*} ¢ ® Help
Modules Qutput Server Worker Online Help
Caching  Certificates  Processes
Management
— L —
B, =
Configurat... Feature Shared
Editor  Delegation Configurat...
[ Festurs Vi 2 Content i
Ready B

3. Navigate to the virtual directory you created previously, cgi-bin.
4. On the center pane, double-click Authentication.

The Authentication options open.

£

w [21 » JSMITH001 » Sites » Defoult Web Site » cgi-bin »
File View Help
S Authentication
A | 5j A\ Click here to leam how to
[E X - configure Extended
4 i JSMITH Oﬂl.U;mrth 00T jsmith) Group by: No Grouping - Protection.
b @ Application Pools -
2 & Default Web Site Anonymous Authentication Disabled :
[l cgibin| Windows Authentication Enabled HTTP 401 Challenge D=t
Advanced Settings...
Provider...
0 Help
Online Help
B Femiemevia i Conent Ve
C ion: ‘localhost’ applicationHost.config, <location path="Default Web Site/cgi-bin"> .

5. Enable Windows Authentication and disable all other authentication
methods.
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6. Right-click Windows Authentication, and select Providers from the
menu.

The Providers dialog box opens.

Providers

Enabled Providers:

Megotiate viove Up
NTLM

Select a provider from the list of available providers and click Add
to add it to the enabled providers,

Available Providers:

QK Cancel

Remove Negotiate from the Enabled Providers and click OK.

Select the virtual directory again, double-click Handler Mappings.

‘Tﬂ Internet Information Services (IS) Manager EI

% ‘L‘J » JSMITH-001 » Sites » Default Web Site » cgi-bin » |@ s ﬁ @-
File View Help

= EJ Handler Mappings

492 JSMITH-001 (jsmith-001jsmith)
(&} Application Pools

Add Managed Handler...

Use this feature to specify the resources, such as DLLs and managed code, that handle

responses for specific request types.
4[] Sites
4 € Default Web Site Group by: State _ -
+ & cgi-bin Name = Path State Path Type Edit Feature Permissions...
Revert To Parent
Dicabled ~ )
o View Ordered List...
. Help
Enabled @ 5
Online Help
TRACEVerbHandler - Enabled Unspecified |
OPTIOMSVerbHandler - Enabled

Unspecified I

ayf

[0

[ Feturs Vi ]2 Content View

Configuration: 'Default Web Site/cgi-bin' web.config

&
9. Double click CGl-exe.
The Edit Module Mapping dialog box opens.
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10.

11.

12.

13.

148

Edit Module Mapping -5 |3l

Request path:

*

JEXE

Example: *.bas, wsvc.axd

Module:
CgiModule -
Executable (optional):
CGl-exe
[ 0K ] I Cancel ]

Click the browse button for the Executable box, and browse to the
location of the dlcgi.exe file. The default value is
C:\DI\Solution\diveline\cgi-bin\dlcgi.exe. |f you cannot see the
executable, select exe from the file type pull-down menu.

Click OK.
The Edit Module Mapping window opens.

Edit Module Mapping =

‘-.I Do you want to allow this ISAPI extension? Click "Yes" to add the

V' extension with an "Allowed" entry to the ISAP] and CGI Restrictions list
~ ortoupdate an existing extension entry to "Allowed" in the ISAP] and
CGI Restrictions list.

[ ve |[ mo  |[ concel

Click Yes to accept the changes.
The dialog box closes.
Right-click CGl-exe, and select Edit Feature Permissions from the menu.

The Edit Feature Permissions dialog box opens.



Edit Feature Permissions @
Permissions:
Read
Script
[7] Execute
[ 0K l ’ Cancel ]
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14. Select the Read, Script, and Execute check boxes, and click OK. This

enables CGl-exe.

15. Test this configuration by running dlcgi.exe?raw:

Open a web browser and enter in http.//<servername>/cgi-

bin/dlcgi.exe?raw.

NOTE: This page might ask for a username and password. Use the server
username. For this example, the username is jsmith.

Here is the resulting page:

Eile Edit View History Bookmarks Tools Help

jsmith-001/cgi-bin/dlcgi.exe?raw X ‘

[E=3 EoR =)

&« C @
£+ Most Visited @@ Getting Started #% Dimensional Insight

wersion: "7.0 (52.3)"
user: "jsmith-001\jsmith"
password: "KMINBEKY"

C:\DI\Solution\dl-dataroot
Template directory: C:\DI\Solution‘diveline‘\html

Environment Variables:
query string: "raw"
path info: "™
server name: "jsmith-001"
remote user: "jamith-001\jsmith"
script name: "/cgi-bin/dlcgi.exe™

@ jsmith-001/cgi-bin/dicgi.exe?raw e @ T} .‘_}. m @ =

DLCGI configuration file: "C:\DI\Solution\diveline\cgi-bin\dlcgi.cfg"

DLCGI is providing authentication service to & local Diveline using this datarocot:

current directory: "C:\DI\Solution‘diweline\cgi-bin"

IS is now configured for DiveLine’'s Web Server authentication under

Windows 7.

Domain Issues

If you configured both Integrated and Basic authentication for IIS, you may have
a situation where internal users are recognized as <mydomain>\<username>,
while external users are recognized as just <username>. If so, try defining a

default domain.

For example, to enable Basic Authentication in IIS 7.0:
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1. Start the Internet Information Services (IIS) Manager.

2. Expand the Sites container for the Enterprise Vault Web Access
application computer.

3. Click the EnterpriseVault folder.

4. Double-click Authentication in the IIS area at the right.

5. Verify that Anonymous Authentication is disabled and Basic
Authentication is enabled.

6. Right-click Basic Authentication, and then click Edit.

7. Enter the name of the domain that contains the majority of the user
accounts using the Web Access application.

8. Click OK.
If you encounter difficulties, add the following line to your dlcgi.exe file:

default domain="<mydomain>"

In this case, <mydomain> is the domain name to be prepended with a
backslash to the username anytime the Web Server provides a username
without a domain. Users that IIS authenticates as <mydomain>\<username>
stay as <mydomain>\<username>, while users that authenticate as
<username> are changed to <mydomain>\<username>.

Note that when using this method, the Active Directory groups that define who
can access the directory containing dlcgi.exe, and therefore who is allowed to
reach Diveline, need to contain all the users twice, once with and once without
the domain part.

Alternatively, the file system security can change to allow everyone to access
dlcgi.exe, with the Diveline configuration determining who can log on.

Configuring Web Server Authentication

After the Web Server is configured, you need to complete the Diveline settings
in Workbench. If the Web Server has not been configured, see Configuring the
Web Server on page 128.

A user connects to the Web Server, enters a username and password, and is
connected to the DLCGI object on the Web Server. The DLCGI object
dynamically creates the HTML that is returned to the user’s browser. At the
same time, it creates a Diveline password for the user. This password is stored in
a directory on the DiveLine machine in the webdir directory. The password is
good for five minutes, or until the first time it is used. The Web Server must have
permission to write to the webdir directory and Diveline (or the user the service
is running as) must have read access to the directory.
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The Web Server authentication method uses a Web Server to authenticate
users, and streamline maintenance of client start pages. For more information,
see Web Server Authentication on page 127.

To configure Web Server authentication:
1. Open Workbench and open a Diveline connection.
2. Select to Tools > Server Settings > General.

3. In the Security section, select Web Server from the Authentication Type
pull-down menu.

Start  main.divetab M:m 4
|Genera|
I General General

Users ' Security

Groups G&uthenﬂtatinn Type |Web Server

Projects ¥ DLCGI Settings

¥ User Management
Properties

¥ Authorized DivePort Gateways
Controller

Email Notifications
Advanced

_7-’ Options
g & ¥ 6.4Diveline Namespace

¥ Miscellaneous

¥ Login Options

4. Click the chevron next to DLCGI Settings.
The DLCGI Settings display.

Authentication Type |Web Server v

# DLCGI Settings

Authentication URL (DLCGI) | http://jsmith-001/cgi-bin/dlcgi.exe |

Web Server IP Address | |

5. In the Authentication URL (DLCGI) box, enter the URL to the DLCGI
executable for the web site that users are authenticating against. The basic
format of a valid URL is http.//<server name>/cgi-bin/dlcgi.exe.
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6. In the Web Server IP Address box, enter the IP address of the machine
on which the Web Server is installed and configured.
7. Save the Server Settings, using File > Save or Ctrl+S.

NOTE: If authenticating using CGI within a domain environment, the
domain name must be part of the Diveline username. For example,
dimins\jsmith.

In order for DivePort to work, it needs to be reconfigured. For more information,
see Configuring DivePort for Web Server Authentication below.

Configuring DivePort for Web Server Authentication

DivePort needs to be configured so it knows the URL for DLCGI, allowing it to
forward unauthenticated users to that address for authentication. This insures a
single sign-on procedure for the end users.

If DivelLine is using Web Server authentication, you need to update two files:
e diveport.html
e <diveport>.xml

To update the diveport.html file:

1. Copy the diveport.html template file located in
\DI\Solution\webapps\<diveport>\dlcgi to the
\DI\Solution\<diveline>\html directory.

2. Rename the file, replacing diveport with the name of your installed
instance of the DivePort application.

3. From the htm1 directory, open the <diveport>.htmlin a text editor.

7 diveport-test.html - Notepad - m] X

File Edit Format VYiew Help

<html>

<title» DivePort </title»

<meta http-equiv="pragma" content="no-cache"/>

<meta http-equiv="cache-control” content="no-cache"/>

<meta http-equiv="robots” content="none"/>

<meta http-equiv="refresh” content="@; url=https://PORTAL-HOSTNAME:PORT/PORTAL-
PATH#username=$DL_USER&password=$DL_PASSWORD&SDL_EXTRAS™ />

<body>

Redirecting you to the portal site...<br/><br/>

click <a href="https://PORTAL-HOSTNAME : PORT/PORTAL -PATH#username=$DL_USER&password=
$DL_PASSWORD&$DL_EXTRAS">here</a> if the redirect fails.

</body>

</html>

4. Replace the two instances of https://PORTAL-HOSTNAME : PORT/PORTAL-
PATH With https://<servername>:8443/<diveport>.

Use your DivePort <servername> and <diveport> so the html file points
to the correct URL.
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To update the <diveport>.xml file:
1. Select Control Panel > Administrative Tools.
2. Open the Services window.
3. Stop the Tomcat service.

i, Services - ] s
File Action View Help
e |@H Bz dm »mnw

. Services (Local) ' Senvices (Local)

Tomcatd Name Description  Status  Startup Type  Log On As -

\".‘Q me Broker Coordinates.. Running  Manual (Trig...  Local Service

Stop the service

Restart the service omcatd Running  Automatic
£ Touch Keyboz Start b.. Running Manual (Trig.. Local Syste..
0} Update Orche Stop V.. Running Automatic (.. Local Syste..
0L UPnP Device Fhrs Manual Local Service
G, User Data Acc Resume Running  Manual Local Syste...
-&%?;UsarData Stol N Running  Manual Local Syste...
G} User Experien Disabled Local Syste...
 User Manager Al Tasks > g.. Running Automatic (T.. Local Syste..
-&%’;UsarPrDFiIE S¢ ity Running  Automatic Local Syste...
G Virtual Disk Manusl Local Syste...
) Volume Shade Properties n.. Manual Local Syste... v

Extended /(Standard/ Help

4. Locate the context file <diveport>.xmlin the Apache Software Foundation
directory. For example:

C:\Program Files\Apache Software Foundation\Tomcat
9.0\conf\Catalina\localhost\diveport-test. xml

5. Open the file in a text editor.

) diveport-test.xml - Notepad — a x
File Edit Format View Help
<Context docBase="C:\DI\Solution\webapps\diveport-test\diveport.war”
sessionCookiePathUsesTrailingSlash="false">»
<!-- uncomment this and set the following parameters:
<Parameter name="dataroot"” value="Enter DivePort WebData Directory Here" />
<Parameter name="approot” wvalue="Enter DivePort WebApp Directory Here" />
<Parameter name="diveline.server” value="Enter Diveline Server String Here" />
<Parameter name="diveline.admin-username” value="Enter Admin Username Here" />
-->
<!-- for single-sign-on with a CGI-mode installation, uncomment and set these parameters:
<Parameter name="diveline.web-auth-start-url” value="Enter DLCGI DivePort URL Here"/»
<Parameter name="diveline.web-auth-finish-url” value="Enter Logoff URL Here"/>
--»
<!-- If you need to permit HTTP connections:
<Parameter name="require-confidentiality” value="false" />
>
<Parameter name="dataroot” value="C:\DI71\Solution\webdata\diveport-test” />
<Parameter name="approot” wvalue="C:\DI71\Solution\webapps\diveport-test™ />
<Parameter name="diveline.server” value="jsmith-@@1:2131" />
<Parameter name="diveline.admin-username” value="admin" />
</Context>

6. Change the following parameters and values to match your bI1\solution
directory and DivelLine Admin user setup:
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Parameter name="dataroot"

For example:

Parameter name="dataroot"
value="C:\DI\Solution\webdata\diveport-test"

Parameter name="approot"

For example:

Parameter name="approot"
value="C:\DI\Solution\webapps\diveport-test"

Parameter name="diveline.server"

For example:

Parameter name="diveline.server" value="jsmith-
001:2131"

Parameter name="diveline.admin-username"

For example:

Parameter name="diveline.admin-username" value="admin"

7. Within the comment tags, delete the comment and enclosing tags, and set
the following parameter and value lines:

Parameter name="diveline.web-auth-start-url"

This points to the DLCGI DivePort URL, which is the diveport.html file.
For example:

Parameter name="diveline.web-auth-start-url"
value=“http://jsmith-001/cgi-bin/dlcgi.exe/diveport-
test.html”

NOTE: If some users are not using single sign-on, redirect users
using an authentication override of OWN to the logon dialog box by
using one of the following formats instead:

o https://<servername>:8443/<diveport>/login

o https://<servername>:8443/<diveport>/#login=true
This avoids the CGl-authentication redirect.
Parameter name="diveline.web-auth-finish-url"

This points to the Logoff URL, that is, where DivePort users are
directed after log off.

For example:
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Parameter name="diveline.web-auth-finish-url"

value="http://www.dimins.com”

8. Save your file changes and restart Tomcat.

If you require more information on using the DivePort DLCGI, contact Technical
Support.

LDAP Authentication
Diveline supports use of the Lightweight Directory Access Protocol (LDAP) as
defined by RFC 2255. When Diveline is using LDAP authentication, for each user
that attempts to log in, in real time, DivelLine:

» Requests credentials

» Connects to an LDAP directory server

» Performs a search for the given user

» Authenticates that user with the given password
If it succeeds, then the username attribute specified is passed back to Diveline.
That user then has access based on profile settings in Workbench. Note that you

do need to define your users within Workbench, and the user names assigned in
the DivelLine user profile must exactly match the user names in the LDAP.

LDAP authentication is supported in Diveline running on:

o All Windows platforms
» Solaris
e Linux

The Microsoft version of LDAP is Active Directory (AD). LDAP authentication is
tested against both Microsoft Active Directory and OpenLDAP directories. On
supported UNIX platforms, the OpenLDAP libraries must be installed on the
server in order for it to work.

NOTE: When configuring DiveLine LDAP authentication, the database schema
must be known. On Windows, if it is unknown, the LDAP Data Interchange
Format (LDIF) utility can be used to provide the necessary information.

Diveline also supports LDAP over TLS (LDAPS). The LDAP server certificate must
be installed and trusted. The DiveLine Events logs indicate if there are problems
with the certificate. LDAPS is a good option when Diveline is on one server
environment and the authentication is being done on a remote server.

The key to DivelLine's ability to make use of LDAP servers is the attributes
defined in the atlcfg.cfg file. These attributes determine whether LDAP is
supported, how a user’s credentials are matched against the directory, and the
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scope of a search that an application conducts in the LDAP tree. The atlcfg.cfg
file is updated when you use the Workbench GUI.

There are three steps to configuring DiveLine to use LDAP authentication:

e Obtaining Information below

» Exporting the LDAP Database Listing below

» Configuring LDAP Authentication on the facing page

Obtaining Information
It is recommended that the following information be obtained prior to
configuring LDAP:

» LDAP server name or IP address and port number.

» Account for an application to access the LDAP server, typically an LDAP
administrator.

» LDAP schema; this can be provided in the form of an LDIF file.

o LDAP user distinguished name (DN) components that map to the base
search for Diveline.

o LDAP user attribute that maps to the Diveline user name.

NOTE: It is often the case that the Diveline administrator is not an LDAP expert,
so a trial and error period might occur when configuring Diveline for LDAP
authentication. DivelLine session logs prove very useful in these cases, as they
provide helpful information on authentication failures.

Exporting the LDAP Database Listing

When configuring DivelLine to use LDAP authentication, it is useful to have a
database listing to ensure that the names given to DivelLine match those in the
LDAP configuration. The database contents can be exported in LDAP
Interchange Format (LDIF) by using the LDIFDE utility as follows:

1. Start a Command Prompt on the server.
2. Run the ldifde -f output.ldf file.

The output.ldf file contains all the objects in the LDAP configuration,
separated by blank lines. Each object begins with the Distinguished Name
(dn); this is considered the primary name for the object and has a form
similar to:

dn: cn=Users,dc=jsmith-001
Notice that the names for objects contain the local domain.

When authenticating user “John Smith”, Diveline connects to the server at
dimins.com, and then searches the users under cn=Users,dc=jsmith-001
for a user with a common name (cn) of “John Smith”. If it is preferred that
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the user log in to Diveline with a short name (jsmith), then pick another
attribute (for example, sSAMAccountName) that contains this value, for
example:
|dap://jsmith-
001:389/cn=Users,dc=dimins,dc=com?sAMAccountName?sub?obje
ctClass=user

The LDIF dump should indicate what the values for various attributes are.
By not specifying a port, the example URL above uses the default port 389.

If this is not the port in use, the URL should take the general form:
|dap://<server>:<port>/<dn>?<attribute>?<scope>?<filter>

DiveLine can connect to only one LDAP directory server. If that directory
server has been set up to switch to a standby computer server, Diveline
accepts the returned URL and searches the new directory server.

If the Active Domain administrator has set up Organization Units, users
may be in a different part of the hierarchy based on their organization
unit. This displays in the LDIF dump. In this case, the username might have
an "OU" attribute giving the organization unit. For example:

cn=John Smith,OU=Documentation,dc=dimins,dc=com

To only search users in the Administration organizational unit, give that as
the base DN in the URL:

|dap://jsmith-
001:389/ou=Administration,dc=dimins,dc=com?cn?sub?objectClass=user

When using LDAP, please note the following:

» URLs should be entered without spaces or line breaks.

» LDAP Group attributes are not recognized as Groups in DiveLine. Groups
in DiveLine are established using Workbench.

e Diveline LDAP authentication requires challenging the user credentials.
Single sign-on is possible only with DiveLine Web Server authentication.
See Configuring LDAPS on page 159.

Configuring LDAP Authentication

Once you have collected your LDAP information, you need to configure LDAP
authentication in Workbench.

To configure LDAP authentication:
1. Open Workbench and open a connection.
2. Select Tools > Server Settings > General.
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Start  main.divetab M:m 4k
|Genera|
I General General
bers ' Security
Groups E&uthent\catlonType LDAP V]
¥ LDAP Settings

Projects

¥ User Management
Properties
¥ Authorized DivePort Gateways

Controller

Email Notifications
Advanced

~ -’ Options
g_. ¥ 6.4 Diveline Namespace

¥ Miscellaneous

¥ Login Options

3. Select LDAP from the Authentication Type pull-down menu.

Authentication Type | LDAP ~

# LDAP Settings
LDAP URL Idap://fismith-001:38%/ocu=Documentation,cn=Users,dc=jsm |

LDAP Bind Mame:  Distinguished Name| ou=documentation, cn=users,dc |

Password |II-I-I-I-I-I-I-| |

Edit Other LDAP Servers...

4. Enter the LDAP URL. The LDAP URL defines the LDAP server, the
username attribute, and the filter for searching the LDAP database. This
URL is an LDAP URL as defined by RFC 2255, and takes the general form:

Idap://<server>:<port>/<dn>?<attribute>?<scope>?<filter>
» server—The LDAP server hostname or IP address.

e port—The Transmission Control Protocol (TCP) port number to use
to connect to the LDAP server. The default is 389.

* dn—The distinguished name used to start the search for the user.

« attribute—Used to match the given user name to Diveline. If there
are multiple attributes specified, only the first one is used. If no
attributes are specified, the default attribute, uid, is used. Diveline
can also match an attribute and return a different attribute. Multiple
attributes are separated by commas.

158



Diver Platform 7.0

» scope—Defines the scope of the search, and should be either one to
search the children of the given base, or sub to search all
descendants of the given base. The sub option is recommended.

« filter—A string representation of the filter to apply in the search. It is
appended to the username search using an AND condition, such as
(&(user=attr)(filter)). This is optional.

5. Enter the Distinguished Name. This field needs to contain the
Distinguished Name of an LDAP administrator to use to log in to the
server. This user must have permission to search the database. The
Distinguished Name is passed in clear text.

6. Enter the Password. This field must contain the password for the
Distinguished Name given in the Distinguished Name field. The password
is stored and passed in clear text.

7. Save the Server Settings, using File > Save or Ctrl+S.

8. Restart the Diveline service for the LDAP settings to take effect.

Configuring LDAPS
When using LDAP authentication, a URL starting with [daps:// can be specified

to cause DivelLine to negotiate a secure TLS connection before sending
passwords to the LDAP server.

When configuring LDAPS on Windows, note the following:

» The SSL/TLS certificate presented by the LDAP server must be considered
trusted by Windows. If it is not, the logon fails. The DiveLine Events log
indicates that the cause is the LDAP server is down or the certificate was
rejected. In some Active Directory or Windows Domain environments, the
necessary certificates can be distributed and trusted automatically.

» To troubleshoot LDAPS connections, you can tell DivelLine to not attempt
Certificate Verification, blindly accepting any and all certificates. To do
this, manually add the following line to the main block of the atlcfg.cfg file:

|daps_debug_skip_cert_verification="true"

Then start a new ProDiver session.

CAUTION: This creates a security risk from man-in-the-middle attacks and
should be undone at the conclusion of your troubleshooting.

If LDAPS only works with this switch enabled, then there is a problem with
the certificate. It might be one of the following:

° The certificate is expired.
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° The certificate common name does not match the name of the machine
specified as the LDAP server. Note that "machine" and
"machine.domain.com" do not match.

° The Certificate Authority (CA) is not trusted. This is the case for self-
signed certificates or certificates signed by a corporate CA where the CA
certificate has not been imported.

» Toinstall a new Certificate Authority (CA) certificate in Windows, use the
Certificates snap-in of the Microsoft Management Console (mmc.exe). See
http.//msdn.microsoft.com/en-us/library/ms788967.aspx for instructions
on starting that interface and importing the third-party root certificate.

When configuring LDAPS for Linux, note the following:

* Itis possible to modify atlcfg.cfg to require encryption through STARTTLS
on the normal port by setting Idap_tls="always". Use of an ordinary (dap.//
URI is then encrypted.

Other options:

° ldap_tls="none"—Do not attempt STARTTLS; it is treated as if the
option is not present.

o ldap_tls="optional"—Encryption is not required. Never use this except
for debugging.

e The TLS certificate presented by the LDAP server must be trusted. The
/etc/ldap/ldap.conf file specifies, using its TLS_CACERT attribute, a file
containing the trusted Certificate Authorities. Position the certificate here
to enable both STARTTLS and LDAPS.

* ltis also possible to temporarily set "TLS_REQCERT never" in the LDAP
configuration file during debugging to see if the certificate is in fact the
problem.

CAUTION: This should not be left set, however, because it disables
certificate checking and protection from man-in-the-middle attacks.

« Verification of the TLS certificate settings can also be done from the
command-line, using the Idapsearch tool. For example:

TLS on LDAPS port:

ldapsearch -x -H ldaps://ldapl.dimins.com -Db
"ou=people,dc=dimins,dc=com" uid=joe

STARTTLS on normal LDAP port:

ldapsearch -7ZZ -x -H ldap://ldapl.dimins.com -b
"ou=people,dc=dimins,dc=com" uid=joe
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You see a Connection error message if the certificate is rejected or if
the network connection cannot be made.

Implementing SSO on Linux

If you are using LDAP on Linux, and are trying to implement SSO (single sign-
on), consider using dlcgi.exe for Web Authentication. The standard use of
dlcgi.exe allows you to implement SSO.

For standard SSO from an LDAP Active Directory login, configure a Windows
server or virtual machine (VM) with Internet Information Server (IIS) running
dlcgi.exe. You can then configure the dlcgi.exe to refer to the Linux Diveline as
the target to forward authentication information to.

Running Diveline in Clustered Mode

Running Diveline in clustered mode allows multiple DiveLine services, on
multiple machines (or nodes), to share a dataroot. To run Diveline in clustered
mode, install all instances of DiveLine on the desired machines, being sure to
point each instance to the same dataroot location. The dataroot needs to be on
shared storage, such as a NAS or Windows file share. Once installed, you must
explicitly tell each Diveline service instance to run in clustered mode.

NOTE: Clustering requires the use of a separate load-balancer, as software or
hardware, and is not supplied by DI.

For example, on Windows:

1. Open the Start menu and type cmd.exe.
2. Click the search box icon.
3. Click emd.exe from the results list.

The Command Prompt opens.

¥ Command Prompt

4. Navigate to the Diveline utilities. For example:

cd \DI\Solution\diveline\bin
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5. Enter di-service -list and press Enter.
A list of DivelLine instances on the machine appears.

6. To turn clustering mode on, use the following syntax for each instance:

di-service -edit <servicename> -cluster

Replace <servicename> with instances from Step 5.

7. Repeat Steps 4 to 6 on each Diveline server, for each Diveline service
instance. This ensures all instances of di-service.exe are set to run in
clustered mode.

8. Stop and restart each service instance.

Each time you set a Diveline to use clustering, it should return a message similar
to the following:

Service: DI-DivelLine-2131

Status: Running

Start-up: Automatic, on system boot.

Executable: \\Jjsmith-001\DI\Solution\diveline\bin\di-

service.exe

Service runs as user: divelineuser

Dataroot: \\Jjsmith-001\DI\Solution\dl-dataroot

Port: 2131

Clustering support is enabled.
NOTE: The di-service.exe -1ist command indicates if clustering is in use.
This is an easy way to verify the dataroot and cluster support settings.

The following points should be considered when using clustered mode:

« All Divelines should be configured to use the same dataroot, on shared
storage, such as a NAS or Windows file share. When installing the
Divelines, the dataroot would be something like
\\<server>\DI\dataroot

» Configuring the DiveLines to use the same dataroot is how they can use
the same configuration of users, same data, and how the nodes can find
each other for presentation in Workbench.

e Thereisonly one atlcfg.cfg file, in the shared dataroot, that all clustered
nodes access.

* In cluster mode, logs are written to 1ogs-<nodename>-<portnum> instead
of just logs-<portnum>.

 If you are running DI-Broadcast or DI-Scheduler jobs, the atljobs.cfg file
that the di-scheduler-engine looks for on the node uses the node name
as well as the port number, so that each node does not run the same jobs.
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» Once clustering is enabled, you can use Workbench to connect to any
node in the cluster and see information about the use of all nodes.
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Appendix D: AntiVirus Exclusions
List

The following information is provided in order to best optimize performance
and security for an installation of the Diver Platform. Exclusions are presented as
options rather than requirements, and the potential risks are presented to help
you to make informed decisions best suited to your needs.

Client Machines
No specific exclusions are required for normal operation. The following should
be considered.

» ProDiver is a single stand-alone exe file. There are no dlls files and no
exclusions are required. This is installed by defaultin c:\Program Files
(x86) \Dimensional Insight\ProDiver,butthBiSCOhﬁguraUe.”the
executable source is trusted it can be specifically excluded.

» DiveTab-PC uses a number of dlis files. The install directory, which defaults
to C:\Program Files (x86)\Dimensional Insight\DiveTab, can be
excluded from real-time scans, or the DiveTab.exe binary can be
specifically excluded.

e DivePort and NetDiver are web clients that run in a browser. No exclusions
are required.

Application Server

Solution Directory

The Solution directory contains the executable components of the application
server, as well as configuration files, logs and the cache. Many of these files are
accessed and changed frequently during normal operation of the product.

All paths below are relative to the Solution installation directory set at install
time. The defaultis c:\DI\Solution.

DivelLine bin

The following core components of the application server should be permitted to
execute recursively:

e C:\DI\Solution\diveline\bin\

Alternatively, the entire diveline directory can be excluded.
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DivelLine dataroot

The dl-dataroot directory and all subdirectories should be excluded from real-
time scans. There are no executable files present, and the data files are modified
often and continuously during normal operation of the server:

e C:\DI\Solution\dl-dataroot\

Projects Directory

The Projects directory contains scripts and data files that define the nightly ETL
process and other data processing as well as configuration and logs. The
location is configurable at install time, but defaults to c: \DI\Projects.

Real-time scanning of the c: \DI\Projects directories should be disabled.
There are no executable files here, and lots of modifications are made to data
files on a continual basis. Enabling real-time scans carries a strong risk of
impeding the timely and successful completion of nightly processing of data.

Web Server

The web server can be installed on the same machine as the application server,
but is not required.

Webapps Directory

The following locations contain dlls files, executables and war files that are
regularly called in the normal operation of the product. While it is not required
that real-time scanning is disabled for these locations, it is advisable when using
certain features (printing, certain features of the Spectre engine, among others).

e C:\DI\Solution\webapps\<diveport> for each DivePort being served
e C:\DI\Solution\webapps\<netdiver> for each NetDiver being served
e C:\DI\Solution\webapps\<divetab> for each DiveTab being served

Alternatively, the entire c:\DI\Solution\webapps directory can be excluded.

Webdata Directory

The following locations contain data files that are regularly updated in the
normal operation of the product. No executable files are present. While it is not
required that real-time scanning is disabled for these locations, some
performance can be lost if it is not.

e C:\DI\Solution\webdata\<diveport> for each DivePort being served
e C:\DI\Solution\webdata\<netdiver> for each NetDiver being served
e C:\DI\Solution\webdata\<divetab> for each DiveTab being served

Alternatively, the entire <solution>\webdata directory may be excluded.
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Appendix E: Troubleshooting

Below are some common problems you may have during installation, and the
way to solve them.

Licenses

If a machine has multiple network adapters, each having a unique
MAC address, which MAC address is used as the machine ID?

When using the exportinfo tool, the network adaptor last returned by the
system is used. Prior to Windows 10, the order of network adaptors can be
controlled from Control Panel > Network and Internet > Network
Connections > Advanced Settings. Starting with Windows 10, the order is
unspecified.

IMPORTANT: If using a virtualization platform, verify that the hardware
addresses are not changing upon machine restart.

When validating a license, DI looks at all installed adapters and matches it to the
address in the license. You can specify multiple hardware addresses and provide
them to DI Support if using the last returned network adapter, chosen by
exportinfo, is not sufficient. This includes all the hardware addresses within the
license.

DivelLine

My AD account does not have the correct permissions.

If after installing Diveline, the service is set to run as an Active Directory
account, you need to make sure it has the correct permissions. The service user
requires write permissions to the dataroot directory and everything contained
within it, as well as the projects root.

Windows security is having me authenticate when it should be
authenticating for me.

This happens when the basic settings are set to user pass-through
authentication to run the dlcgi.exe file. To solve this issue, create a virtual
directory and set the needed permissions.

NOTE: In many cases this is occurring even when they have read execute access
to that directory.

1. Navigate to Control Panel > Administrative Tools, and open the
Internet Information Services (/IS) Manager.
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W5 Internet Information Services (IIS) Manager - m} x
« > &) v JSMITH-001 » Sites » @ oy @
File View Help
onnestions €@ s
re Sites
3 ?

€5 JSMITH-00T (jsmith-001\jsmith s s
v 4 (smith-001:jsmith) Filter - % Go - G ShowAll | Group by: - et WebsRelD-aul

L2 Application Pools = @ ne

~ .[8| Sites Name D Status Binding v

¥ Default Web Site & Default Web Site 1 Started (http) 20 (http)
< >
[ElFestres View |2 Content View

Ready S

2. On the left panel, expand your connections and open the Sites directory.

3. Right-click the Default Web Site and select Add Virtual Directory from
the menu.

The Add Virtual Directory window opens.

Add Virtual Directory ? X

Site name:  Default Web Site
Path: /

= ~
(Alias:

Example: images

(Physical path:

Pass-through authentication

Connect as... Test Settings

Cancel

Enter cgi-bin for the Alias.

5. Enter the path to the dlcgi.exe file for the Physical path. The default path
isC:\DI\Solution\diveline\cgi-bin.

6. Click Connect as and select Connect as specific user.
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Connect As

Path credentials:

[@l Specific user: ]

(O Application user (pass-through authentication)

7. Fill in the credentials for the user account running DiveLine.
8. Click OK.

DivePort

| cannot resolve the https://<servername>/<portal name>.

It could be that port 443 is in use by another program. Do one of the following
to check:
» Review the Apache Tomcat logs, typically found in c:\Program
Files\Apache Software Foundation\Tomcat 9.0\logs. The logs may
indicate that the address is already in use.

» Open the command prompt and run netstat -ab. This tells you if port
443 is in use.
If port 443 is in use, you can do one of the following:
» Figure out what is using the port and decide if that is something that can
change.

» Modify the server.xml file to use port 8443 instead of 443. The file is
typically found in c:\Program Files\Apache Software

Foundation\Tomcat 9.0\conf.

| am getting a java.lang.OutOfMemoryError: PermGen space error when
using multiple DivePorts on the same DivelLine

This error indicates that there is not enough space granted to Tomcat to store
Java classes. To change this, the Java options for Tomcat must change to include
more PermGen space.

To remedy this error:

1. Open Windows Explorer and navigate to the Tomcat bin directory at
C:\Program Files\Apache Software Foundation\Tomcat 9.0\bin.

2. In the bin directory, double-click the tomcat9w.exe file.
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The Tomcat9 Properties dialog box opens.

‘} Tomcat® Properties b4

LogOn Logging Java  Startup  Shutdown

Service Name: tomcat9

Display name: | Tomeats |

Description: | |

Path to executable:
"C:\Program Files\Apache Software Foundation\Tomcat 9.0%bin{Tomcat.

Startup type: Automatic w

Service Status:| Started

Start Stop Pause Restart

Cancel Apply

3. Select the Java tab.
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General LogOn  Logging J8va  Startup Shutdown

[ use default
Java Virtual Machine:

| C:\DI_Solution_71Vavatjdk-11.0. 11+9bin'servertjym.dll

Java Classpath;

| C:\DI_Solution_71{Tomcat{Tomcat 3. 0'bin'bootstrap.jar;C: ||,DI_SDIu1J'0n_|

Java Options:

-Deatalina.home =C:\DI_Solution_71{TomcatiTomcat 9.0
-Deataling.base=C:\DI_Solution_71\Tomcat\Tomcat 9.0
-Djava.io. tmpdir=C:\DI_Solution_71Tomcat\Tomcat 2.0%emp

-Djava.util.logaing.manager =org.apache. juli. ClassLoaderLogManage
)

Pimrim il lmmmimn mamfn Sla W ART b bice T4 Tt Tmma

Lnnv

Java 9 Options:

Initial memory pool: | | MB

Maximum memory poal: | 4096 | ME

Thread stack size: | | KB

oK Cancel

Apply

4. On the Java tab, add -xx:MaxPermSize=128m to the Java Option.

TIP: If 128 is not enough space, try 256.

IMPORTANT: If the -xX:MaxPermSize attribute is already in place,

modify it with the new value.

5. Toimplement any changes, click Stop then Start in the Service Status

section on the General tab.
6. Click Apply.

Spectre

Spectre.exe sometimes crashes even without arguments on the customer

machine.

If running spectre.exe without any arguments crashes, it could be your virus

scanner. To check:

Try disabling the virus scanner and then running spectre.exe. If Spectre runs
repeatedly without issue, add spectre.exe to its list of exclusions. Also review the
section Appendix D: AntiVirus Exclusions List on page 164.
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ProDiver
My data is not displaying correctly.

The ProDiver and DivePort clients are able to display text-based data in all
languages. Some languages have characters which require "Unicode-enabled"”
versions of DiveLine and ProDiver in order to correctly display those characters.

If using a non-Unicode Diveline and non-Unicode clients, set the system's
Language for Non-Unicode Programs. In Windows 10, navigate to Control
Panel > Region, select the Administrative tab, and then Change system
locale under the Language for non-Unicode programs section.

¥ Region X
Formats  Administrative
Welcome screen and new user accounts

View and copy your international settings to the welcome screen, system
accounts and new user accounts,

!;Copy settings...

[ Language for nen-Unicode programs

This setting (system locale) controls the language used when displaying
text in programs that do not support Unicode,

Current language for non-Unicode programs:

English (United States)

| !;Change system locale...

OK Cancel Apply
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